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T S ELIOT had foresight. “April is the cruelest month,”
he wrote in his classic poem The Wasteland. In the world
of technology, nothing could have been crueler than
last month when a bunch of Pune-based BPO employ-
ees defrauded Citibank’s clients of more than Rs 1.5
crore, and a boy from Nashik (Maharashtra) repeatedly
molested a girl from Mumbai when she visited him
after he confessed his love for her online.

No wonder, then, that the daggers are drawn, and
technology is back to being the villain.

This column has always argued that it is not tech-
nology that is the villain, but lack of effective regula-
tion. Branding technology as the perpetrator of the
crime (or even an accomplice) is not only being short-
sighted but also displays a complete lack of knowledge
of technology as well as history. It is a classic case of
missing the woods for the trees.

Bigger frauds have taken place even when tech-
nology was not predominant (remember Harshad
Mehta and Ketan Parekh?); women have been sexually
attacked since time immemorial by men with twisted
brains (even our epics carry stories of exploitation); and
teenagers and adults have always exchanged porno-
graphic material among each other.

The question then begs itself: Why does technol-
ogy get the blame?

The answer is that is most people, especially those
that make the laws (or are supposed to), do not under-
stand technology. Worse, they are scared of it. It is sim-
ilar to when people get scared of learning mathemat-
ics, they pin the blame on it for earning fewer marks.
So then, is mathematics to blame, or is the person
unwilling to understand the nuances of the subject
the culprit?

To take the argument further, should we blame
credit cards for financial fraud, or cars for road acci-
dents, or nuclear weapons for the WWII twin Japan-
ese disasters?

Admittedly, technology provides avenues for a lot
of things. It also provides avenues for crime. Which is
why, the anti-India anti-outsourcing propaganda in the
US is on thin ground. Mature commentators in the US,
in fact, are praising the Indian police’s quick action to
nab the Pune culprits. On the popular Web site mot-
leyfool.com, columnist Rich Smith says that data may

be more secure in India primarily because we have
checks and balances in place, like the cybercrime units
of the police force. They may not be the world’s great-
est online detectives, but their fast action in the Pune
case may deter future online criminals.

While the Pune action is heartening, it also exem-
plifies how, until the regulations are enforced, crime
will happen. Until then, the authorities will keep blam-
ing technology. Maybe we will have to just live with it!

Blame It On Tech

Editorial

“Most people, especially
those that make the

laws, do not understand
technology”

Sachin Kalbag Executive Editor

sachin_kalbag@jasubhai.com
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By Demand
You get to choose what goes in Digit
Interactive. This month, you chose:

Linspire Live 5-0 (Linux OS)
Autopatcher XP March Edition

Online Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

Digit Reader Poll

This Month’s Question

How much spam mail do
you receive in a month?

None
Less than 10
Between 11-50
Between 51-100
Between 101-200
Above 200

Log on to www.thinkdigit.com
and vote

taste technology at www.thinkdigit.com

May 2005

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum

Last Month’s Question:

What is the maximum you are willing to
spend per month on a broadband or
always-on Internet connection?
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Kailash Kher
Singer

An ardent follower of Ustad
Nusrat Fateh Ali Khan,

Kailash Kher created a stir with
his debut number ‘Allah Ke
Bande’. His rugged voice and
passionate lyrics let him
connect equally well with the
masses and the classes. We

asked him about his
thoughts on technology

and on how it touches
his life. Excerpts.

What does
technology mean

to you?
Technology is a very

important part of life. In
this tech-savvy world, being
oblivious to technology is like
committing suicide.
What role does technology
play in your daily life?
I have to use technology in
some form or the other daily.
My recording studio is rigged
up with the latest systems that
help me deliver a better song
each time I record. Even
rehearsals are impossible
without gadgets! So they’re
imporrtant—but I may not be
able to tell you how it works
because I have people who help
me understand it. 
How often do you use the
Internet?
I do not surf regularly; my team
members check and respond to
my mails. Every once in a while
when I find time, I log on.
What kind of gadgets do
you own?
I own a cell phone. I try and
make my music as digital as
possible. The sounds of dhols
and chambals are all digitally
modified to suit my songs.
Does technology have any
influence on your music?
It does... I listen to a lot of
variations before finalising
what will fit into my style.

Linux: Automated Again
Linus Torvalds has launched a new tool—Git, to manage his
software project. Torvalds stopped using a management
system called BitKeeper, reverting to an older, slower
technique of simply e-mailing updates among the hundreds
of programmers who contribute to the project. 

Sober, But A Worm
A new version of the Sober worm is spreading rapidly.
Called Sober-M or Sober-N, it uses an e-mail to convince
recipients that their e-mail is being diverted to the alleged
sender. The subject is “I’ve_got your e-mail on my_ account!”
The infected .zip file is commonly named “your_text.zip”.

It’s the merger of the
millennium—Adobe has

entered an agreement to
acquire chief rival
Macromedia for about $3.4
billion in stock. The
companies intend to
combine their software into
‘integrated solutions’ and
might tap unexplored
markets such as the mobile
and enterprise segments.

Macromedia will
enhance Adobe’s
publishing, design and
developer portfolio with
products such as Flash,
Director, ColdFusion,
Authorware, and RoboHelp,
among others. Post the
merger, Macromedia
stockholders will receive
0.69 shares of Adobe
common stock for every
share of Macromedia
common stock. 

Sandeep Mehrotra, Sales
Manager, Adobe India,
confirmed that it will be
“business as usual” for the
two companies, until close
of transaction. Any new
products in the offing? “The
combined company will not
be able to create a joint
product roadmap until after
the transaction is closed,”
says Mehrotra.

According to the terms,
Adobe CEO Bruce Chizen
will retain his position

while Macromedia CEO
Steven Elop becomes
Adobe’s president of
worldwide field operations.

Analysts around the
world and those who have
been following the fortunes
of Adobe over the years feel
this decision has been
driven by the fear of a
competitor that doesn’t
exist. This, in fact, has also

been cited as one of the
reasons why Adobe brings
out so many upgrades
and changes to all its
software with such
alarming frequency.

The deal underscores
Adobe’s growing concern
that Microsoft is set to
encroach on the wide
marketshare enjoyed by
both Adobe and
Macromedia. Adobe’s PDF
document format is an
industry standard for
businesses, and its Acrobat
Reader software ships with
most computers. 

Although Adobe brings
in most of its revenues
from its Photoshop and
Illustrator design tools, the
company has begun to
centre its business around
document creation and
collaboration using PDF.
Macromedia’s Flash,
meanwhile, is the standard
for Web animation and is

beginning to dominate
mobile multimedia as
well; Flash is expected to
ship with 75 per cent of
mobile phones within
five years. 

The growing reach of
PDF and Flash has sparked
concern at Microsoft,
which in turn began to
develop its own offerings.
Office 2003 shipped with
InfoPath for creating forms
and sharing information,
and Longhorn is expected
to ship with further
document-sharing
alternatives to PDF. 

Across cyberspace,
though, the reaction has
been mixed and while some
laud the move, others are
not sure what this will
mean. Forums across the
Internet have been rife with
speculation whether Adobe
will discontinue any
Macromedia products and
which one it will merge
with its existing products.
Flash and Dreamweaver,
it is believed, will be the
two major ones to survive
on their own, while
Fireworks may well be
merged with Photoshop.
What actually transpires
remains to be seen.

VALIDATION FIRST

Microsoft
Introduces
‘Piracy Lock’

Microsoft users who wish
to download local

language add-ons to

Enter
“BUSINESS AS USUAL”

Adobe Dreamweaver? 



Windows have to first
validate their copy of the
operating system as
legitimate. The first add-on
to be affected will be the
Vietnamese language
interface pack.

Over five million users
have taken part in testing
the piracy lock, dubbed
‘Windows Genuine
Advantage’, on its Download
Center Web site since
September, according to
Microsoft. Currently,
Download Center visitors
using Norwegian, Czech, and
Simplified Chinese versions
of Windows have to validate
their copy of Windows.

SATA II INTERFACE, TOO

First 500 GB
Hard Drive
Released

Hitachi’s new Deskstar
7K500 is the first

desktop hard drive to reach
500 GB, and one of the first
to use the new super-fast
SATA II interface.  

Hitachi’s 500 GB drive
will be available in two
versions: a $500 drive
featuring the parallel ATA
interface and an 8 MB data
buffer, and a $520 model
with a 16MB buffer that uses
the 3 Gbps Serial ATA II
interface, backward-
compatible with the 1.5 Gbps
SATA interface. According to
Hitachi estimates, the five-
platter drives will be able to
store up to 56 hours of
HDTV, depending on
compression rates.

JAVASCRIPT VULNERABILITY

Et tu,
Firefox?

Security firm Secunia
discovered a flaw in

Firefox, the popular open-
source browser.

Firefox versions 1.0.1
and 1.0.2 contain the
vulnerability, which stems
from an error in the
JavaScript engine that can
expose arbitrary amounts
of heap memory after the
end of a JavaScript string.
An exploit may disclose
sensitive information in the
memory, according
to Secunia.

The flaw can also expose
sensitive
information
from Web sites
users have
visited, and the
information they
enter there. The
Mozilla
Foundation
issued a patch
that resolves the
issue, and
advised people to
update their
software.

There is
another angle to
the story. The
exposed flaw
could be good
publicity for open source,
and could be seen as an
opportunity to show that
the system works, according
to open source advocates.

The publicity
surrounding the JavaScript
flaw shows “the open

source system is working,”
said Greg Minchak, director
of external affairs and an
analyst with the Open
Source Industry Alliance.

“Unlike some software
companies that sit on
vulnerabilities until they

Dhivya Ramanujam, Thane
Archana Subramanian, Chennai

Gmail
Google has
already doubled
the storage
limit on Gmail
to a whopping

2 GB. Moreover, Google will
offer free storage increases
as user needs expand, 
thus creating virtually
unlimited storage!

Hotmail
Hotmail is still
stuck at a paltry
250 MB, even as
Yahoo! has begun
taking it to 1 GB.
In fact, you get a miserable
25 MB at sign-up, which,
Hotmail states on its sign-up
page, will be upgraded
within 30 days.

“As long as my cable TV works fine.”

“A couple of hours maybe… the
longest I can stay without food.” Rohit Madhavan, Kerala

Reeba Joseph, Navi Mumbai
“As long as I can stay without having

a bath.” 

Jigar Patel, Mumbai
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Security Watch
Outlook and OWA ‘From’
Header Spoofing
The Problem
April 10, the FrSIRT (French
Security Incident Response
Team) reported that remote
exploitation of an address
spoofing vulnerability in some
Microsoft e-mail clients,

including Outlook, could allow
attackers to social-engineer
sensitive information from end
users. The flaw exists in the
message header parsing
engine, and allows an attacker
to spoof the ‘From’ field that is
displayed on the user’s screen.
This is made worse by the fact
that when the ‘From’ field
contains multiple comma-
separated addresses, Outlook
only displays the first address.

The Damages
Say a corporate SMTP server is
configured to drop all mail
received from the external
network claiming to be from an
internal address. By exploiting
this, an attacker can bypass
restrictions and transmit a
message that appears to come
from an internal user. A user is
therefore more likely to give
out sensitive information.

Precautions
Microsoft has reviewed the
issue and has said that while
a bug fix may be implemented
in a future service pack, a
patch will not be released
for this issue.

Examine the full mail
headers of any suspicious
e-mail messages prior to
taking described actions or
following live links.

One Silly Question

“Just the six hours I sleep!”

How long can you survive without the Internet?

“Not even a minute… theInternet’s like the air I breathe.”
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Pulse

Tech, Freebies, Movies

DDeessiiggnnTTeecchhnniiccaa
This Web site is one of the best places
to read up on cutting edge technology
and lifestyle products, with sneak
peeks and extremely in-depth reviews
on stuff ranging from the latest gizmos
to office furniture! There’s news,
reviews, and a forum as well. This site
will satisfy all your technology reading
needs, whichever way you may be
associated with technology.

TThheeFFrreeeeSSiittee..ccoomm
TheFreeSite.com is the “Home of the
Web's Best Freebies.” It offers
miscellaneous freebies, graphics, Web
page counters, trackers, freeware, 
e-mail, free e-mail, Web pages,
Webmaster tools, samples, fonts, and
much, much more. You just won’t
believe how much free stuff there is on
the Web! Happy Surfing!

iiFFiillmm
This Web site gives you an instant fix of
the latest movie trailers and more.
Some sections on the site are ‘Viral
Video’, ‘Movies’, ‘Action Sports’,
‘Uncensored’, ‘Music Videos’, and ‘Video
Games’. An excellent site to visit during
office breaks... or in between breaks,
for that matter!

thefreesite.com

ifilm.com

designtechnica.com

get around to them, the
open source community
swarms to a problem the
moment it’s made known.”

A9, A POPULAR CHOICE

Bringing 
It To The
Customer
Like Never
Before 

A9, the search tool
developed by

Amazon.com, is proving to
be a popular choice among
early users, says Werner
Vogels, chief technology
officer of the online retail
giant. Vogels was recently
in India and travelled to
Hyderabad, Mumbai,
Pune and the
Amazon
Development Centre
in Bangalore. In
conversation with
Digit, Vogels
outlined some
of the plans
and priorities
for him as CTO

of Amazon.com.
“The Web and search

engines are run by talent,
and collaboration will be
the key in the success of A9.
We have a large group of
developers working on A9
and this is happening from
our Bangalore office,”
informed Vogels.

The future form of the
Internet has been widely
speculated. Vogels said that
one of the biggest challenges
would be the possibility of
building applications that
have not been attempted
before. “The key to the future
would be to develop
interfaces that are new, allow
developers to innovate… as of
right now, there’s not much
to do, but it would be wrong
to say that there is
stagnation,” said Vogels.

Speaking about the
Internet as an

operating system,
Vogels said this
was more
“philosophical”
than practical at
this moment.

“It’s more suited
to service than
to become a
platform 
in itself.

A Round-up Of Technology News From Across The GlobeThe Digital World

CHINA

DENMARK

Denmark remained No. 1 in the list of nations taking
advantage of the Internet, in connecting citizens as
well as in Internet banking and government
services. This is according to an annual study by IBM
and the intelligence unit of British magazine The
Economist. India ranks 49th.

AUSTRALIA

BigPond, Australia’s largest ISP, has asked the
Australian High Tech Crime Centre to investigate
recent attacks on its DNS system from Trojan-
infested PCs. There has been a spate of bogus DNS
requests swamping its servers and delaying
customer e-mail and Web site requests.

UNITED KINGDOM

Google UK has introduced local-search and mapping tools. Beta versions of
the two services—Google Maps UK and Google Local UK—were unveiled April
19. The local-search service provides listings of businesses, such as
restaurants, and indicates their positions on a map.

UNITED STATES

Three Incredibly Useful Sites

MIT researchers are seeking to build $100 laptops to
help the developing world. Nicholas Negroponte,
director of the MIT Media Lab, and some MIT
colleagues, are at work on a project they hope will
brighten the prospects of hundreds of millions of
developing world kids.

High-tech will be used to explore a 3,000-year-old
bronze culture at Xingan County as archaeologists will
use remote sensing, magnetic field positioning and
underground probing technologies. Using digital
processing technology, they can pinpoint tombs, find
connections between sites, and do trial excavation.

JAPAN

Worried by a spate of high-profile attacks on
children, Japanese parents are equipping their kids
with knife-proof clothing and school bags equipped
with Global Positioning System.

$100

Werner Vogels, CTO, Amazon.com
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Traditional software houses
have created complex
software. If software is a
service, you can upgrade
and deliver immediate
results,” he said.

After the success of
Amazon.com, Vogels thinks
A9 will be the next area of
focus for the company.
“Our aim is to make A9 the
best available. The A9
Yellow Pages is the next big
thing… it can narrow it
down to the nearest listing
available and really make
this medium localised,” he
added. A9, feels Vogels, is
how you can bring
something to your
customer like never before.

EIGHTEEN PLAYERS INVOLVED

United Front
Against
Hacker
Attacks

Eighteen global network
providers and ISPs have

teamed up in order to
confront and curb large-
scale hacker intrusions.

The organisations, which
include British Telecom,
Deutsche Telekom AG, MCI
Inc., NTT Communications
Corp., Cisco Systems Inc.,
and EarthLink, have agreed
to share information about
network-based attacks
through the Fingerprint
Sharing Alliance. 

Participants will share
data using technology from
security company Arbor
Networks Inc., that sells
technology for detecting
and fending off network-
based attacks.

PRINT OUT ANYTHING!

A ‘Print
From TV’
Platform

Printing from your TV
could just become

reality if Seiko Epson’s
plans take shape as they
expect. Announced as one
of the major new steps the
company would be taking,
the ‘Print from TV’
platform has already been
announced in Japan. The
platform would allow the

user to hook up an Epson
printer to a special TV to
make prints of the
information (or photos)
being displayed on screen.
“We have already entered
into an agreement with
Panasonic for

manufacturing the specific
types of TV sets required
for this, and a standard for
the Japanese market could
be reached this year. For the
rest of the world,
discussions are still on,”
according to Norio Niwa,
vice-president, Seiko
Epson Corporation.

Epson is also working on
developing various types of
displays including OLEDs,
and what are largely being
called as flexible displays
that have widespread
applications in cell phones
and other devices. “At

Epson, we allot six to seven
per cent of the annual
turnover for R&D, and this
has facilitated the variety of
research we are now doing,”
said Dr Tatsuya Shimoda,
director, Technology
Platform Research Centre
and   deputy general
manager, Corporate R&D.

Pulse

Photograph Jiten Gandhi

Last Month’s Winner!
M Sudhendra, 3-10-38/A,
GokhaleNager, Ramanthapur,
Hyderabad 500013
“Ek haath doodh ka packet,
doosra haath data packet!”

Send your captions to
beatthat@thinkdigit.com
and win the 
Family UtilityCD 
from Numeric 
Power Systems Ltd

Every month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game!

Digit Caption
DDR Rs 500 a kilo, SDRAM
Rs 400...

The new OLED TV from Epson



21DIGIT MAY 2005

Pulse

Epson is the leader in the
Japanese market but not so
in the rest of the markets.
Commenting on the same,
Niwa further explained, “We
have laid greater emphasis
on photo printing in Japan
and therefore enjoy the
marketshare we have. We
have a different strategy for
every market.”

Also unveiled on the
occasion were a range of
new printers that used
pigment inks for improved
print quality, and a wider

range of applications. Using
special inks and media,
inkjet printing could even
facilitate the printing of
electronics   and household
items in  the near future.

While some of the
innovative applications do
sound far-fetched, they
could be practical pretty
soon. So don’t be surprised
if you see someone
printing their own ties and
even PCBs at home! 
(The author was hosted by
Seiko Epson in Japan)

BULLISH ABOUT INDIA

FICCI Frames

The annual FICCI-Frames
conference on the

‘Business of Entertainment’
was held in Mumbai, from
April 4 to April 6. A
conference where the gurus
of the entertainment world
met, saw a few policy
statements by the
Information & Broadcasting
Minister, Jaipal Reddy. 

With the increasing
demand for radio to be
freed from the licensing
structure the minister made
a commitment to set up
guidelines to enable almost
300 private radio stations in
the country in a years time.

Coupled with this, he
also emphasised the need to
push for the popularising of
the community radio. The
government, he said, was
keen to see as many as 4,000
community radio stations
come up around the
country. In addition to
these he also spoke of
considering the revenue
sharing model instead
of the present annual
licensing one to boost
the sector.

The other major areas
under the spotlight were
piracy and IPR and the
emergence of mobile
gaming, entertainment
and news. 

All the industry experts
and leaders were bullish
about entering the Indian
market in the mobile and
animation area. Gaming
major EA said that they
were evaluating the Indian
market and would be
entering the mobile gaming
sector very soon. 

EA Asia President Jon
Nierman also said that
India was a very attractive

proposition for the
development of games, as it
has a technically strong
talent pool. 

Among other
international companies
TOM Online, the parent
company of Indiagames.
com, said that they were
keen to increase their
presence in India by
providing more interactive
and user-specific content for
mobile phones. “We are
very positive on India,
because at 36 per cent, it
has the highest 5-year CAGR
in terms of cell phone
growth,” said S Wang, CEO
& ED, TOM Online.

The animation and
movie special effects area
was also a prime focus area,
with the number of co-
productions increasing and
the use of new technologies
such as Digital Integration
in Bollywood movies. 

With the mood positive
at the conference, one
thought voiced constantly:
it’s time India replicated
the software success story
in entertainment.

MONITORING OF RESOURCES

ISRO To Link
All Tamil
Nadu
Villages

India’s premier space
agency, ISRO, plans to

create resource centres
linked by satellites in all
villages of Tamil Nadu. The
resource centres are based in
Rameswaram, Dindigul and
Thiruvaiyaru districts. The M
S Swaminathan Foundation,
based in Chennai, will be the
nodal agency. 

The centres will monitor

GENDER 

BENDERS

A second year BSc (IT) student, Ganesh is raring to go. A music
file titled Beatles appears in the Winamp playlist. He right-
clicks the filename and the dialog box ‘MPEG file info box + ID3
tag editor’ appears. Straightaway, Ganesh clicks the ID3v1 tag
icon and merrily enters the information we provided in the
‘Title’, ‘Artist’, ‘Album’, ‘Year’, ‘Genre’ and ‘Comment’ sections.
He grins widely at us—having tagged the mp3 effortlessly, well
almost, and in good time.

Ganesh Subramanian vs. Aakanksha Kekan

Tag An Mp3

40 sec

2 min
10 sec

Aakanksha is pursuing her BE (IT). Though tech-savvy, she
needs some mollycoddling to get rid of her apprehensions.
Aakanksha narrows her eyes at Winamp and selects the
Beatles song. She fumbles about with the various options,
clicking this and that, and sighs. Finally, she clicks the ‘Misc’
button that appears in the last row of the Winamp playlist,
opens ‘File Info’, and the right dialog box appears. Aakanksha
quickly enters the data and appears visibly relieved.

HP recently announced a new disk-labelling
technology called LightScribe, which lets you

burn high-quality labels onto specially-coated CDs
and DVDs. Apart from special media, you require
LightScribe-capable CD or DVD Writers and
compatible software in order to use the new
labelling system. To label a compatible disk using

Lightscribe, you just burn it the way you normally
do, and then flip it over in the drive tray to burn
text and/or graphics. LightScribe technology
currently supports only greyscale printing at 1x
speeds. However, the future promises higher
speeds and colour support. You can visit
www.LightScribe.com for further details.

LightScribe
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usage of resources like soil
and water. ISRO has also
placed remote sensing
satellites in orbit to transmit
information to the centres.

LONG-AWAITED

OS X Tiger
Launched 

Tiger, the fifth major
version of Mac OS X, has

more than 200 new features
and innovations, including
Spotlight, a desktop search
engine, which will
completely integrate into
the operating system.

Other features include a
‘Dashboard’ to access
‘Widgets’ that let users get
information quickly and
return to work ASAP. ‘iChat’
enables  audio and video
conferences with up to 10
people. ‘Automator’ helps
automate complex or
repetitive tasks without
programming, and Safari
RSS enables RSS feeds to
cull information from news
organisations, community
Web sites and blogs. 

LOTS OF APPLICATIONS

Abundant
Adobe

Adobe launched its
Creative Suite 2 (CS2)

worldwide on April 4, 2005.
The CS2 is being pegged as a
tool to help print and Web
workflows for creative
professionals. It includes
Adobe Photoshop CS2, Adobe
InDesign, Adobe Illustrator,
Adobe GoLive and Version
Cue. Also included is Adobe
Acrobat 7.0.

The CS2 has a new
component—Adobe Bridge
that acts as a hub for
productivity, imagery, and
creativity. It provides multi-
view file browsing and
smooth cross-product
integration across the
CS2 software.

The designers can
preview multi-page PDF files,
drag and drop from
floating Compact Mode

windows, process images
with built-in Camera Raw
3.0, edit and search for
Adobe XMP metadata. 

To simplify the
purchase and management
of stock imagery, Adobe
CS2 introduces Adobe Stock
Photos. It brings together
more than 230,000 images
from some of the
world’s leading stock
photography
providers including
Photodisc by Getty
Images, Comstock
Images by
Jupitermedia, Digital
Vision, Imageshop
royalty free by
Zefaimages. Version
Cue in CS2 is a file-
version manager and
collaboration tool
that helps users
visually preview,
track and access
historical and
alternate versions of files in
CS2 projects.

Adobe GoLive is a
powerful authoring tool
for Web and mobile
content. GoLive CS2
introduces new CSS layout
tools which can be used by
Web designers and
developers to create,
publish, manage and
update content that adapts
easily to the latest
generation of handhelds.
Adobe GoLive CS2 delivers
mobile authoring tools
based on open standards to
support mobile layout
(CSS,XHTML), multimedia
and interactivity (SVG,SVG-
t) and video (3GPP, MPEG-4)
for mobile devices. The
estimated street price for
Adobe CS2 Premium
Edition in India is Rs 65,300
and Rs 48,900 for the CS2
Standard Edition.

LAX LOCAL TV NETWORKS

BitTorrent
To The
Rescue!

Australians are catching
new episodes of their

favourite American
television shows from 

P2P applications such 
as BitTorrent. 

According to an
independent study
conducted by a former
general counsel for the
Australian Recording
Industry Association, the
popularity of BitTorrent in
Australia

is driven in part by local TV
networks which are slow to
air recent episodes of
popular TV shows.

SEEKING TO MATURE

Disney
Invades
Gamezone 

Disney’s Buena Vista
Games has purchased

Salt Lake City-based
Avalanche Software for an
undisclosed amount. Buena
Vista Games is also setting
up a development studio in
Vancouver that will create
action-adventure games.

By buying Avalanche,
Disney is seeking to mature
into an established game
development house.
Avalanche developed Tak
and the Power of Juju,
published by THQ, and
Dragon Ball Z: Sagas for
Atari. According to Disney,
they will focus on creating
‘family-friendly’ games.
A team of developers
formerly at EA will be
heading Disney’s
Vancouver-based studio. 

Compiled by Aditya Kuber, Meera
Vankipuram, Mithun Kidambi,

Ram Mohan Rao and Renuka Rane

What is SLI?
Scalable Link Interface is a
method of parallel
processing for computer
graphics, in which two or
more video cards can be
linked to produce a single,
more enhanced output.
Where was SLI technology
first deployed on a
commercial scale?
An initial version (dubbed
‘Scan Line Interleave’) was
used by the US-based 3dfx
in 1998, in the Voodoo 2
line of graphics
accelerators. 
When was the modern SLI
introduced?
nVidia and ATi developed
their own versions, that
were rechristened ‘Scalable
Link Interface’ in 2004. 
How do the SLI
versions differ?
In 3dfx’s SLI, the two
connected cards compose a
frame by rendering
alternating horizontal lines
of pixels. While the nVidia
SLI splits the screen into
two parts, one GPU
rendering each, ATi’s
solution
breaks the screen into
little squares.
Why does SLI have an edge
over ordinary graphics
cards?
By harnessing the
processing power of two
graphics cards, SLI-enabled
systems can roughly—
although not completely—
double the performance of
a single Graphics Processing
Unit (GPU) configuration.
Who is the target
audience? 
With better image
compositing and rendering,
SLI-enabled systems are a
must for the die-hard
gamer. There’s a caveat:
deep pockets required, as
SLI systems need to be
complemented with a high-
end motherboard and
processor, as well a top-
notch display unit.

Pulse
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CLICK HERE TO
Protest

But for those who cannot spare time specially
for making their point, it does present the
option of lessening the guilt! A few clicks of the
mouse and you’ve done your bit, for the month
at least. Doesn’t sound much like activism...
that’s exactly why it works.

The easy and quick nature of this type of
protest ensures that a large number of people
move a cause. In most cases, online petitions are
signed by almost twice the number of people

who could be in direct contact
with the issue. 

Mithun Kidambi

ow many times have you taken to the
streets to protest a cause? Never? You
also probably don’t cringe every time

you hear about the plight of the Bengal tiger, or
when yet another rain forest in South America
falls to the axe of the lumber mafia there. 

Despite the lack of popularity of armchair
activists, many of us would be more than glad to
register our protests from the comfort of our
homes or offices. And you can. For all those
wannabe armchair activists out these—all those
of you who care, yet cannot or will not take part
in a morcha—the Internet comes as a medium to
air your views, and
sometimes, even 
take action. 

Why Online?
Online, or cyber-
activism, comes
across as ‘the
easy way out’.

The spirit is willing but the flesh is weak… that’s the case with most of us when it comes to
causes we care about. Can the Internet make a difference?

H
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Cyber-activism transcends geographical lim-
itations and ensures the issue is kept alive 24/7.

To illustrate this point, an online petition to
push for a permanent seat for India in the United
Nations Security Council (UNSC), put up on
www.sulekha.com, a networking hub for Indians
from around the world, garnered more than
55,000 signatures from across 120 countries.
What’s more interesting is that many of these
signatories were willing to take time out and vol-
unteer for the cause. 

Many hardline activists, though, are not sold
to the idea of the strategic effect of an online
petition. What is increasingly being realised,
though, is that the Internet could not only play
a significant role in tackling these pressing prob-
lems, but also has the potential of letting the
oppressed speak out and be heard. 

Petitions, Causes, Blogs
The Internet helps activists save costs in collect-
ing and distributing information, finding like-
minded people to support a cause and training
them, and raising funds for the purpose. People
in remote areas can participate just as effective-
ly in e-mail discussions, like those in larger
cities. Increasingly, as the medium itself
becomes cheaper to access and more multime-
dia-like in nature, it opens up to a larger seg-
ments of society. Those affected might finally
have a way to tell the world of their plight, with-
out needing intermediaries.

Activism on the Net can be broadly classified
into two categories. One involves signing a pre-
drafted petition, many of which are put up on
sites such as www.petitiononline.com, www.peti-
tionspot.com, www.ipetitions.com, and
www.thepetitionsite.com. 

These sites have petitions indexed by topic
and area. Registering a petition is really simple;
however, www.petitiononline.com, 
for example,  does not have a moder-
ator to sift through the non-serious
petitions. This results in a large
number of inane petitions like “Get
my girlfriend back!” by Douglas Cor-
nell of ‘Doug loves Shannon Inc.’.

In the other type, one uses a blog
or Web site dedicated to a single
cause. Examples are www.cleanwat-
eraction.org, www.greenpeace.org,

www.makingindiagreen.org and www.
oneworld.net, which have people registered
with them as cyber-activists. 

A different kind of example is networking
sites such as www.actionnetwork.org, which
functions as a gateway to as many as 170 leading
environment, health and population advocacy
organisations. These cyber-activists are kept
updated about various protests and activities
through a regular newsletter. Activists can also
download action kits, send Flash-animated post-
cards to friends, and play informative games. 

The Scene In India
Cyber-activism has been around in India ever
since the Education and Research Network—the
ERNET—set up by the Government of India and
the United Nations Development Program
(UNDP), gained some popularity. 

The first known case of a movement on the
Net was back in 1995, at a time when BBSes
(Bulletin Board Services) comprised much of
ERNET. Enthusiasts ran the BBSes in their spare
time, using their own funds. The government
suddenly deemed these as profit-making corpo-
rations fit for taxation. And the Department of
Telecommunications (DoT) decided that Rs 15
lakh annually from each BBS operator as a
‘license fee’ was appropriate.

Obviously, no operator could afford this.
There was an uproar, and a group called FREE
was formed. They fought the case and by active
lobbying, won. The license fee was withdrawn.
This was India’s first brush with online activism.

The scenario today is very different, with an
unregulated Internet, and a large connected pop-
ulation aware of the issues plaguing it. The pop-
ularity of the Internet as a medium for
communication has altered the demographic
break up of today’s cyber-activists. “College stu-
dents form the majority of cyber-activists today,
but there are also housewives and teachers with
access to computers at home who participate in
our cyber-actions,” says Shailendra Yashwant,
campaign director, Greenpeace India. 

India has the largest number—and the widest
range—of NGOs and it is therefore natural for
cyber-activism to be active here. 

One of the longest sustained campaigns has
been the one against genetically modified (or
GM) foodgrains and crops. Many environmental
groups including Greenpeace claim India is
being converted into a dumping ground or
testing area by major multinationals. 

More Than The Birds And The Bees
Environmentalists have been at the forefront of
using the Internet as a formidable tool of protest.
Almost all major groups working towards the pro-

tection of the environment have a
strong presence in cyberspace. 

The Worldwide Fund for Nature
(www.panda.org), too, has a cyber-
activism cell, akin to the one run by
Greenpeace. However, its activities are
not as aggressive.  Other organisa-
tions such as PETA (People for Ethical
Treatment of Animals) India do not
have a specific online activism cell,

College students
form the
majority of
cyber-activists
today
Shailendra Yashwant, 
Campaign Director,
Greenpeace India

A Valid Petition 
Almost always supported by an established organisation such as the
Worldwide Fund for Nature or Greenpeace
These do not carry a must-forward clause. The receiver is free to forward it if
he so wishes
These are usually based on an issue you have heard of or read before

Spam
Supported by organisations that you’ve never heard of before; chances are no
one has. Example: Mothers Against Drunken Driving
Always has  a must-forward clause
The issues being dealt with are not concrete. Mostly talk of direct help. For
example, “Forward this mail to XXX people, and for every forward, Microsoft
(or some other major company) will contribute $1 to the cause.”

Know The Real Petition 
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but do have downloadable literature.
Additionally, they allow downloads of
their ads for use on your Web site.

So is online activism is restricted
to social or environmental issues?
Thanks to the media, no. 

One of the strongest movements
witnessed recently on the Net was
against the forced closure of the blog
‘Mediaah!’ The blog, run by a jour-
nalist, carried daily updates about
Indian media houses. Written in a chatty, gos-
sipy style, it gave out bits of ‘insider’ news on
the activities of various big media houses. Its
activities, though, were cut short since some of
those mentioned on the site did not seem to
agreee with the views expressed.

According the Indian IT Act, the respondent
to the notice should have been the service
provider—in this case, Google—and not the
author. But, rather than challenge the notice,
he decided to shut shop. 

“This is a classic case of a large media house
throttling our fundamental right of free
speech,” says Rohit Gupta, a journalist and a pro-
lific blogger. Gupta and fellow bloggers from
around the world are campaigning against blogs
being attacked by entities with vested interests.
“It’s time these people realised that just because
they have the muscle power they cannot
trample upon our rights,” says Gupta.

Thanks to the unregulated nature of the
Internet, an anonymous blogger can potentially
set up a blog called www.mediaha.blogspot.com
with all the allegedly offensive articles, and
also scanned copies of the legal notice served 
to Mediaah! 

Not Just Petitions And Protests
So is it just about signing petitions and post-
ing protests, or is there something concrete
about the process? There definitely is a move
beyond your desktop. 

This is best illustrated by the amount of
relief that flowed in during the tsunami of
some months ago. Several blogs and Web sites
were set up to coordinate relief work and dis-
pense accurate information. 

There is, however, only this much that any
petition can do—whether posted online of dis-
tributed among people. To mobilise people,
one needs to move from just spreading the
word and gathering information. 

All the relief work during the tsunami was
possible because there were people on the
ground who knew how to handle the situation.
The Internet just acted as a facilitator; a one-
point control centre. Can an issue be tackled
only by protests lodged on the Net? “It depends
entirely on the issue at hand,” says Yashwant.  

A customer-savvy corporation will pay atten-
tion to what its customers are saying. Compa-
nies like Microsoft have a cell to address
consumer complaints and tackle issues that are
posted on the Net. Likewise, e-friendly states
with a high level of e-governance could look at
incoming mails and stop an ill-advised project. 

Morphed forms of activism on the Net are
also gaining ground. One of the more popular

ones is ‘hacktivism’. This new phe-
nomenon of protest in the cyber-
world is a synthesis of social
activism and hacking. 

‘Hacktivists’ are a bunch of
people who want to transport the
movement of civil disobedience onto
the Internet. In December 1999, a
group called the Electrohippies
organised a “WTO virtual sit-in” that
overloaded the machines hosting

the World Trade Organisation’s Web pages. Esti-
mates say over 450,000 people swamped the site. 

This disrupted traffic to the site for close to
five hours daily. Some question whether it’s an
acceptable form of protest, but hacktivists hope
to defuse criticism by popularising not just their
tools, but also their code of ethics—by publicising
their intentions before any attack or action.

It’s All A Number Game
Over the last couple of years, online protests have
garnered support from around the world. when
the movements gained public acceptance. 

In Bhopal, for example, on August 15, 1999,
Greenpeace India launched its first cyber-protest.
A cyber-café was set up in the middle of J P Nagar,
literally in the shadow of the Union Carbide fac-
tory. Thousands of residents sent out e-mails
from this facility. 

After nearly 3,000 mails, Union Carbide was
forced to shut down its corporate mail centre to
screen out e-mails arriving from Bhopal. The case
recently got a boost when, after a sustained e-mail
campaign, the Government of India gave the US
courts a green signal to accept cases filed by
Indians against Union Carbide.

With advancements in technology, it is only
natural that each of man’s ways of expressing and
emphasising his individuality will adapt with
time. Protests are a way of pushing for and
stressing one’s rights. There has been a funda-
mental shift in the way protests are carried out. 

But with effectiveness failing to back up the
numbers, purists are still wont to describe online
activism as all bark and no ‘byte’. 

mithun_kidambi@thinkdigit.com

It’s time these
people realised
that just because
they have the
muscle power
they cannot
trample upon
our rights
Rohit Gupta, 
Journalist and Blogger

With the Internet, it’s not difficult to run into stuff that will have you laughing
silly. It’s no different with online petitions. Here’s one:

“Put The Star Wars Kid In Star Wars III”
This is addressed to George Lucas, the creator of the ‘Star Wars’ series.

Who is the ‘Star Wars Kid’?
He is a 15-year-old from Quebec. Back in November 2002, while playing around

at a school video studio, the boy recorded himself fighting a mock battle using a
broomstick as a lightsaber. The two-minute video has the teenager twirling his
mock lightsaber while making his own accompanying sound effects. 

His friends found the tape and uploaded it to KaZaA as a joke. Within two
weeks, someone had added the gamut of Star Wars special effects and sounds to
the tape, and the video was linked on gaming, technology, and Star Wars-related
sites across the Internet. 

Now What?
This petition, up on www.petitiononline.com, has garnered close to 150,000

signatures. Will we see more of him?

The Quirkies
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At the Shared Tissue Engineering Labora-
tory at the Medical University of South
Carolina, scientists use machines to

‘print out’ skin. The printed skin could eventu-
ally replace skin grafting, which is used for
burn victims as well as for cosmetic purposes.
The machines are shooting out the proteins
that will constitute the skin, and the tissue is
being captured on specialised gel.

There’s probably nothing overly interesting
about that, but what’s amazing here is that the
machines are old HP and Canon inkjet printers! 

Whoever said the unassuming inkjet could
only be used for printing out documents, reports
and such? Certainly not the inventors of the tech-
nology! They were experimenting with a variety
of uses for it, and it just so happened that print-
ing on paper got most quickly commercialised.
Now, researchers are going back to their draw-
ing boards and finding seemingly exotic, yet
eminently practical, uses for the technology
behind the print nozzle.

You see, the print nozzle is an exquisite piece
of technology: it has many, many holes, and
squeezes out extremely tiny droplets of whatever
is in the cartridge. That’s where its potential lies.
Instead of just ink, you could think of anything

A Plan +
A Printer = A Product!
The exquisite technology behind the inkjet is so versatile, the uses are virtually
limitless. “Take a plan and print it out” could soon work for almost anything—from
MP3 players to houses!

Illu
stration Shyam Shriram
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to put in the cartridge, and instead of paper, you
could think of just about anything for the ‘ink’
to be deposited on.

Although printing out skin is an interesting
and useful idea in itself, one can easily extend
the concept. How about printing out display
screens? Printed circuit boards? MP3 players?
Entire houses?

But we’re getting ahead of ourselves. In
what follows, we’ll talk about 3D printing—
instead of just one print head moving to and
fro in one dimension, imagine several print
heads capable of moving in all three dimen-
sions, depositing anything you could imagine
on any suitable surface. Or, a regular inkjet
printer could print layer upon layer, thus
making up a 3D object—for example, a bone or
an internal organ.

What you have then, are machines capable
of printing, well, just about anything. For exam-
ple, instead of constructing an MP3 player part
by part, incorporating the PCB, the plastic
moulding, the hard disk and so on, you could
just create a blueprint of the entire device and
print it all out at once. That’s the idea behind
most of what follows—a plan being printed out.

Here’s a glimpse at what is being printed
now, and what will be printed in the near
future; and all of it goes far beyond plain old
paper and ink.

Skin, Bone And Cartilage
So how does all this work? Like we mentioned,
the inkjet printer is a marvel of technology
because of the print nozzle, which spits out
thousands of microdroplets. As an example,
think about grafting skin onto a wound. A 2D
inkjet printer will suffice for skin because the
proteins shot out can be captured on a flat gel
substrate layer. Experts enter the wound’s dimen-
sions into the printer to ensure a perfect fit. They
then take skin cells from the patient’s body and
multiply them using biological techniques, and
then print out a strip of skin that is tailor-made
for the wound—and ready to sew on.

Such a printer has been developed at
Manchester University in England; it only takes
up the area of three filing cabinets. At the
university’s School of Materials, scientists have
already successfully created skin, and think
they will soon be able to create bone and carti-
lage as well.

Team leader Professor Brian Derby says, “It’s
not like printing a sheet of paper. We can print
a few millimetres in depth and build it up layer-
upon-layer until, in principle, we could produce
bone fragments the size of a golf ball.” Project
leaders say the method could eventually be used
to build an organ in a day!

The amazing thing here is that it’s basically
inkjet technology at work.

Instead of
constructing an
MP3 player part
by part, you
could just create
a blueprint of
the entire device
and print it all
out at once

Inkjets For Just About Anything

Faxing Up Spare Parts
Think about the plight of an astronaut in space when something
breaks. Where would he get a spare part from? Roger Spielman, a
scientist for Boeing Canoga Park, has the answer: fax and print.
One could ‘fax’ the 3D computer-aided design file to the
International Space Station, where the data would be fed into a
machine that assembles the required spare part from a bucket of
powder. This, if you think about it, is not very far from faxing a
physical object!

Printing Out A Heart
Tissue engineering combines the disciplines of cell biology,
materials engineering, and biochemistry to create biological
substitutes for human and animal tissue. At Clemson University in
South Carolina, chemical engineer Thomas Boland had a novel idea
in 2001 that brought the inkjet into tissue engineering. His method
was deceptively simple: you could build up a 3D tissue by modifying
the printers’ output tray to drop down a little bit with each pass of
the print head. Boland used his printers to create half a cat’s
heart—the heart actually beat in a petri dish!

Fuel Injection And Medicine Atomising
Since an inkjet sprays tiny droplets, one of the first uses that
springs to mind is fuel injection. A regular injector does the same
thing, atomising petrol (or diesel) into tiny droplets, but the smaller
the droplets, the more completely they will vaporise and mix with
air, making for more efficient fuel burning. An inkjet can therefore
be part of extremely precisely controlled fuel injectors.

Think about medical inhalers, such as asthma medication
inhalers. As with fuel injection, the task of creating the spray that
these inhalers spit out is ideally suited to the inkjet. The problem
is that conventional inhalers spray out a mist of drops that are too
large, and also uneven. The inkjet can remedy this: digital
aerosols, which are thermal print heads incorporated into inhalers
that spit out perfectly uniform drops, could come to market as

early as the end of 2005. This method of injection is ideally suited
to drugs that need to get to the bloodstream—the smaller the size
of the droplets, the easier the absorption of the medicine into the
bloodstream.

Digital aerosols are being developed by Australian company
InJet Digital Aerosols. The inhalers will deliver drugs faster than do
tablets or patches.

Flexible Plastic Screens
Several companies worldwide are in the race to commercialise
flexible plastic-screen technology. Philips is currently using a four-
headed inkjet with hundreds of piezoelectric nozzles to print OLEDs
(Organic Light-Emitting Diodes) onto computer and television
screens. You have probably heard of OLED screens—OLEDs glow
when a current is applied. (Piezoelectric nozzles are one of the two
commonly-used types of nozzle—the other is a thermal nozzle. A
piezoelectric nozzle works when a current bends a piezoelectric
crystal, forcing the fluid down and out of the nozzle. One of the
properties of piezoelectric crystals is that they move or bend when
a current is applied, and they release a current when bent.)

In Bristol, England, HP engineers are using inkjets to etch tiny
liquid-crystal dots onto a plastic substrate—the dots themselves will
be the pixels. Electrodes in the plastic, which is bendable, turn the
crystals on and off, making for a full-colour display that would, at
some point, compare with printed material in terms of resolution.

Circuit Boards
As was proved by Japanese engineers at Seiko-Epson, printing
the innards of a gadget is possible using inkjets. In November
2003, they printed a circuit board consisting of 20 layers, and
only 200 microns thick. How? They simply swapped copper for
conductive inks and silicon for insulating inks. A piezoelectric
print head with microscopic nozzles was used for the process.
Seiko-Epson is confident that these thin boards will be used in
gadgets as early as 2007!
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3D Printing
Going beyond 2D inkjets, think about 3D print-
ers. A 3D printer is essentially a modelling tool,
which can create plastic moulds and such. As
an example, Z Corp, based in Burlington, Mass-
achusetts, USA, markets an “affordable 3D
printing system”, which uses a spray nozzle
adapted from an HP inkjet printer, to spray a
liquid that binds powdered solid substances
into a certain shape.

Z Corp began shipment of its Spectrum
Z510 3D printing system in March of this year—
the first high-definition colour 3D printer ever
to hit the market. The Z510 introduced HD3DP
(high-definition 3D printing) for rapid proto-
typing to designers, engineers, and product
developers. (Rapid prototyping refers to a 
class of technologies that can construct physi-
cal models from Computer-Aided Design, or
CAD, data.)

Using the system interface, product devel-
opers could now efficiently print 3D physical
models with smaller features and more
complex geometries, in colour, and with high-
definition detail. The system software also
allows for labelling, enhanced texture
mapping, and vibrant product colouring. The
Z510 initially retailed at $49,900 (Rs 21 lakh) in
the United States.

But such printers can, obviously, be used for
more than just modelling and visualisation. It’s
all about design: you feed in the requisite data to
the printer, and it constructs the required object
according to the blueprint.

And that is something to think about. You
could feed in a blueprint for just about
anything! Could such inkjet (and other) print-
ing technologies democratise manufacturing
the way the invention of the printing press
democratised knowledge hundreds of years
ago? Instead of inkjet printers that print just
words and graphics on paper, we could all have
3D printers sitting on our desks, printing out
whatever we told them to. 

And what would that mean in terms of who
would make the money? There would be a para-

digm shift: you
would pay for plans
rather than for prod-
ucts. Download a
plan, print out the
product. You are
probably already
i m a g i n i n g
P2P networks that
you could download
plans off!

What kinds of
product would you
really be able to
print out? What is
feasible in reality?
As an indicator,
instead of looking 
at fiction of the
future, let’s look at
what is being done
right now.

Flexonics
John Canny, professor of engineering at the
University of California, Berkeley, and his co-
investigator Vivek Subramanian, are using
electroactive polymers, gold nanocrystals and
inkjet printers to print devices that can move
as well as process information. (Electroactive
polymers are substances that respond to exter-
nal electrical stimulation by displaying a
significant displacement in shape or size, and
nanocrystals are a non-traditional type of semi-
conductor.) They call this process ‘flexonics’. 

This revolutionary approach to desktop
manufacturing has been enabled by recent
advances in 3-D printers and organic electronics.

Printing Out Houses

Better inhalers for better delivery of drugs. Plastic screens. Tissue
engineering. Fuel injection. Rocket spare parts. Bones. Organs. Skin.

What is not possible with inkjet technologies? Houses? As it turns out,
houses can be printed out, too. One researcher has plans to, as he puts it,
“be able to completely construct a one-storey, 2000-square foot home on-
site, in one day and without using human hands”, by ‘printing’ the house.

Engineer Behrokh Khoshnevis, at the University of Southern California,
has been perfecting his ‘Contour Crafter’ for more than a year now. It
‘prints’ houses, and is to be tested by the construction industry. It takes
instructions directly from an architect’s computerised drawings and then
squirts layers of concrete one on top of the other to build vertical walls.
The precision automaton could revolutionise building sites, for the simple
reason that it can work round the clock, in darkness and without breaks.

The key to the technology is a computer-guided nozzle that deposits a
line of wet concrete, something like toothpaste being squeezed out. Two
trowels, attached to the nozzle, move to shape the formed deposit. The
robot repeats the same step many times to give height; hollow walls are
built and the machine returns to fill them.

Degussa AG, of Düsseldorf, Germany, will collaborate on Khoshnevis’
project to help him find the best kind of building material. Khoshnevis has
tested his prototype with cement, but believes that adobe—a mix of mud
and straw dried by the sun—might be suitable.

Khoshnevis’ prototype robot hangs from a movable overhead gantry (a
large supporting structure). The first house will be built later this year. If
the technology proves successful, the robot could enable new designs that
cannot be implemented using conventional methods, for example,
structures involving complex curving walls.

How Inkjet Nozzles Work

There are two types of inkjet nozzles—piezoelectric, on the left, and thermal, on the right. In the former, a current
bends the crystal, which forces the ink out. In a thermal nozzle, it’s based on the formation of an air bubble.

Electric current

A Piezoelectric Nozzle A Thermal Nozzle

Piezoelectric 
crystal bends

Heat causes air
bubble

Vacuum causes
refilling from
ink well

Ink gets
forced out

Ink is forced 
out of the nozzle

From ink
well
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Their research will allow fully-assembled electric and elec-
tronic gadgets to be printed in one go, instead of going the
traditional way—creating a casing and then filling it with
electronic circuit boards and components. Printing a
complete and fully-assembled device by printing layer upon
layer of conducting and semiconducting polymers, the
device circuitry is built up as part of the bodywork.

When the technique is perfected, devices such as light
bulbs, cell phones, radios, remote controls and toys will be
spat out from printers as individual, fully-functional systems
without expensive and labour-intensive production on an
assembly line. 

Three-dimensional printers are valuable tools for making
prototypes of new designs. They deposit layers made from
droplets of smart polymers, which gradually build up into
3D shapes. (Smart polymers are fascinating materials that
show distinct responses to differences and variations in the
environment, such as thermal gradient. They are called
‘smart’ because one can actually harvest their odd properties
to benefit a wide range of applications.)

Such printing techniques have now become so sophisti-
cated that it is possible to print working prototypes 
with mechanical parts that move just as they would in the
final product.

The University of Berkeley’s important addition to this
art is to allow the electronics to be included in the printed
device, rather than being added at a cost later.

Already, the Berkeley team has worked out how to print
out electronic components such as transistors, capacitors,
inductive coils and other semiconductor components.
“These may be connected to form complete circuits for actu-
ation and control,” says Canny. He also believes that once
they develop inkjet cartridges that can handle all the poly-
mers needed for casing and circuit printing, they would be
able to make, say, a remote control.

It would be printed as a single component, rather than
being built up of smaller components. The infrared emitter
and all the other electronics would be polymer-based.

Is There Anything We Can’t Print?
Brains, probably!

There are so many uses for the inkjet, 3D or otherwise,
that it’s overwhelming. You sort of get the idea that there is
nothing that cannot be printed out.

The point here is twofold: first, desktop manufacturing
will revolutionise the way we think of products. With flex-
onics maturing, and with high-quality 3D printers getting
cheaper, we will soon enter an age where, like we
mentioned, you will pay for plans rather than for parts.

Second, one needs to remember that not all materials
and substrates have been researched. For example, to print
out, say, a handbag, you would need a process that could
extrude leather out of a nozzle, which is not very realistic,
at least for now.

Another limiting factor is how easily plans can be laid
out for the object: if it’s something like a screwdriver, it’s
relatively easy because the dimensions and other properties
are well-known and easily documented. And as we
mentioned, it would be difficult to print out a handbag
because it’s not quite so easily defined.

Desktop manufacturing could easily become a buzzword
in the near future. Remember, you read about it first in Digit!
Research in the areas we’ve mentioned is ongoing and excit-
ing. Roger Spielman of Boeing probably sums it up best: “It’s
actually happening. You’re going to hear a lot about this in
the near future. There are hundreds of uses. You can build a
part in a part. You can build a ship in a bottle. We can make
real things out of dust.” 

ram_mohan@thinkdigit.com

1/2 pg AD
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Digital Light Processing (DLP) is a tech-
nique used to project images and is based
around a specialised optical semicon-

ductor chip—a Digital Micromirror Device
(DMD), developed by Texas Instruments (TI).
Today, DLP powers general purpose conference
room projectors, and over the years, has
spawned a new category of small, ultra-portable
mobile projectors.

Although initially developed for projection
processes, DLP is now used in telecommunica-
tions, scientific instrumentation, volumetric
displays, holographic data storages, lithography
and medical imaging. 

Digital Light Processing, a technology that led to
miniaturisation of projectors, has the potential to
replace the ageing film-based projection of movies in
theatres, and more…    

Let’s take a closer look at what
makes a DLP system tick. 

The Chip That Rocks
The Cradle
The soul of any DLP
system is the Digital

Micromirror Device (DMD)
chip, which was developed by

Dr Larry Hornbeck at Texas Instru-
ments (TI) in 1987. Over the years of devel-

opment, starting from 1977, to the release of
the first commercial product in 1996, DLP
technology has been perfected to deliver the
goods it promises. 

A DMD chip consists of an array of two
million microscopic hinged mirrors that can be
individually tilted using digital signals. The tilt-
ing motion allows them to be used as a switch
to modulate light in a particular direction, and
are often referred to as light switches or Spatial
Light Modulators (SLMs). 

Each aluminium micromirror is a 16
micrometer square, polished to reflect light in
the desired direction. The combination of a
micromirror, the hinge assembly and an address
pad forms one pixel of the DMD. 

The Stuff It’s Made Of
The mirror has a central post on which it is pivoted
(as shown above: Anatomy Of A Micromirror); the
other end of the post is connected to the yoke of
the hinge assembly. The hinge assembly consists of
a central yoke that is suspended between two
support posts via a torsional hinge.

Two address electrodes are placed coincid-
ing with the diagonal ends of the mirror, with
a gap of air left between the mirror surface and
the address electrode, so as to enable the tilting
motion of the mirror.

The hinge assembly, as a whole, is responsi-
ble for the tilting motion of the mirror. The
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Using a 
single DMD,
smaller 
projectors 
can be made,
which offer
results on 
par with 
projectors 
based on 
slower light
modulators

address pad has two pads—one feeds the address
electrodes with the required signal while the
other sends the ‘Reset’ signal to the yoke in the
hinge assembly via the supporting post. The
address pad acts as an interface between the
mechanical mirrors and the CMOS addressing
logic that forms the substrate of a DMD chip.

Since a DMD is an amalgamation of an opti-
cal device with a semiconductor controlling
base, it is called an Optical Semiconductor. Such
devices fall under a category known as Micro-
Electronic Mechanical Systems (MEMS). A DMD
is a ‘MEMS’ primarily because it has millions of
mechanically moving micromirror’s controlled
via CMOS electronics. 

How Stuff Works
To modulate light in a particular direction, the
mirror can be rotated to a maximum of ±12
degrees, depending on the state of the CMOS
circuitry lying underneath each mirror. The
CMOS applies a voltage to the address electrode
of the hinge assembly to create an electrostatic
attraction between the electrode and the
mirror, which, in turn, results in the tilting of
the mirror in the desired direction. 

When the CMOS is in the ‘ON’ state the
mirror rotates to +12 degrees, whereas when
the CMOS is in ‘OFF’ state the mirror rotates to
-12 degrees. Once the rotation completes, the
mirror is electro-mechanically latched in the
desired direction, and the state of the CMOS
can change without affecting the position of
the mirror. 

Typically, for projection purposes, a metal-
halide lamp is used as a light source. The white
light from such a source is projected on the
DMD using focusing optics. 

The arrangement of the light source, with
respect to the DMD chip, is such that all micro
mirrors that are in the ‘ON’ state reflect the inci-

dent light to the pupil of the projecting lens,
whereas the micromirrors in ‘OFF’ state reflect
the incident light on to a light absorber.

The controller driving the CMOS states (ON
or OFF), can change a thousand times per
second. In other words, each mirror on the DMD
either switches ‘ON’ or remains ‘OFF’ a thou-
sand times per second. 

When a particular micromirror remains
‘ON’ more frequently than ‘OFF’, it will project
a grey pixel on the screen whereas the
micromirror that remains ‘OFF’ than ‘ON’
reflects a darker shade of grey. In this way by
precisely controlling the rotation of the mirrors,
the DMD is able to produces a grey scale that
can go up to 1024 shades of grey.      

Once you have a grey scale solution in place,
producing colour is just a matter of introducing
a colour wheel, consisting of red, green and blue
filters between the light source and the DMD.

The rotation of the wheel is synchronised
with the controller that drives the CMOS of each
mirror. Now, for example, to project the colour
purple on the screen, a pixel will only project
red and blue light. 

The colour green is bypassed by ensuring
that the micromirror is in the ‘OFF’ position
when the green filter is in position, and turned
‘ON’ when the Red and Blue filters come into
position. Though this actually means that
different colours are flashed on the screen a
thousand times a second, the naked eye cannot
keep up with this and sees a mixture of red and
blue—purple.

Now, since each mirror is controlled by a
digital signal—issued to the CMOS circuitry by
a digital controller—the incident light is said
to be digitally modulated, and hence this tech-
nique is called Digital Light Processing (DLP).
It should be noted that during the whole
controlling or modulating process, the inci-
dent light never undergoes an optical-to-elec-
trical conversion, as is prevalent in digital
cameras and camcorders.   

The current generation of DMDs have a
mechanical switching time of 15µs (microsec-
onds) and an optical switching of 2µs. Such fast

A Three Chip DLP Projector Configuration 
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Three DMD Chips are used in high-end DLP Projectors often used in places such
as auditoriums and theatres

Imaging Atul Deshmukh, Jayan Narayanan
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switching times offer the advantage of using a
single light modulator i.e., one DMD, to
produce 256 shades per primary colour, as
compared to other slower modulators which
require three separate modulators for
each primary colour. 

Thus, using a single DMD, smaller and more
compact projectors can be made, which offer
results on par or even better than projectors
based on slower light modulators, as in LCD
technologies, for instance. 

DLP In Projectors 
Depending on the number of DMDs used (one,
two, or three), three configurations of DLP
projectors are currently available in the market.
Remember, the choice of configuration
depends upon the intended application, cost,
brightness levels, lamp technology, weight and
power dissipation. 

One-chip configurations are normally used
in consumer grade products such as confer-
ence room projectors and televisions. The
single chip projector is cheaper, offers decent
brightness levels and results in smaller, more
portable designs. 

Generally, the two chip projectors are used
in situations where a longer lamp life is desired
since they offer better light efficiency. 

Three chip projectors offer the highest
optical efficiency, and hence are used in

venues where large-screen projection is
required, such as public information displays,
auditoriums and movie theatres. Shown 
on the previous page is a functional schematic
of a three chip DLP projector.   

Apart from the above-mentioned parame-
ters, ‘Resolution’ of the projected image is also
important. Products using DLP technology
capable of SVGA (800 x 600), XGA (1024 x 768)
and SXGA (1280 x 1024) are available in the
market. Recently, improvements have added
high definition capabilities to DMDs, and such
products will be available soon. 

DLP Cinema
The goal of most multimedia projector manu-
facturers is to offer a product that can rival the
quality of 35 mm film projection. The motion
picture industry has long since shifted to digi-
tal technology, in terms of the production of
movies; however, movie theatres still use last
century’s technology to show them to us. 

In recent years, the motion picture industry
has opted for multi-track sound formats such
as Dolby or DTS, resulting in a dramatically
improved aural experience. The visual experi-
ence though, remains outdated.

Moreover, film-based projection has severe
limitations—duplication and distribution is
expensive, deteriorating film quality with
repeated screening, focus flutters, travel ghost-
ing and inconvenient updating of post produc-
tion content such as advertisements. 

An exciting development in DLP technology
is all set to change this with the introduction of
DLP Cinema. The goal of DLP Cinema is to make
the entire motion picture industry a digital
industry, right from the production and distri-
bution, to the final presentation of the film. 

In 1997, a prototype using a 1280 x 1024
(SXGA) DMD called the DMD1210 was made,
for evaluating the rapid upgrading of existing
projectors to produce high quality, high
brightness images. It involved the technical
and creative community of the motion picture
industry. The DLP Cinema technology demon-
stration projector exceeded the expectations
of most people. 

Alhough, the DLP Cinema has apparent
advantages over film based projection, as was
proved by the demonstration, there are some
hurdles that the technology has to see through.
A considerable amount of work is needed in
terms of data compression, storage, and media
delivery, before the ‘Cinema of Tomorrow’ 
can materialise. 

sanket_naik@thinkdigit.com

DLP Versus LCD 

LCD competes directly with DLP in the projector segment, and hence the
question arises, “Which is better?” The fact of the matter is that neither of

them has a clear advantage over the other. Let’s have a quick look at the
advantages and disadvantages of both. 

Historically, LCD projectors have displayed better colour saturation than DLP
projectors. This is because DLP projectors have a clear white panel in the colour
wheel to boost brightness, due to which, the picture appears to be brighter than
normal, and causes colours to look dull. However, the latest DLP projectors have
a six-segment colour wheel, eliminating the white component. Despite this, LCD
projectors still seem to offer better colour saturation. 

On the other hand, DLP projectors offer better contrast video, with deeper
black shades than what LCDs are capable of. Leading LCD projectors are rated to
have 1000:1 contrast ratio, whereas a DLP projector is rated at 3000:1. 

LCD projectors offer sharper pictures at any resolution, when compared to
DLP projectors. The difference in sharpness is seen better when viewing high-
detail images of financial sheets, rather than during the playback of video. Of
course, this does not mean that DLP projected images are blotchy; the
differences can only be made out when a DLP projection is compared side-by-
side with an LCD projection. 

Unlike LCD projectors, DLP projectors are not plagued by pixelation
problems. Nevertheless, advances in LCD technology are overcoming
this limitation, and given time, even cheaper LCD projectors will
incorporate these developments. 

The most obvious advantage of DLP is the compact size of units that use a
single chip solution. Though LCD technology also aims at making smaller, more
compact projectors, they have a long way to go to catch up with DLP solutions. 

Market Overview
DLP projectors are manufactured by most consumer product manufacturers
including Sony, Panasonic, Toshiba, NEC, Mitsubishi and InFocus. IT companies
like BenQ, Acer and Dell have also entered this field and have at least one DLP
model. The cheapest DLP projector is available for Rs 60,000, but the price
can go as high as Rs 3 lakh for top-end models, which offer higher resolutions
and better features.

DMD Chips in increasing order of supported resolution

SVGA (800x600) XGA (1024x768) SXGA (1280x1024)

Digital DMD Controller Chip
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Disable the context
menu—the menu that
appears when you right-
click—from appearing
when you right-click
anywhere on the Desktop.
As always, you are not
permitted to use third-
party utilities.
Write in to
takeacrack@thinkdigit.com
with your solution

Go to Start > Run, and type
in “gpedit.msc”. This opens
the ‘Group Policy Editor’.
Once here, go to ‘Computer
Configuration’, and expand
Administrative Templates >
Windows Components >
Internet Explorer > Internet
Control Panel. On the right,
double-click ‘Disable the
Security page’, and then
click the ‘Enabled’ radio
button. Click ‘OK’. Then
double-click ‘Disable the
Connections page’, and
then click the ‘Enabled’
radio button. Click ‘OK’.

Do the same for
‘Advanced’. Close the Group
Policy Editor. Now, go to

Internet Options—by right-
clicking the Internet
Explorer shortcut—to see
the results.

If you like living
dangerously, you can also use
the registry editor. Go to Start
> Run, and type in “regedit”—
this opens the registry editor.
Navigate to HKEY_
USERS\.DEFAULT\Sof-
tware\Policies\Microsoft. If
there is a key ‘Internet
Explorer’ under ‘Microsoft’,
click on it, else create it: right-
click on ‘Microsoft’, click on
New > Key, and name the new
key ‘Internet Explorer’.

Similarly, under
‘Internet Explorer’, create a

key named ‘Control Panel’
if it does not already exist. 

Now right-click the
‘Control Panel’ key and
click on New > DWORD
Value. Name this
‘ConnectionsTab’. Double-
click it and set its value as
‘1’. This will disable the
‘Connections’ tab in
‘Internet Options’.

Similarly, create the
DWORD values ‘SecurityTab’
and ‘ContentTab’, and set
their values to ‘1’, to disable
the ‘Security’ and ‘Content’
tabs respectively. Close
the registry editor and check
‘Internet Options’ to view
the changes.

Disable right-clicking
anywhere on the
Desktop

THIS MONTH’S CHALLENGE

Remove the Internet Options tabs for Security, 

Connections and Advanced
LAST MONTH’S CHALLENGE

Win!

To remove the tabs, you need to naviagate to Administrative Templates > Windows Components > Internet Explorer >
Internet Control Panel. This is what the screen looks like at this point. Here, just disable the required entries



Get ready for 
the Portable 
entertainment 
revolution—play
games, music, and
videos on Sony’s 
new handheld 
gaming console

This incredibly powerful and much-awaited
handheld device from Sony has sold half a

million units in just the first two days of its
launch, and not without reason!

The PlayStation Portable features a large 4.3-
inch 16:9 aspect LCD screen with a really sharp
and crisp 480 x 272 resolution. It supports USB
2.0, Wi-Fi, Memory Stick Duo and uses Sony’s
proprietary Universal Media Disc (UMD, which
is more or less like a mini disc) and has a
massive 1.8 gig of space!

Apart from the huge list of game titles that
are being released en masse, this device will also
play music, video and image files, provided you
plug in a sufficiently large Memory Stick!

If you put it in the USB mode with the
Memory Stick inside, it can also act as a
removable USB drive. For a mere $300

(approximately Rs 15,000), the PSP is absolute
value for money, to say the least. We wish it
could also make phone calls. Now that would
redefine the term portable!
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PlayStation Portable
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Digital Passion l 30 days with...

Wacom Intuos3 Graphic Tablet

Day 1
I woke up early–this was a special day for me. I was

going to buy the tablet; My Dream Tool. An Intuos3 9

x 12 inch tablet. Yes, 9 x 12; a vast virtual playground

for a digital artist like me. It’s actually 13 x 17, but

the active area is 9 x 12.

Once in my hands, I opened the box delicately – and

wow, it was a work of art. A pleasant tungsten grey,

it sure had sex appeal!

There’s a cute little blue light on the top. Don’t

know what it does, but it looks cool... Installed the

drivers, which was a breeze. The foreplay over, it was

time for some real pleasure. I held the grip pen and

revved up Photoshop. Doodled for a long, long time in

Photoshop and Corel Painter IX.

Day 2
Drawing with a tablet was not a new thing for me—I

have another small tablet of a different make, which

cannot compare with the Intuos3. It’s sooo sensitive.

Drawing is much, much more fun now. I’m on top of

the world!

Day 4
Came to office with my new dream tool. It’s got great

flaunt value, too! And trust me, doing my daily work

was now heaven!

Day 5
I got two software free with the tablet—nik Color Efex

Pro 2.0 and Corel Painter Essentials 2 to experiment

with. The Intuos3 is, of course, cordless and battery-

free. It has another unique feature–tilt sensitivity,

which makes it feel even more like pencil on paper! I

can feel the difference in the strokes when I tilt the

pen. It feels so realistic, it’s easy to forget you aren’t

drawing on paper.

Day 10
The Intuos3 has 1,024 – yes, 1,024 – levels of tip and

eraser (yeah, there’s actually an eraser at the other

end of the stick) pressure sensitivity, so I can draw

more easily. It’s made just for artists like me. There

are express keys and a very sensitive touch strip –

much like a laptop touchpad – for zooming, panning

and more. My tablet has a 200 pps (points per pixel)

reporting rate, and an incredible resolution of 5,080

lines per inch. 

Day 13
Drawing is now sheer joy. Thank God I am an

illustrator! I can drag, zoom, pan; I can choose colours

without touching the keyboard. It also has [Alt], [Ctrl],

and [Shift] keys as well as a spacebar, and the best

part is, it’s compatible with all software. Whether it’s

Photoshop, Painter or Illustrator, it’s a made-for-each-

other kind of feeling.

Day 18
Just discovered that the Intuos3 has three types of nibs

for different drawing experiences. It has a ‘Standard’

nib; a ‘Stroke’ nib that includes a dual-spring

action for extended tip travel–a

real brush-like

experience; and a 

‘Felt’ nib designed

for a pencil-on-paper

feel. Imagine being

able to customise the

nib according to what

you’re drawing!

Day 30
By now, I’ve 

minimised the use 

of paper and pencil, 

because I have 

The Power Of The 

Intuos3. Got to leave 

now–my beauty beckons!

shyam_shriram@thinkdigit.com

Shyam Shriram

It’s like a dream in CMYK at 300 dpi: the Wacom Intuos3 tablet, a must-have for

all professional digital artists. The No. 1 tablet in the world, I’m told. I’m also

told it feels like pencil on paper—the ideal gadget for someone like me who wants

to make the shift to fully digital. Goodbye, pencil! Goodbye, paper!

Wacom Intuos3 Graphic Tablet

Digital Passion l 30 days with...
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Jumpstart

Meera Vankipuram

here there’s a will, there’s
a Web portal. An adage
‘tweaked’ for 21st century

reality, best describes the endeav-
ours of five entrepreneurs in India
who have utilised the marketing
portal ‘eBay.in’ to augment their
hitherto offline businesses. 

Sangeeta Gupta, vice presi-
dent, Events, National Associa-
tion of Software and Service
Companies (NASSCOM), says,
“The growth of the Internet
and the e-commerce market
in India has provided an

opportunity for SMBs and entre-
preneurs to sell their products to
a global marketplace, and also find
partners or customers in markets
they couldn’t reach earlier. 

Although, this trend is not as
widespread today, it is likely to

proliferate with the growth of
websites that provide entrepre-
neurs this oppportunity.”

Click To Sell
Chennai-based Shobha Suresh
and Sudha Ravishankar own
Trendyjute, a business dealing in
jute and jute products. Child-
hood friends and former
colleagues at a credit card
company, the duo flipped for all
things jute, a few years ago. 

This mutual ‘passion for jute’
materialised into a business of
customised jute products, built
largely through word-of-mouth
referrals. Trendyjute, earlier a
local offline distributorship, soon
started getting queries and orders
from all corners of the nation, and

W

Technology For Personal And SoHo Productivity

GenNext 
Entrepreneurs

65 Sound Solutions Mobile Wallet Work Easier

Is having a nationwide retail reach a tall order for businesses? Not anymore,
say entrepreneurs who use eBay.in as their online retail outlet  

Imaging Atul Deshmukh
Photographs Chandroo and Mexy Xavier

Sudha Ravishankar of
Chennai and Devesh
Tanna of Mumbai
show off the
goods they
sell on
eBay.in
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opportunity to diversify without
additional hassles. 

Diversification It Is
Diversification is the name of the
game, more so, for enterprising
businessmen. Meet Devesh Tanna
of Mumbai. A commerce gradu-
ate, Tanna started out with a
wholesale business of selling
gifts and toys to retailers,
sourced from factories in Noida.
Referring to eBay.in, Tanna says,
“The portal gave me one more
avenue to display my products. 
I liked the idea—a service 
that has no initial entry cost or
listing price.” 

Soon computer peripherals
caught his ‘biz eye’, and Tanna
realised that there was a good
market for these in India. He
adds, “I source peripherals from
distributors including Rashi,
Neoteric, Mediatech and Savex.”

“I cannot afford to invest in a
website of my own—a business-to-
consumer (B2C) portal would
require a lot of marketing.
Instead, I invested time and effort
in surfing eBay.in and identifying

items that were
hugely in demand,”
says Tanna. He
claims the business
has been profitable
till date. 

Level Playing
Field
Gautam Thakar,
marketing director,
eBay India, feels
that the key advan-
tage of eBay.in lies
in the wide ‘reach’
it gives to sellers.
Sellers can access

almost 135 million users from
sites in 32 countries. 

Thakar says, “Globally, nearly
5 lakh people make all or part of
their living on eBay. In India, only
a few thousand sellers make most
of their income on eBay.in.” 

He adds, “On eBay.in, one can
sell anything—from coins to
camcorders. Sellers need minimal
or zero investment to start. eBay.in
offers tools like ‘Turbo Lister’ (helps
list items offline using eBay's
templates) and ‘Selling Manager’ (a
sales management tool  that tracks
account activity) to assist sellers
manage their business and trans-
actions effectively, online.”

Indeed, eBay.in levels the play-
ing field. The seller—whether a big
brand, SME, trader or an individ-
ual—is given the same set of tools,
and charged the same amount to
trade products and services online.

Retail Right
Praveen Dwarkanath and Amit
Rakhecha own Nucleus Comput-
ers, a small firm in Bangalore.
They employ aggressive sales
tactics, such as,  hiring three
member teams to monitor site
activity, answer customers queries
and co-ordinate sales.  “We began
by selling a mere headphone.
Today, we sell all computer
peripherals online,” says
Dwarkanath.

“We manage to relieve dealers
of stock lots in record time. In
fact, we were the largest single
sellers of Mercury digicams in
South India, some months ago.
Once, we   sourced a requirement
of 72 pieces of a Palm DV
camcorder in a few days. We have
seen a 30 per cent increase 
in revenue, due to our online 
presence on eBay.in since 2001,”
adds Dwarkanath.

Boosting E-commerce
Using the web for retail is a
trend that may signal the revival
of e-commerce in India. The
prime movers of the next gener-
ation of e-commerce models will
be entrepreneurs, who are
unafraid to depart from the
conventional strategies of sales
and marketing. 

Of course, long-term sustain-
ability will depend on the ability
of such entrepreneurs to adapt to
rapid market changes and tech-
nological advancements. For, to
the smart e-enabled marketer,
belong the spoils. 

meera_vankipuram@thinkdigit.com

even from people travelling
abroad, and NRIs—all through a
listing on eBay.in. 

Trendyjute’s products, includ-
ing seminar bags, folders, and the
like are custom-made in produc-
tion units at Chennai. 

Explains Sudha, “We wanted to
utilise our experience of corporate
marketing to further our business.
We discuss the specifics with
clients, and negotiate fabric rates
before placing an order with the
production units. We involve the
customer at every stage.” 

Expanding Frontiers
While the duo regularly conduct
exhibitions to display their prod-
ucts, an online presence has given
an incredible boost to their deal-
ings. Says Sudha, “Apart from the
exposure it gives our products, I
like the payment model on eBay.”
(See box: The eBay Way)

As an online marketplace,
eBay.in helps SMBs to have a self-
sustaining business, and avoid
overheads such as advertisement,
showrooms and marketing. Also,
eBay.in gives entrepreneurs an

Find
Select the product of
your choice from

hundreds of product
categories (and sub-
categories), as well as  
global sites. 

Buy/Sell
Make a list of items
you would like to

buy. You can avail of the
following services on
registration—item details,
feedback from the 
sellers, and their 
contact information. 

Similarly, to sell an item,
host a picture of your
product on the site along
with a brief description of
the product and your contact
details. Also, eBay.in offers
‘Advanced Selling Tips’ for
sellers, visit
http://snipurl.com/dw54.

Pay
To make international
payments, the two

parties can use mutually
convenient electronic payment
methods or international
demand drafts. For

transactions within India,
buyers can use the PaisaPay
service that facilitates credit
card payments and online
bank transfers. 

In PaisaPay, buyers pay
using a credit card or online
bank transfer. The seller is
credited for the payment
once the bank has confirmed
the transaction. A cheque/DD
is sent by eBay.in to each
seller. Sellers are charged a
percentage of their
transaction for payments
made via Credit Card or
online bank transfer.

The eBay Way

www.ebay.in: An online haven for Indian retailers

"eBay.in also
offers tools
such as ‘Turbo
Lister’ and
‘Selling
Manager’ to
assist sellers
manage their
business and
transactions
effectively,
online.”

Gautam Thakar, 
Marketing Director, 
eBay India, 
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Place Tables Side By Side
To position two tables
adjacent to each other

instead of one above the
other, first insert two tables,
one above the other. Adjust
the column widths to ensure
that the width of each table
is less than half the width of
the page. Select both tables.
On the toolbar, go to Format
> Columns, and select ‘Two’
under ‘Presets’. The two
tables should now appear side
by side.

Precise Table
Measurements

You can adjust table
column and row widths

by dragging the cell
boundaries. But these
boundaries snap to a grid,
and it can be difficult to line
up your columns or rows
precisely. First, make the
ruler visible (if it isn’t
already) by clicking ‘Ruler’ in
the ‘View’ menu. Now, to turn
off the default ‘Snap to Grid’,
and to display detailed
column and row
measurements in the ruler,
click a cell and then hold
down [Alt] as you drag the
column boundaries.

Adjust Table Placement
To reposition a table in
Word, in the ‘Print

Layout’ view, rest the pointer
on the upper-left corner of
the table until the table move
handle (a four-headed arrow
inside a box) appears. Click
the handle, and use it to
drag the table to the
desired location.

Specify Spacing Between
Sentences

Word can help you
ensure that your

spacing between sentences is
consistent—one space or two.
You can do this by setting
rules for grammar and style.
To do this, on the ‘Tools’
menu, click ‘Options’, and
then click the ‘Spelling &
Grammar’ tab. Click
‘Settings’. In the ‘Grammar
and style options’ box, under
‘Require’, select the options
you want for the number of
spaces required between

sentences. To restore the
original rules of the selected
grammar and writing style,
click ‘Reset All’.

Position Clip Art Using
Text Boxes

A text box is a moveable,
resizable container for

text or graphics. In Word, you
can use a text box when you
want more precise control
over the position of clip art.
On the ‘Drawing’ toolbar,
click ‘Text Box’. Click the
border of the box that
contains the words ‘Create
your drawing here’, then click
the text box that appears, and
drag it where you would like
to position the graphic. To
add clip art to the text box,
place your cursor within it,
click ‘Insert’, point to
‘Picture’, and click ‘Clip Art’.
In the ‘Insert Clip Art’ task

pane, use the search interface
to select your clip art.

Note that you can use the
options on the ‘Drawing’
toolbar to enhance a text
box—for example, to change
the fill colour, just as with
any other drawing object.
Also, when using a text box to
display a graphic, be sure to
change the line colour on the
text box to ‘No line’. You can
do this by right-clicking the
border of the text box and
choosing ‘Format Text Box’.

Easy Access To
Often-used Documents

The ‘Work’ menu is a
great feature that you

probably do not know about.
You can use the ‘Work’ menu
to keep an easily accessible
list of your frequently-
accessed Word files. To add
the Work menu to the menu

bar or a toolbar, on the ‘Tools’
menu, click ‘Customize’, and
then click the ‘Commands’
tab. In the ‘Categories’ box,
click ‘Built-in Menus’. Click
‘Work’ in the ‘Commands’
box, and drag it to the menu
bar or displayed toolbar. Now,
with the Work menu in place,
you can add any open Word
document to your list. The
options you have are:

To add the current
document to the Work menu,
click ‘Add to Work Menu’ on
the Work menu.

To open a document on
the Work menu, click the
document you want to open
on the Work menu.

To remove a document
from the Work menu, press
[Ctrl] + [Alt] + [-]. The cursor
will look like a large, bold
underscore. Now on the Work
menu, click the document
you want to remove.

Add Watermarks To Your
Documents

Watermarks are text or
pictures that appear

behind the text. They can
identify the document’s
status, marking a document
as a draft, for example. You
can use graphics or text as
watermarks. To add a
watermark to a printed
document, go to Format >
Background, and click
‘Printed Watermark’. Then do
either of the following:

To insert a picture as a
watermark, click ‘Picture
watermark’, and then click
‘Select Picture’. Select the
picture you want, and then
click ‘Insert’.

To insert a text watermark,
click ‘Text watermark’, and
then select or enter the text
you want.

Now select any additional
options you want, and then
click ‘Apply’. To view the
watermark as it will appear
on the printed page, click go
to View > Print Layout.

Modify The Custom
Dictionary

To add, delete, or edit
words in a custom

dictionary, go to Tools >
Options, and click the
‘Spelling & Grammar’ tab.
Click Custom Dictionaries.
Choose the checkbox next to

MS WORD
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You can place tables side by side in Word!
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the dictionary you want to
edit. Click ‘Modify’. Then, do
one of the following:

To add a word, type it
in the ‘Word’ box and
click ‘Add’.

To delete a word, select it
in the ‘Dictionary’ box and
click ‘Delete’.

To edit a word, select it in
the ‘Dictionary’ box, modify
it, and then click ‘Add’.
Delete the previous version.

Mail Merge
In Word, Mail Merge is
used to create form

letters, mailing labels, or
envelopes. One document is
the ‘Data Document’, which
contains all the names,
addresses, and other variable
information. This data is
merged with the ‘Main
Document’, resulting in a
third document, which
has as many sections as
there are records in the
‘Data Document’.

Word XP uses a new
feature called the ‘Mail Merge
Wizard’ to guide you through
the merge process. If you
want to try the ‘Mail Merge
Wizard’ in Word XP, choose it
from the ‘Letters and
Mailings’ menu. The
directions appear in the task
pane on the right side of 
the screen.

If you don’t like the Word
XP Mail Merge Wizard, you
can install the Word 2000
‘Mail Merge Helper’. You’ll
have to make two
modifications to your
installation of Word XP:
adding the ‘Mail Merge
Helper’ to the Word XP tools
menu, and adding the ‘Insert
Merge Field’ button to the
Word XP Mail Merge toolbar.

Add The Mail Merge
Helper To The Word XP
Tools Menu

To do this, go to Tools >
Customize. In the

Customize window, select the
Commands tab. Select ‘All
Commands’ from the
‘Categories’ list on the left.
Then select ‘Mail Merge
Helper’ on the right. Drag
‘Mail Merge Helper’ to the
‘Tools’ menu (the Tools menu
will open). Continue holding
the mouse button and drag
‘Mail Merge Helper’ to the

‘Letters and Mailings’ menu
item (the Letters and Mailings
menu will open). Continue
holding the mouse and drag
‘Mail Merge Helper’ to the
first position in the list of
items. Release the mouse
button; ‘Mail Merge’ will
appear on the menu. Finally,
click ‘Close’.

To add the ‘Insert Merge
Field Button’ to the Word XP
Mail Merge toolbar, go to
View > Toolbars, then select
‘Mail Merge’ to display the
‘Mail Merge’ toolbar. Then
go to Tools > Customize. In
the ‘Customize’ window,
select the ‘Commands’ tab.
Select ‘Mail Merge’ from the
‘Categories’ list on the left.
Select ‘Insert Mail Merge
Field’ on the right. Then
drag ‘Insert Mail Merge
Field’ to the ‘Mail Merge’
toolbar, and position it to
the left of the ‘Insert Word
Field’ button. Release the
mouse button—the ‘Insert
Merge Field’ button will
appear on the toolbar.

At this point, if you
don’t need the ‘Mail Merge’
toolbar now, go to View >
Toolbars, then select ‘Mail
Merge’ to hide the ‘Mail
Merge’ toolbar.

Create A Set Of Merge
Documents

To create a set of merge
documents, choose go to

Tools > Mail Merge. (Word XP
users should choose ‘Letters
and Mailings’ from the Tools
menu first). This will start the
‘Mail Merge Helper’, which
will guide you through the
three-step process:

Create the Main Document
(Form Letter, Mailing Label,
or Envelope).

Specify a Data Source
(create from scratch or use an
existing document, which is
usually a Word table or an
Excel spreadsheet).

Merge the ‘Data Source’
with the ‘Main Document’.

Save Word Documents As
Web Pages

Word has a ‘Save as Web
Page’ command on the

File menu. In addition, there is
an ‘Insert Hyperlink’ button on
the toolbar, as well as two
additional toolbars for the web:
‘Web’ and ‘Web Tools’. To

activate these toolbars, go to
View > Toolbars. If you save a
Word document as a Web page,
Word includes XML (Extensible
Markup Language) tags, which
enhances the format of the
web page, but may cause
problems with some Web
browsers. Pages created with
Word work best when viewed
with the current version of
Microsoft Internet Explorer.

You can download an
HTML filter for Word 2000
that will allow you to Export
as Compact HTML—compact
HTML removes most of the
XML tags. When you save a
Word document as a Web
page, the formatting is
converted into the
appropriate HTML code,
although some formatting
will not be displayed on the
Web page exactly as it
appeared in Word. To
download the HTML filter
for Office 2000—“Office 2000
HTML Filter 2.0”—go to
http://snipurl.com/6mx2.

Sharing A Word Document
In Other Versions

If you want to share a
Word document with

someone who doesn’t have
your version of Word, go to
File > Save As, and in the
‘Save as type’ box, select the
file type you want to use.

If you’re not sure what
file type will work—such as
when you are sending a
document to someone else—
choose ‘Rich Text Format’
(*.rtf) or WordPerfect 5.1 for
DOS (*.doc). All recent word
processing programs for
Windows or Macintosh can
read either of these formats. 

However, the conversion
is sometimes not perfect and
any formatting Word cannot
convert will be discarded.

Put An Excel Chart In A
Word Document

The easiest way to insert
an Excel chart into a

Word document is to open
the chart in Excel, copy it,
then paste it into your Word
document. You may have to
resize the chart after you get
it into Word.

To resize the chart, go to
Format > Object. The ‘Format
Object’ dialog box has a ‘Size’
tab, and the ‘Layout’ tab has

options for setting the flow of
text around the chart.

You can also insert the
chart as a linked or
embedded object. A linked
chart stores the data in the
original Excel worksheet. If
you edit the spreadsheet, the
changes are reflected in the
linked chart in Word.

An embedded chart is
stored in the Word document.
To create a linked or
embedded chart, go to Insert
> Object. Click the ‘Create
from File’ tab. Enter the
filename, or use the ‘Browse’
button to locate the file. An
embedded object is created if
you don’t check the ‘Link to
file’ checkbox.

When you create an
embedded object from an
existing Excel workbook, the
entire workbook is inserted
into your document. The
document displays only one
worksheet at a time.

To display a different
worksheet, double-click the
Excel object, and then click a
different worksheet.

Sheet And Workbook
Names And Paths

The ‘Cell’ function
returns information

about the formatting,
location, or contents of the
upper-left cell in a reference.
So, to get the name of the
current sheet, you can use
this formula:
=MID(CELL(“filename”),FIND(“
]”,CELL(“filename”))+1,255)

To get the workbook name:
=MID(CELL(“filename”),FIND(“
[“,CELL(“filename”))+1,(FIND(“]
”,CELL(“filename”))+1)-
FIND(“[“,CELL(“filename”))-2)

MS EXCEL

Count The Number Of
Words In A Cell
To count the number of words
in a cell in Excel, enter some
text into a cell, say A1. Then use
the following formula in cell A2:
=IF(LEN(A1)=0,0,LEN(TRIM(A1
))-EN(SUBSTITUTE(TRIM(A1),”
“,””))+1)

This should give you the
correct result in cell A2.

Bet You Didn’t Know
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Jayesh Limaye

After going through the
TV tuner card roundup

in this issue of Digit,
chances are, you want to
get yourself a TV tuner
right away! Remember,
though, that the TV
viewing applications that
TV tuners come bundled
with provide only a few,
basic features. 

Winamp in contrast, is
a free multimedia viewing
application for which a
host of free plug-ins are
available. One such is
Winamp TV, developed by
Branimir Lambov. You can
access the Winamp TV at
http://snipurl.com/dzi7,
moreover, it’s only a
250 KB download. 

The plug-in enables
Winamp to be used in
conjunction with your TV
tuner card, as a TV
viewing application, and
an FM radio if your card
has a tuning unit.

Winamp TV uses
Microsoft’s WDM
streaming technology to
play video and sound, and
so requires WDM drivers—
these come bundled with
most newer TV tuner
cards. Also, the next
version of this plug-in will
have the capture facility,
which will allow you to
capture audio and video to
your hard disk.

Installation And
Configuration
You must

download the installer
and run it—it will install
the plug-in to Winamp’s
plug-in directory. 

Start Winamp and go
to the preferences menu
([Control] + [P]). Click on
‘Input’ under ‘Plug-ins’.
Next, select the Winamp
TV plug-in, and then
click ‘Configure’. 

You can specify the
stream size in the ‘Video
Size’ box, and if your
display card supports it,
you can opt to use Video
Mixing Renderer 9 (VMR9)
for better image quality.

If you select ‘Winamp
Video’ under ‘Output
Window’, Winamp’s
default video output
window will be used to
play the TV video.

Scanning For Radio
And TV Channels
Click the ‘Scan’ tab

and you can scan for TV
channels as well as for FM

radio channels.
First-timers will
find it easier to
leave the settings
alone and just
click the ‘Quick
Scan’ button.

Winamp TV
will begin
scanning for all
available TV
channels, and
when the scan is
complete, save the
channels to a
playlist by clicking
‘Set as Playlist’. 

If you find
that you’re
missing some
channels, you can
try the ‘Full Scan’
option, however,
this takes a lot
more time than
Quick Scan.

You can also
scan for FM radio
channels by
clicking ‘Scan
Radio’. Again, save
the scanned channels by
clicking ‘Set
as Playlist’.

Final Settings
Click the ‘Audio’
tab, and select the

appropriate mixer line,
which lets you control the
channel volume from

within Winamp. This is
usually Line-in, but you may
experiment with different
settings if it doesn’t work.

Check the ‘Capture
Audio’ checkbox in the
‘Audio Capture’ tab to
enable the Winamp DSP
plug-ins to process the TV
audio. However, this feature
is in the beta stage, and may
cause Winamp’s volume
control to stop working.

Click ‘OK’ to close the
plug-in configuration
window, and then close the
Winamp preferences
window. You can now
double-click a channel in
the playlist to view it. 

Click the volume icon in
the system tray to adjust the
volume. You can fine-tune
channels by clicking the
channel name in the playlist
and pressing [Alt] + [3].

jayesh_limaye@ thinkdigit.com

Watch TV Using Winamp 
Use Winamp TV, a free plug-in, to catch your television and FM shows on Winamp

Select the Winamp TV plug-in in
Winamp preferences

The Winamp TV configuration
channel scanning window

The scan results show up in this
window. Save them as a playlist

Use this page for fine-tuning and
also for other adjustments

Double-click a channel in your playlist to
watch it—just as though it were a track!



44 DIGIT MAY 2005

Digital Tools l Tips & Tricks

To get the path address
and workbook name:
=CELL(“filename”)

To get the path address:
=MID(CELL(“filename”),1,FIND
(“[“,CELL(“filename”))-1)

Use A Combo Box In Excel 
Say you want to select a
month from a drop-

down list, and have the
month number (as in “3” for
“March”) appear in a cell.
Here’s how to go about it.

First, add a list of
months. Select the list. Press
[Ctrl]+[F3] and define the
Name, say, ‘MonthsList’.
Select cell B2-this is the cell
where the month number
will be displayed. Press
[Ctrl]+[F3], and define the
Name as ‘MonthNumber’.

Now, place the mouse
arrow over any toolbar, right
click, and select ‘Forms’ from
the shortcut menu. Click the
‘Combo Box’ icon. The cursor
changes into a cross. Select a
cell in the sheet, and draw
the shape that you want for
the combo box. A combo box
will appear.

Select the combo box
you just created, and make
sure you are in edit mode.
Right-click, and select
‘Format Control’ from the
shortcut menu. Select the
‘Control’ tab.

In the ‘Input Range’
box, type in ‘MonthsList’.
In the ‘Cell Link’ box, type
‘Month Number’. Select the
3D shading checkbox, and
click OK.

You should now be able to
select a month from the
combo box and see the month
number appear in cell B2.

Create A Hyperlink
You can create a
hyperlink in a cell to any

document you want. First,
select a cell. Press [Ctrl]+[K], or
select the ‘Insert Hyperlink’
icon from the toolbar. In the
‘Insert Hyperlink’ dialog box,
just fill in the necessary
fields, such as the text to
display and the address.

Apply Formatting Only To
Certain Cells

In Excel, you can apply
formatting to cells that

contain only certain types of
data, even if you select an
entire range. For example, to
apply a certain style only to
cells that contain text, first
select a range of cells.

From the ‘Format’ menu,
select ‘Conditional
Formatting’. In ‘Condition 1’,
select ‘Formula Is’ from the
dropdown list. Now, in the
Formula Box, enter the
formula ‘=ISTEXT(A1)’.

Click ‘Format’. Select the
desired format from the
‘Format Cells’ dialog box, and
click ‘OK’. Again, click ‘OK’ to
close the ‘Conditional
Formatting’ dialog box.

Use AutoCorrect To Enter
Special Symbols

You can use AutoCorrect
to enter special symbols,

for example, foreign

characters. Here, we’ll use the
example of the euro sign (�).

In a cell, enter the
formula ‘=CHAR(128)’, press
[F2], and then [F9]. This will
paste the euro sign as a value.
Copy the euro sign from the
formula bar using [Ctrl] + [C].
Now from the ‘Tools’ menu,
select ‘AutoCorrect’. In the
‘Replace’ box, type in “euro”,
and in the ‘With’ box, press
[Ctrl] + [V]. Click Add, and
click OK.

Now, you can the type in
the word “euro” in any cell. It
will change to “�”.

Add Hidden Text To
Formulas

Say you have a formula
like ‘=12018+1056-

4*1120’. When you wrote it,
you knew what each number
represented, but when you
look at the sheet again, you
find you can’t remember
what the numbers are for. In
such cases, you can add a
hidden note to your formula
by using the ‘N()’ formula.
Change the above to read:

=12018+1056-
4*1120+N(“My wage + bonus -
four weekly loan
repayments”).

The ‘N()’ function converts
text to zero.

Formula Syntax
When writing formulas
in Excel, you sometimes

need a quick reminder of the
formula syntax. Type an
equals sign followed by the
function name, and push
[Ctrl] + [Shift] + [A]. For
example, typing ‘=Vlookup’
and then pressing [Ctrl] +
[Shift] + [A] will give you:
=vlookup(lookup_value,table
_array,col_index_num,range
_lookup).

Non-bold font arguments
are optional. 

Inverting A List
There is a simple and
elegant way to invert a

list in Excel. First copy the list
to another location using
Copy > Edit > Paste Special >
Value. Now select all data in
the list, and go to Tools >
Options > Custom Lists.

Ensure the list address is
in ‘Import list from cells:’,
and then click ‘Import’. Now
go back to the column next

to your list, and in the top
cell, place the last entry
from your list.

In the cell below, place
the second-last entry. Select
both cells and double-click on
the ‘Fill Handle’ (the small
black square at the
bottom right).

Hiding And Unhiding
Columns

To hide a column, select
a cell or cells and press

[Ctrl] + [0]. To unhide a
column, select the cells to the
left and right of the hidden
column, and press [Ctrl] +
[Shift] + [0].

Changing Cell Indentation
Say your data is in cells
A2 through A6. Select

the range A2:A6 and press
[Ctrl] + [1]. Select the
‘Alignment’ tab, and in the
‘Indent’ box, change the
number of characters to
indent. Click OK.

Copying Cell Content
Across Sheets

To fill across sheets or
to copy information

from the selected cells to all
sheets in the workbook
simultaneously, first copy
the range of cells. Right-
click the sheet tab, and from
the shortcut menu, select
‘Select All Sheets’. From the
‘Edit’ menu, select ‘Fill’ and
then ‘Across Worksheets’. In
the ‘Fill Across Worksheets’
dialog box, check one of the
three option buttons and
click ‘OK’.

Multiple Slide Masters
A new feature in
PowerPoint 2002 is that

you can use multiple slide
masters in a single
presentation.

The slide master is an
element of the design
template that stores
information including styles,
placeholders, and colour
schemes. Using the slide
master, you can make global
changes—such as replacing a
font style—across all the
slides in your presentation. 

When using multiple
slide masters, remember that

MS POWERPOINT

You can actually create a combo box in Excel!
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if you want to make a global
change to your presentation,
you need to change each slide
master. To insert a slide
master, go to View > Master,
and click ‘Slide Master’. Then
do one of the following:

To insert a slide master
that uses the default styles in
PowerPoint, on the ‘Slide
Master View’ toolbar, click
‘Insert New Slide Master’.

To insert a slide master by
adding a new design template,
on the ‘Formatting’ toolbar,
click ‘Design’, point to the
design you want, click the
arrow, and select one of the
options on the shortcut menu.

To replace or add slide
masters, go to View > Master,
and click ‘Slide Master’. On
the toolbar, click ‘Design’. If
you want to replace selected,
rather than all, masters in the
presentation, select the
masters in the thumbnails on
the left. Then in the ‘Slide
Design’ task pane, point to
the design template you want,
click the arrow, and perform
one of the following tips:

To replace selected masters
with masters for the new
design template, click
‘Replace Selected Designs’.

To replace all the current
masters with masters for the
new design template, click
‘Replace All Designs’.

To add a new design
template and its masters to
the presentation, click
‘Add Design’.

Toggling Case
If you have text that is
in the wrong case, select

the text, and then press
[Shift] + [F3] until it changes
to the case style that you like. 

[Shift] + [F3] toggles the
text case between the all
caps, lowercase, and initial
capital styles.

Using Guides
Make the guides visible
by clicking View >

Guides. Then, hold down
[Shift] while you click-and-
hold a guide; the tool-tip for
the guide will display 0:00. As
you move the guide, the
distance the guide covers
from the beginning of the
drag will be displayed in the
units of your ruler. This way,
you can measure distances

between objects, place guides
at specific places, and so on.

Preview Fonts
If you would like to see
previews of fonts in the

font selection of the
formatting toolbar, go to
Tools > Customize, click on
the ‘Options’ tab, and click
‘List font names in their font’.
Click ‘Close’.

Resizing Proportionately
You can resize images
while retaining

proportions. Select the
objects one at a time, keeping
the [Shift] key pressed. Drag
one object to the desired size,
and PowerPoint will
automatically scale them all.

Import Outlines
From Word

Instead of creating
presentation outlines in

PowerPoint, they can be
imported from Word.

First, open the file in
Word, and click on File >
Send To. Select ‘Microsoft
PowerPoint’ to export the
outline to PowerPoint. It will
help to have the outline
properly formatted with
Word’s heading styles.

Create Semi-transparent
Objects

To create a semi-
transparent object, select

the object you want and then
‘ungroup’ it by clicking Draw
> Ungroup from the ‘Draw’
toolbar. Once the object is
ungrouped, regroup it by
selecting the ‘Group’ option,
again from the ‘Draw’ menu.
This will convert the picture
to a Microsoft Office Drawing
Object. Click Format > Object.
Under the ‘Colours and Lines’
tab, check the
‘Semitransparent’ box.
Click ‘OK’.

Use Curved Text
WordArt allows text to
be styled and twisted in

various ways. For using
curved text in PowerPoint,
click Insert > Picture >
WordArt, choose the style
you want to apply to the text,
and click OK. A dialog box
will prompt you for the text
to be placed in the given
format. After the WordArt

object has been generated,
select it and click on the
‘Shape’ button on the
‘WordArt’ toolbar. Here, you
can choose the style in which
you want the text to be bent.

Change Fonts On
All Slides

If you need to change the
font on all your slides,

open your presentation and go
to View > Outline.

PowerPoint now shows
you a slide-by-slide view of all
the text in your presentation.
So if you want to change all
the text in your presentation
to a different font, in Outline
view, select ‘Select All’ from
the ‘Edit’ menu. Now click
Format > Font. Choose the
font you want and click ‘OK’. 

All the text in your
PowerPoint presentation
will now be displayed in the
new font.

Try Before You Buy
It’s always a good idea
to try your hands on the

model before you finalise a
purchase. Find out if any of
your friends has the same
piece, so you can try out the
interface and the feel of the
phone to make sure you are

Mobile Buying Tips

Using More Than One
Guide
If you like using guides, and
wish there were more, you
can create additional guides
by simply holding down [Ctrl]
while dragging on an existing
guide. This will create a new
guide. To get rid of guides,
just drag them off the edge of
the slide.

Bet You Didn’t Know

...conveniently import presentation outlines

Use the Send To option in Microsoft Word to...
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Varun Dubey

If you have AVI movies that you
are tired of watching on your
PC’s small screen, and, in

addition, you don’t want to write
them to a CD because of the loss in
quality, here’s how to convert your
AVI files to DVD.

The most incredible thing about
this is that the required software is
absolutely free, and performs better
than most of the paid versions
we’ve seen!

You Will Need
A DVD-Writer for burning the

DVD. As of now, DVD-Writers retail
for roughly Rs 4,500.

The software, Avi2DVD, which can
be found at http://snipurl.com/e0ze

The Input
Post installation, firing up
the software brings up a

single window interface, which is
akin to Nero’s info tool. This is the
command centre for all the
encoding. There is an option to
select from two input modes—
AVI or DVD.

Since you would like to convert
existing AVI files to DVD, you will
need to choose the AVI mode.
Interestingly, in the AVI mode, the
software takes not only .AVI files,
but also .OGM (Ogg Media files) and
.MKV (Matroska Video files).

The Output
Here, you can select the
output format for your

movie file. You can choose 
between DVD, SVCD and VCD. 

Then, using the drop-down menu,
you can select the disk size that you
are using. This ranges from 740 MB
for a CD-ROM to 8.5 GB for a dual-
layered (DL) DVD. 

Remember, to burn a DL DVD,
you need to have a DVD-Writer that
supports DL writing, as well as
compatible media. 

You can also specify the screen
aspect ratio—16:9 for wide-screen
TVs, or 4:3 for regular TVs. The
software even allows you to specify
the video format—NTSC or PAL (PAL
is the standard used in India).

A thoughtful addition is the
ability to specify the number of
disks you want to spread your movie
across—the software splits the
output file accordingly!

Encoding     
Once you have selected the
output mode, you can select

the codec you would like to encode
your movie with. 

Incidentally,
the software offers
four encoders by
default. These are
QuEnc, NuEnc,
FreeEnc and
HCEnc. All these
are freely
available, so you
need not worry
about payment or
copyrights. They
get installed with 
the software.

In our tests,
we found that
that the encoders
provided do 
a pretty good job.

There are also
various options

such as VBR (Variable Bit Rate,
which reduces file size without
noticeable loss in quality), an option
to set the output to High Quality
with one click, and an option to set
the number of passes for your movie
encoding. The more the number of
passes, the better the output will be.

If you are making a DVD, the
software even allows you to add 

subtitles to the movie. Moreover,
you can select font type, size, 
colour margins, and even 
the language!

Using the software does not lead
to any audio quality loss, and retains
the number of channels your
original file had.

Burn It!
Once you have encoded your
file, navigate to the directory

where you saved the original file.
You will find a folder called
Avi2DVD_temp (or whatever folder
name you specified). 

Inside this, you will find the
.CUE files. Burn these using your
favourite writing software, and your
DVD is ready!

varun_dubey@thinkdigit.com

Make DVDs Of Your AVIs
If you have a DVD drive and a DVD player, it’s easy to convert your AVI files to
DVD—and then watch them on your TV set

The options available at startup

Here, choose the
options you want
for the actual
encoding of the 
AVI file

When you’re sure you’ve made all the correct
choices, just burn your ready-to-view DVD!

You get advanced options just prior to
burning your DVD
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comfortable with it. Apart
from the interface, check out
the size and weight to make
sure it fits in with your
requirements. If someone you
know already owns the
phone, he or she will also be
able to tell you about the
battery life and its other pros
and cons. Some dealers also
let you try out a demo piece.

Stick To Your Budget
The market is flooded
with all sorts of

phones. You may be lured to
buy a more expensive phone
than you can afford, but
resist the temptation!
Remember that you will be
paying for all the features
that the device offers, but it
may be a waste if you will
not use some of them.

Check The Talk-time
You should always check
the talk-time of the

phone before buying. Most
mobile manufacturers specify
this on the packaging box.
However, it will be better if
you can confirm this from a
trusted source, such as a Digit
review, or from someone
you know who owns the
same model.

Power Woes
There are usually two
types of batteries

available in the Indian
market: Lithium Polymer
and Lithium-ion. While
buying a new phone, it’s
advisable to buy one with a
Lithium Polymer battery, as
these are slimmer and have a
larger power capacity. A
third type of battery, Nickel
Metal Hydride, was used in
older models, but has been
mostly discontinued as these
are heavier and have less
power capacity.

Size, Shape And Weight
It’s advisable to opt for a
medium-sized phone

that easily fits in your pocket.
It’s easier to hold and use
such phones than newer, tiny
models, even if the latter look
more appealing—especially if
you have large hands.

Also check out the
weight, as the weight
mentioned by the
manufacturer could be

without the battery. Some
users may prefer to opt for
flip models over the standard
candy-bar phones.

Scheduling your work
Most phones give you
the functionality of a

calendar and task options,
which allow you to create
daily schedules. However,
the calendar could prove
inconvenient if you are
not provided with a
monthly view.

Internal Memory
Some basic phones do
not give you any

internal phonebook memory.
High-end phones provide
fixed allocated memory
ranging from 300 to 500
contacts, and also give you
the flexibility of adding

multiple entries for each
contact—such as different
phone numbers for home,
work, mobile etc. 

Hence, before buying a
phone, take a look at the
amount of internal phone
memory that it ships with.

Internal memory is all the
more important for phones
that have features such as an
integrated camera, MP3
playback, voice recording etc,
as you will require more
memory for storage.

External Memory Support
Many mid-range and
high-end phones give

you the flexibility of adding
external memory modules,
which allow you to add more

data. If you’re buying a high-
end phone, it’s advisable to
buy one that supports
external memory so that you
can add more when you need.
Again, this is important for
phones with features that
require extra storage.

Colour Display
If your budget permits,
buy a phone that

provides a colour display—the
prices of these phones have
come down drastically. The
choices range from phones
that can display 4K colours,
65K colours, and now even
260K colours. Generally
speaking, phones with screens
that can display more colours
will be more expensive.
Tri-band Or Dual-band

Check if the phone
supports dual-band, and

preferably tri-band, which
ensures that you can use the
phone globally.

Infrared Port
Most new phones give
you lots of connectivity

options. Phones with
infrared allow for a wireless
connection between a
computer and the phone.
You can use infrared to send
and receive phone book
entries (business cards),
reminder notes, images and
much more.

Bluetooth
Bluetooth provides a
very user-friendly

way of transmitting data
at high speeds over short

distances. If your phone
supports Bluetooth, you can
also use a Bluetooth headset
in most cases.

The advantage of
Bluetooth over infrared is that
apart from being faster and
having more range, Bluetooth
does not require line-of-sight,
as is the case with IR.

Multimedia Messaging
Service (MMS)

Most high-end phones
have this feature, which

allows you to send and
receive rich media messages
(comprising text, sounds,
images and video).

However, most phones
have a size restriction per
message, and they may not
allow you to forward audio.
Before buying an MMS—
enabled phone, make
sure you take into
consideration the file size
restrictions and its capability
to send audio.

Concatenated Messages
And Character Support

The GSM standard
restricts you to messages

containing 160 characters, so a
phone that supports
concatenated messages enables
you to send longer messages.
Phones that have support for
Unicode will allow you to
display blinking messages.

Bundled Accessories
Most expensive phones
bundle quite a few

accessories in the form of a
communications cable, a
desktop charger, a leather
case, etc. Check for these.

Voice Dial
This is a system that
allows you to dial a

telephone number by just
saying the person’s name.
Voice dial is convenient, and 
useful in places where you
cannot see the keypad or
when your hands aren’t free. 

OS And Application
Support

Most high-end phones
allow you to install

additional games and
applications depending upon
the OS and available memory.
Options available include
Symbian and Series 60. 

A Bluetooth handsfree headset
has more range than an 
infrared one

Fuel cell-powered mobile cartridges are
good when you’re travelling
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A variety of third-party games
and applications are available
for purchase or even free
download. If you are a power
user who would like to use
specific games or applications
on your mobile, you will need
to check whether they are
supported on you new phone.

Data Input Mode
If you are buying a high-
end smartphone, you

also need to consider the
mode of data input. Some
phones use a touch-screen
and stylus to enter data,
while some may offer a full-
fledged keyboard. Some
phones come with both
options. If you are going to
enter a lot of data, make sure
you are comfortable with the
options available.

Support And Service
What happens when your
phone breaks down—does

the warranty cover all the
critical parts such as the circuit
board, screen, software
installation and firmware?
Check before you buy.

Protect The Screen
Even if you do not get a
cover, you may be able to

find a screen protector for
your phone display. Since the
display is one of the most
expensive and fragile parts of
your phone, it is important to
protect it from scratches and
other types of damage. 

A screen protector is a
transparent film that sticks on
to the top of the screen.

Change That Look
Most Nokia phones, and
even some other brands,

allow you to customise the
look of your phone by
changing the external body
casing, keypads, etc. You can
choose from lots of stickers
and cool flickering LEDs,
which you can stick on your
phone’s back panel or the
antenna. Watch them blink
and jazz up your phone!

Carry It Safe
Various types of carry
pouches, belt clips and

cases are available for
different phones. Ranging
from leather to cloth, you
should be able to find one

that suits your requirements
and style.

Memory
If your phone supports
memory expansion, you

can go in for a compatible
memory card to expand the
available memory. This is
useful for phones that do not
have a lot of internal memory
but offer features like an
integrated camera, video
recording, MP3 playback, etc.
There are a variety of memory
cards supported by different
brands and product models.

Ranging from Memory
Stick Duo to MultiMediaCard
(MMC), and available in
varying capacities, you need
to check, before you buy, the

memory format and the
highest capacity supported by
your phone.

Free Your Hands
Handsfree adapters will
free you from having to

hold your phone all the while
you speak. Depending on your
budget and what your phone
supports, you could go in for
plain ones that start from Rs
100 for locally made ones and
Rs 400 for the genuine thing.

If your phone has
Bluetooth, go in for high-end
Bluetooth wire-free headsets
starting from Rs 2,800 (grey
market). Original top-of-the-
line handsfree sets from
Nokia will set you back 
by Rs 6,000.

Looks apart, the reason
you should look at Bluetooth
handsfree is that it’s wireless,
and has a range of
approximately 30 feet, so you
can move around without
being attached to your phone.

Another kind of
handsfree that is gaining in
popularity is radio handsfree.
If your phone doesn’t have a
built in radio, then you can
buy such a handsfree with
integrated radio.

Phone Care Tips
Never keep your

phone near heat and
magnetic sources (gas stoves,
direct sunlight, audio
speakers, etc).

Switch off the device if it’s
not going to be used for some
period of time. If you don’t
tend to use your phone for a
long while, remove the
battery and store it in a cool,
dry place.

Keep the device away from
moisture and liquids. Avoid
taking the phone into areas
like kitchens
or washrooms.

Avoid storing or using it in
dusty areas: the moving parts
could get damaged.

While charging the
device, do not pull the
adapter cord out of the
device until the electricity
supply is switched off.

Switch off the phone
before removing the battery
or changing your SIM card. 

Use only approved
accessories and batteries. Do
not connect incompatible

products. Always use rated
and factory-specified
accessories for your phone. If,
for example, you use a higher
power rating charger, it will
charge faster, but battery 
life could be lowered, and 
the phone could even 
get damaged.

Never forget your cell
phone in your vehicle—the
heat could shorten the life of
electronic devices, damage
batteries and melt some
plastic components. 

Similarly, do not store your
phone in cold areas because
when the phone warms up to
its normal temperature,
moisture can form inside it,
which could damage the
electronic circuit boards.

Never attempt to open the
phone yourself, as non-expert
handling of the device may
damage it.

If you wish to clean your
phone, do not use harsh
chemicals, cleaning solvents,
or strong detergents. Use just
a soft moist cloth.

A new battery usually lasts
for two years, provided you use
it the right way. Never
recharge a battery
unnecessarily—this reduces
the charge cycle. Always make
sure you use the specified
charger, else battery
performance could be affected.

Where temperature and
humidity levels are high,
your phone may stop
functioning in extreme cases.
If this happens, do not open
the phone—take it to an
authorised service centre.

Safety Tips
Never use your phone

while driving. It may not be
a punishable offence in
many places, but you could
cause an accident. As an
alternative, you could use
one of the many handsfree
accessories available today,
but be warned that using
these while driving could
also be dangerous. 

Avoid taking a call while
crossing the road, as your
attention could be diverted—
stand on the side if you must
take a call.

Always buy a cell phone
that’s SAR-approved. This
ensures that the radiation
emitted is minimal.

Mobile Accessories

Handsfree adapters make it safer to
use your phone when you’re driving

Look for zinc-air batteries, which  can
power your phone for really long
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Aditya Kuber

Cell phones are an integral part
of our lives today, and new ones
hit the market almost everyday.

Given the wide range of these new
models available, you could go crazy
looking at every manufacturer’s indi-
vidual Web site for new models. 

Where do you go for the low
down on the latest? GSMArena.com
is perhaps one of the most compre-
hensive sites, though it caters more
to the GSM-based models than
CDMA. For an Indian enthusiast, that
shouldn’t be a problem!

What’s New?
One of the most-asked questions
regarding cell phones is, “Which is
the latest model?” More often than
not, GSMArena will be the site to
break the news on the newest or
upcoming model from a manufac-
turer. Navigation in this regard has
been eased with a list of manufac-
turers on the left instead of the usual
menu you would find on such a site.
The focus is clear. 

News is in abundance and makes
you wonder who’s really buying all
these phones that are launched daily.
The GSMArena team also visits vari-
ous trade shows, and highlights new
developments in the cell phone arena
in detail—often missed by the more
general sites. News is often given in
detail, and also with links, in case they
have not covered the event them-
selves. It is, nonetheless, reliable.

GSMArena also lists phones by
manufacturers, which we in India
haven’t even heard of. In fact, it

opens up a world of new phones, and
tells us that there are choices beyond
the obvious ones we make.

Features
News, Ringtones, Forums, Reviews,
Logos… the works! GSMArena also
has an active forum. 

There are discussions on which
phone is the best, to discussions on
individual brands and their loyalists
do all they can to defend! “Flame or
get flamed” is the objective, if you
may, for the general discussion. You
be the judge on what the more
specific discussions might be like!

While the site is based in the
UK, there are users from all over
the world accessing it, and you can
even find a fair number of Indian
users registered with the site. The
only problem is that you may not be
able to buy all the products being
sold by advertisers or visitors to the
site. One point to note, though, is
that the site is selling nothing. But
some of the links you would find
here are truly awesome.

Another interesting tool that has
recently been added is the Phone
Finder that lets you search a specific
model without having to sift through
endless pages of cell phone models.

Search criteria include model
name, brand, network, availability (if
it’s upcoming or discontinued), oper-
ating system (Symbian or older),
weight, form factor (such as flip top,
candy bar), antenna, display, camera,

GSMArena.com

WAP, and so on. The advantages of
the exhaustive form you have to fill
up are that if you have an old phone,
you could find it and check for details
you didn’t know.

The reviews are exhaustive and
rate almost all features in addition to
offering a comparison to other similar
models. Not all reviews, though, are
created inhouse. Some of them are
sourced from associates located in
various parts of Europe. 

How Is It Different?
Yes, there are tons of other sites
that do the same thing but not with
so much pizzaz or style. GSMArena
has by far the best design (we don’t
quite like the colour, though) and is
the easiest of the lot to navigate.
Just go to phonearena.com and
you’ll know the difference. Most
importantly, though, they have big
photos of all the phones they list—

even the upcoming models—and this
makes it a treat to check out phones
here. At least, it gives you an idea
what the new model would look like
and whether you are interested 
or not!

If you use a GSM phone and
change your handset at the drop of
a hat, this is a site you must book-
mark. Before you head over to buy
the latest, it would be worth noting
that they list only sellers in the UK.
So what... tell your ‘favourite’ uncle
or aunt to get it for you! 

aditya_kuber@ thinkdigit.com

Your one-stop guide to all the dope on cell phones

GSMArena.com—your comprehensive guide to cell phones

Check features, prices and users’ opinions on cell phones

Get detailed and reliable news on the
latest cell phones launched worldwide



Lock Up That Computer! 

SecuriKey is a hardware/software PC security solution. If the data
on your system is too important to be protected by a mere

password, you may get SecuriKey to add another layer of security
to your system.

SecuriKey works like a hardware key, which, if not plugged
into the system, will restrict anyone from gaining access to
your PC (or Mac). The package comes with two
USB-based hardware keys, where one is an
original while the other is a
replacement—just in case! It also
provides an option to use the
second key to validate another user,
in case the system is shared between
two users. However, in such a case, the
second key will not function as a spare key to the first one. 

Installation is a complete breeze, but unlike other USB devices,
the installation has to start first, and then, during the course of
installation, the key has to be plugged in. 

Company J. S. Equipment 
Price Rs 9,625
Phone 022-23810713
E-mail jse@vsnl.com
Web site www.securikey.com

Rating 

50 DIGIT MAY 2005

SecuriKey Professional EditionContour Design’s Roller Mouse

Contour Design’s RollerMouse works in
conjunction with a keyboard and comes with a

‘roller bar’ that lets you to move the cursor around
and click on icons. It acts as a base
for your keyboard, and the
roller bar and buttons fall
within easy reach of
your thumbs. 

It has three buttons
and one scroll wheel; the
roller bar doubles up as a
left click. You can set the
sensitivity of the click by
increasing the tension via a
knob at the base.

To attach the RollerMouse, you need one USB
port. Drivers are not needed for PCs with Windows
ME and later versions. It costs $189 (approx Rs 8,127)
and can be bought online.

Company Contourdesign
Price Rs $189 (Approx Rs 8,127)
Phone 033-22207961   
E-mail info@contourdesign.com
Web site www.contourdesign.com

Rating

Lacks Nothing... Except Bluetooth

The ‘My S-7’ from Sagem looks just like any other
standard camera phone until you switch it on.

Running Windows Mobile 2003 Second Edition, My S-
7 is a decent blend of the usability of a cell phone
with the functionality of a smartphone. Measuring
49.5 x 20.8 x 109.8 mm and weighing 120 gm, the
Tri-band GSM/GPRS device is definitely not the
lightest, but is certainly pocketable! Encased in a
metallic grey casing, the look is business-like and
the build quality, good.

Apart from the standard 12-key numeric
pad, two soft keys and the standard ‘Call’
and ‘End’ keys, the front facia sports a
home and a back key, with a five-way
joystick. The 2.2-inch transreflective LCD
displays 65K colours with a resolution of
176 x 220. The other controls include a
volume key along with a rubber-covered
memory card slot on the left side and the
Infrared port on the top next to the headphone
connector, again covered by rubber.

Powered by an Intel PXA 262 200 MHz processor, My S-7
has 32 MB of RAM, the same amount of ROM, 15 MB of which
is available to the user. You can add more memory through
the SD/MMC card slot. It has infrared, but sadly no Bluetooth.
It can be synchronised with a PC using the bundled
ActiveSync cradle and USB cord. Installed applications
include Internet Explorer, MSN Messenger, Photo ID, Pocket
MSN, Tasks, Video Player and Windows Media Player.

As far as usability is concerned, the keypad is
simple to use, thanks to the fairly large keys

coupled with a slanting shape that offers
more depth to click. 

The joystick is also fairly large and
smooth—one of the most comfortable ones

we have used. However, we did have issues
with the joystick, and ended up clicking in

one of the four directions when we actually
wanted to click the centre. 

The menu response is speedy and the 200
MHz processor handles most applications with

ease. We installed a demo of the game Sky Force,
and it played nicely, with no jerks. Voice clarity is

good, even in areas with low network strength. The
screen is vibrant but is a problem to read in daylight. 

The VGA camera is pretty decent for daylight
stills and video, but outputs grainy results in low

light. Audio output for ringtones and MP3 playback
is also acceptable, though not very loud. The battery

lasts about three to four days with standard usage.
At close to 20K, the Sagem My S-7 offers a good

combination of features, usability and performance.
Now, if only it had Bluetooth…

Company Cenzer Industries Ltd
Price Rs 18,500
Phone 022-26858594
E-mail mktg@sagemindia.com
Web site www.sagemindia.com

Rating

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

Sagem My S-7



Photographers Rejoice! 

Transcend, famed for its high-performance
storage devices, has introduced the

Photobank 20 GB Portable Photo Storage
drive. This device is a portable, palm-sized
hard drive and a multi-card reader for
fast and easy photo/file transfer and
storage on the go. 

It integrates a 20 GB 1.8’’ hard drive
and a memory card reader compatible with
different formats including CF Type I and II,
MicroDrive, SM, SD, miniSD (with SD adapter), MMC,
RS-MMC (with MMC adapter), MS, MS Pro, MS Duo
(with MS adapter), MS PRO Duo (with MS adapter). 

It features a B&W, blue backlit LCD that indicates the
basic functions of copying, deleting, formatting and dis-
playing information. It connects to a PC, laptop or Mac via
the USB 2.0 cable provided, allowing speeds as high as 480
Mbps. The rechargeable Li-Ion battery lasts for nearly three
hours on a full charge, but takes four hours to fully charge! 

The Transcend Photobank is a blessing that allows pro-
fessional photographers to backup their memory cards.
Business people can use it as a portable hard drive to
transfer data between their home PC and laptop. When con-

nected to a computer, it shows up as a removable hard
drive with various memory card slots. It supports the

FAT12/16/32 file systems. 
On the visual appeal front, the Photobank

doesn’t really score. The buttons feel tacky, are
sometimes unresponsive, and generally not

very comfortable. It posted a drive index of
16 MB/s in the SiSoft Sandra 2005 SR1
benchmark. In the data transfer test, 1 GB
of assorted files could be copied from the

Photobank in 57 seconds, while copying the
same files to the Photobank took 119 seconds. But

at 285 gm, it is very light and can be easily carried
around in the protective leather pouch provided. 

Unlike its more costly sibling with the TFT LCD and MP3
playback, the Photobank 20 GB is a no-frills but useful device.
At Rs 18,000, it’s somewhat expensive… but if you are a pho-
tographer, you will find the price is justified.

Company Mediaman Infotech Pvt ltd
Price Rs 18,000
Phone 022-23828100
E-mail sales@mediamangroup.com
Web site www.transcendusa.com                

Rating
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Arihant Flexi Keypad

Ergonomics and the tactile feel of a keyboard
are the two most important factors that dif-

ferentiate the good from the bad. 
The Arihant Flexi keyboard appears cool—it

can twist, turn, fold, and can also be washed! It’s
flat and can give you a feeling of typing on the
table. This will make it difficult to use, initially.
The difficulty will increase when two or three
keys will be used in combination, say, [Ctrl+G]
or [Alt+F]. The absence of a slope puts more pres-
sure on the palm and fingers—especially the
index finger. 

Although its
rubber surface
offers a good grip,
it’s not soothing
for your finger-
tips. Two major
improvements are
needed—combining
the two separate spacebar buttons and
enlarging the backspace button. 

Indicator lights for ‘Num Scroll’ and ‘Caps
Lock’ are arranged at the extreme right under a
big black box that looks more like a design
anomaly. Available in black, with no hot keys,
the keyboard is great for touch typists. The
absence of audible feedback and slope are the
main hindrances for new users, but those disap-
pear once you get used to it.

Company Arihant Computers Ltd
Price Rs 900
Phone 022-23826357
E-mail video-tch@yahoo.com
Web site www.ozaki.us

Rating
1 2 3 4 5

1 2 3 4 5

1 Poor: Has serious drawbacks and needs improvement before it can be used for its target application. 2 Mediocre: Does not live up to expectations, needs improvment 
in many areas. 3 Average: Reasonably competent but nothing spectacular about the product. 4 Good: A good buy, better than most products in its category. 
5 Excellent: A brilliant combination of price, performance and features - far beyond expectations.

Calling All Gamers

Antec, one of the premier brands in PC cases and power supplies, has
launched a new case aimed at gamers christened Super LANBOY, the

successor of the older LANBOY case. The Super LANBOY sports an anodised
aluminium finish and looks classy—similar to the new Apple G5 machines. 

The front bezel has a swivel door that covers the optical drive bays.
Right below are two USB ports and jacks for sound. A blue LED-lit 120 mm
fan covered with a smoky plastic rail adds a bit of touch to the otherwise

bland front. Antec has made good use of the
unused space near the floppy drive bays by
integrating a small toolbox that holds a
foldable screwdriver, among other things.

Inside, there are four hard drives, three
optical drives and two floppy drive sized
devices. The hard disk bays are aligned facing
the side panels, making installation easy.
Also, the drives have to be mounted on a
drive rail. On the rear, is a noiseless, but
efficient 120 mm fan. 

The side panels have a cutaway acrylic
window. Antec has optional accessories such
as a sound sensitive Blue LED panel (Rs 1,450).

Further, an ultraviolet light (Rs1,550) can brighten up the surroundings.
The Super LANBOY, though, comes at a super price of Rs 5,500—just

the price of the cabinet. The power supply and accessories have to be
bought separately.

Company Cyber Space Abacus Pvt Ltd
Price Rs 5,500
Phone 044-4464468 
E-mail shunmugavel@theitdepot.com
Web site www.antecindia.com

Rating 1 2 3 4 5

Antec Super LANBOY

Please write to products@thinkdigit.com. The Digit Test Centre will be delighted to
respond to your queries.

Looking for more information on any of the products featured here?
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AMD Motherboards 
ASUS K8N-E Deluxe

Excellent performance and 
great features
Lacks PCI-Express
Contact ASUSTeK Computer Inc
Phone 022-56290785
E-mail info_india@asus.com.tw 
Price Rs 7,850

MSI K8N Neo Platinum (Gold)
Excellent performance and
good features
Lacks PCI-Express
Contact Cyberstar
Phone 0-9323809599
E-mail navin@cyberstarindia.com
Price Rs 7,250

Internal TV Tuner cards
Compro VideoMate PVR/FM

Exceptionally clear TV recep-
tion quality, low price, FM
radio, good PVR software

Contact Mediatech India
Phone 022-26361111
E-mail
sales@mediatechindia.com
Price Rs 1,995

Mercury TV Tuner Card
Good TV reception quality,
FM radio, low price
Basic PVR software
Contact Kobian India Ltd
Phone 022-23020767/0774
E-mail mumbai@kobian.com
Price Rs 1,995

Projectors
Acer PD11

High 1600 lumens bright-
ness support 
Big 330-Inch diagonal
image size capability
Picture in Picture mode
Contact Acer India Pvt Ltd 
Phone 080 25219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 62,999

Cell Phones 
Sony-Ericsson K700i 

Extensive feature set,
includes camera, MP3, FM
radio etc.
Fast processor
Contact Sony Ericsson
Phone 0124-2560808 
E-mail dhiraj.soni@
sonyericsson.com
Price Rs 17,500

CRT Monitors (19-inch)
Samsung SyncMaster 997DF

Good colour reproduction
Compact in size
Contact Samsung Electronics India
Phone 011-51511234 
E-mail marketing@

samsungindia.com
Price Rs 14,900

Samsung SyncMaster 957MB
Brightness modes for different
viewing environment
Good colour reproduction
Contact Samsung Electronics India
Phone 011-51511234 
E-mail marketing@

samsungindia.com  
Price Rs 16,500

PDA Phones
Nokia 9500 Communicator 

Full QWERTY keyboard
Slightly bulky
Contact Company: Nokia India Ltd
Phone 011-22677900
E-mail jay.bakshi@nokia.com
Price 39,359 

O2 XDA II Mini 
Small, thin and pocketable
One-handed operation not 
possible  
Contact Creative e-biz
Phone 022-23828100
E-mail creative@goldkist.net 
Price Rs 32,888

Portable Hard Drives
WD-Media Centre 250GB

Very low cost per MB 
Memory card reader slots
Contact Western Digital 

Phone 022-25851085 
E-mail ajay.kapure@wdc.com
Price Rs 15,999

Freecom FDH-2 Pro 80 GB 
Extremely compact and bun-
dled carry case
Contact J S Equipments
Phone 022-23810713
E-mail jse@vsnl.com
Price Rs 15,500

CRT Monitors (17-inch)
Acer AC715

High resolution of
1600x1200@75Hz 
Good finer details 
reproduction 
Contact Acer India Pvt.Ltd.
Phone 080-5219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 6,995

Viewsonic E71f
Aesthetically good looking  
Good geometry reproduction
Contact Roop Technology Pvt. Ltd.
Phone 022-26680022
E-mail roop@vsnl.com
Price Rs 7,500

Intel Motherboards
Gigabyte GA-8I915G Duo

Excellent Performance at an 
affordable price 
Contact Digi Giga System Ltd.
Phone 022-26526696 
E-mail sales@digigiga.co.in
Price Rs 5,500

Gigabyte GA-8I915G-MF 
Very affordable
Average performer 
Contact Digi Giga System Ltd  
Phone 022-26526696
E-mail sales@digigiga.co.in
Price Rs 5,100

The best products tested so far in different 
hardware and software categoriesThe A-List

May 2005

DIGIT MAY 2005
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LCD Monitors (17-inch)
Acer AL714sm

Light weight
Good gray scale 
reproduction
Contact Acer India Pvt. Ltd
Phone : 080- 5219520-23
E-mail Rajesh_Aiyar@acer.co.in
Price Rs Rs 14,999

CMV CT-712A
High luminancet

Good coloured text 
reproduction
Contact Cee Vision 
Technologies Pvt.Ltd
Phone : 022-26733353
E-mail chemoplastmumbai@ 
vsnl.net
Price Rs 17,000

Laptops 
ACI Emerald C2

Inbuilt Web camera
Affordable price
Contact Allied Computer 
International

Phone 022-56943260  
E-mail hirji@aci-asia.com   
Price Rs 44,999
Website www.aci-asia.com

MSI MegaBook M510C
Terrific performance, typical
feature set
High screen resolution
Average wireless LAN 
performance 
Contact Maxtone Electronics
Phone 022-23011434
E-mail maxtone@vsnl.com
Price Rs 63,000

LCD Monitors (15-inch)
Acer AL1512

Very competitively priced
Good contrast ratio
No Vertical swivel
Contact Acer India Pvt. Ltd
Phone 080- 5219520-23
E-mail Rajesh_Aiyar@acer.co.in
Price Rs Rs 9,999

CMV CT-529A
Good colour reproduction
High contrast ratio
Contact Cee Vision 
Technologies Pvt.Ltd
Phone 022-26733353 
E-mail chemoplastmumbai@ 
vsnl.net
Price Rs 12,000

Home Inkjet Printers
Pixma iP1000

Economical, decent photo
printing. 
No output tray, No pictbridge  
Contact Canon India Ltd
Phone 0124-5160000
E-mail www.canon.co.in
Price Rs 3,195

HP Deskjet 3745
Fast print outs, 
excellent price
Below par photo printing
Contact Hewlett Packard 
India Ltd. 
Phone 0124 2566 111
E-mail www.hp.com 
Price Rs 2,999

Photo Inkjet MFDs
HP PSC 2608

Inexpensive, excellent and fast
text and photo printing
None
Contact Hewlett Packard India Ltd.
Phone 0124-2566 111 
Website www.hp.com
Price Rs 14,999

Office Inkjet MFDs
Lexmark X7170

Full featured MFD, fast 
printing,copying speeds. Decent
quality photo prints
No memory card reader, B&W
LCD screen 
Contact Lexmark India Ltd.
Phone 022-2605 7755
Website www.lexmark.com
Price Rs 14,999

Fujitsu S2020 
Hot swappable combo drive
Good graphic performance  
Average screen readability in
sunlight 
Contact Fujisan Technologies Pvt Ltd
Phone 022-56368718
E-mail gathani.paresh@

fujisan.co.in
Price Rs 78,000

Zenith Presidio Vu
Good battery life
InbBuilt Web cam and SD/MMC

card reader support
No recovery CD provided

Contact Zenith Computers Ltd 
Phone 022-28377300
E-mail kalpak_bhatt@

zenith-india.com 
Price Rs 70,000
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Office/ Photo Inkjet
Printers
Canon Pixma iP 3000

Fast, Excellent photo and 
text printing
No LCD 

Contact Canon India Ltd. 
Phone 0124-5160000
Web site www.canon.co.in  
Price Rs 8,495

Canon Pixma iP 4000
Fast, Excellent photo and 
text printing
No LCD
Contact Canon India Ltd. 
Phone 0124-5160000 
Web site www.canon.co.in  
Price Rs 10,995

5.1 Speakers
Artis X10 Mini

Compact, sturdy, clear 
sound
Slightly weak bass 

Contact Kunhar 
Peripherals Pvt. Ltd
Phone 022 56345758
E-mail salesbom@ 

kunhar.com  
Price Rs 17,000

Creative Megaworks 5.1 550
THX

Excellent bass, easy setup
Satellite speakers 
marginally low on clarity
Contact Creative Technology 
Phone 98203 57718 
E-mail india_getcreative@ 
ctl.creative.com  
Price : Rs 20,490



Pay over the air!
Say goodbye to credit cards, ATM cards and passwords. 
Your mobile phone can now double up as your wallet! 

Shopaholics need not worry about paying by cash or credit card. You
can now use your smartphones, PDAs or Tablet PCs in place of your
credit card. Standard Chartered’s OneWallet software, for 
example, can be installed on any J2ME or smartphone. Create a
Virtual Wallet to store virtual debit or credit cards, ID Cards, tickets
and other info. 

[1] Authenticate Your mWallet Account
Once the customer installs the mobile wallet software
on his phone or PDA, he receives a code and password
from the bank. The mWallet software is authenticated
by the bank’s server via GPRS, which allots a private
digital key to the client’s application. The mobile
wallet is now ready to use.

[2] Data Transfer: Bluetooth, IR, SMS
Users need to point the mWallet-enabled phone or PDA at
a Point of Sale (POS) machine, and click on the relevant
tab. Alternatively, you can send an SMS to your bank to
authenticate your password and user ID.
In the case of Standard Chartered’s OneWallet service, the
POS machines (which swipe credit cards) are fitted with an
infrared (IR) adapter. The adapter converts the IR beam
from the mobile, to a series of magnetic pulses that
replicate the swipe of the card through the slot. Once your
account has been authenticated, the transaction is
complete and an invoice will be printed.
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How It Works: Local And Remote Services
Your mobile wallet can be local (using the  software installed on
your mobile phone) or remote (the service is dependent on the
payment provider). Remote wallets  require an “always on”
connection with the server, and user data needs to be
centralised. The server can be operated by the service provider
or financial institution.

Forgot Your ATM card?
Use your mobile wallet at the ATM to
validate account access. Step into the
ATM centre, and point your mobile
phone or PDA at the ATM. A message
is then sent to the bank’s central
server to authenticate your mWallet
application. Once your request has
been authenticated, the transaction
can be completed. 

Digital Tools l Visual Explanation
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Aditya Kuber

ord, PowerPoint and Excel are some of
the most commonly used programs in
our day-to-day work. But we often strug-

gle with formatting the files we create. There’s
an easy way of having a ready format for your
documents, which we present here.

All three programs offer the facility to
create templates that can be opened and filled
up like a form, thereby taking care of your
formatting worries. These programs also come

W

loaded with templates that can be
used if they suit your needs. You
could, in fact, continue to use
them, unless you need a greater
degree of customisation in every
document you create.

MS Word
We use Word for typing out reports
and creating letters, and, if you are
using MS Outlook, it could even be
your default e-mail editor. Here’s
how you can create a template for
each of these.

If you send out a lot of letters
on a daily basis, and if they must be
in a particular format, you can
create a template that caters to
this. To do this, open Word and
create a blank document. Type out
a sample letter with the various
attributes the way you want them,
including fonts, font sizes, spacing
and paragraph setting, and even
things like your company logo (this
could be placed in the header
space). You can also make good use

of the footer space provided and
include Date, Time and page
number details.

What makes all this better is
the fact that all the fields in the
header or footer spaces can be filled
up using Auto text, or just at the
click of a button.

The major advantage is that
such a format maintains unifor-
mity and lets the reader get
comfortable with your format.
What’s even better is that you no
longer have to spend time re-

formatting files created
by others to maintain
this uniformity. (Refer to
Diagram 1 to know what
you can templatise)

MS Excel
Excel is a multi-purpose
application. You can use
it for many things besides
just spreadsheets. The
various possibilities,
including filtering
columns, locking views

and sorting information, make this a powerful
tool for a variety of uses, from creating tables to
maintaining a monthly balance sheet.

In Excel 2002, also known as Excel XP, the
pre-loaded templates include a loan amortisa-
tion statement, a balance sheet, and an expense
sheet, among others. 

But you can create your own template if you
want to. Say you want to keep track of employ-
ees’ attendance and the time they spend in
office daily. 

It’s just a simple sheet you need to create.
(Refer to Diagram 2 to know more)
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h Work Easier
The MS Office suite offers the option of creating
templates for your frequently-used document formats
to make your work easy
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You can add you
logo to your 

documents and
create your own

letterhead Adding your
company name
and address
would
complete the
letterhead
saving costs

By predefining the
format of 

addressing a letter,
you can iron out
discrepancies in

formal 
communication

How you sign off
every letter can be

included in the
template, as can

the signature field

What is the
document?
Assigning
formulae
to the
fields and
locking
them can
prevent
hanky-
panky!

Rules and
regulations
can be
placed here

Fields for
approval
signature
can also be
included

Take out the
jerks from a
presentation
by placing the
presenters
name in the
same place
every time

Your logo and
other
information
can be placed
here to
complete the
corporate feel
of the
presentation

In an expense
statement,
informa-
tion such
as the
employee
name and
other details
can be locked
so no one can
tamper with it

Footer information
including page

number and date can
help track a docu-

ment. You can also
include other data

such as ‘Confidential’
or ‘For Your Eyes

Only’!

MS PowerPoint
We all make presentations and have some fixed
elements in every presentation, such as your
company name or logo, and would like to
maintain these elements for every presenta-
tion you make.

You could do this using the Auto Content
Wizard, and PowerPoint will generate a
complete presentation document. There are
various types of presentations to choose from
as well. 

You could then choose the header or footer
space to add your logo (and any other 
information you want), and save this as a
master slide. This slide can then be used
throughout the presentation. (Refer to Diagram
3 for more info) 

Additionally, you could also change the
style of the text that appears across a presen-
tation by doing the following:

Make sure no objects are selected. From the
‘Format’ menu, select ‘Font’. Make all the
changes that you want and click ‘OK’.

From that point on, new text will be
created in the style you just defined.

To set the formatting for the title or slide
body objects, go to the ‘Slide Master’ and
format these objects on the master. 

Why Templatise?
While some of this stuff sounds rather basic,
the reason behind emphasising this is the cost
saving it could bring you and the identity you
could create.

Take for example the template created in
MS Word. If you could have a logo and your
address placed in every printout you take, you
would not need to make letterheads for your
company. All employees could print out their
letters on ordinary paper.

By creating a universal template in MS
PowerPoint, your presentations could have
uniformity and consistency of style. Clients can
come to expect this from you and it also
displays a certain level of discipline.

More importantly, though, you could
templatise spreadsheets for purposes such as
claiming expenses—a company balance sheet
with locked formulas can ensure that there is
no misappropriation. All the employee has to
do, is fill in the requisite fields and take a
print. The advantages are obvious.

Programs such as Word and PowerPoint
offer an even greater level of customisation
that can help you take out the hassles of worry-
ing about how every document is going out. 

One thing you need to remember in all this,
though, is to save your file as a template and
not as a file. All the others need to do is open
this template. 

You also don’t need to worry about anyone
overwriting your template file because the
program will automatically open the ‘Save As’
dialog box whenever someone hits [Ctrl] + [S]. 

It’s a good idea to create a variety of
templates for various requirements that could
save everyone time and a lot of headache! 

aditya _kuber@thinkdigit.com

In a
corporate
presentation,
the style is
important
and
predefining
this can help
maintain
consistency

Diagram 1

Diagram 2

Diagram 3
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With falling bandwidth and Web
space prices, and now, a free clas-
sifieds tool! If you have a small
website or a blog, which a clutch of
people visit regularly, then you
could make some money out of it.

After we are clear with what
this AdSense is all about we shall
jump to next obvious question—
how much money can I make,
followed by how much more?

A few details on how to start-
the programme can be roughly
divided into two-steps:

Step 1: You register with
Google for the programme. Give
them the URL of the site where
you want the ads… and wait.
What happens behind the scenes:
Once you do this, Google’s bots pay
you a visit. Reminds you of the
Matrix? Anyway, these guys crawl
all over you site collecting relevant
information. Once the informa-
tion is evaluated, your site/blog is
approved or rejected. 
What are the criteria for
approval: The approval/rejection
is based on the site’s content and
quality. AdSense does not accept
sites, which contain porn or
promote the use of tobacco and
drugs. If your site steers clear of
these then it’s likely that your
application would be approved.

How long does this process take:
“They approve the sites real quick
vis-à-vis other advertising
programmes, considering the
large number of applications they
get,” says Ganesh Siddamali, who
runs www.rupya.com, a site that
focuses on the Indian stock market
including daily performance
updates. Rupya.com was approved
within a day. However, in some
cases, the approval may take as
long as seven days.

Step 2: Once your site is
approved, you are mailed a
link directing you to your
account. You can login and
customise your ads (pick the
colour, placement, and

number of cells per ad). Copy the
HTML code that’s generated and
paste it onto your site or template,
and sit back… but remember the
caveat ‘a little bit of effort’.

Money Matters
Now that you have the
banner or footer or any of

the other ad placements done how
do you pull in the money? The
process is really simple—click the
ads to rake in the moolah and
increase the page-views of your site.

How long does it take for the
first cheque to come into your
account? Google starts paying you
once you have crossed the $100
mark. According to Babychen
Mathew, editor of www.dance-
withshadows.com, a news and
current affairs Web site, “It takes
around four months for the first
payment to come in. That’s if you
have a fairly decent number of
visitors, say, around 10,000 a
month.” Others like Siddamali,
whose site deals in Indian stock
market news and figures at the top
of a lot of searches, got their first
payment within a month.

Trial And Error
Your site’s content
decides the type of ads

that feature on them. All ads 
do not pay the same. The
amount varies from as low as
five cents per click, per ad, to as
much as $5 per click. The well
paying ads are mostly tourism,
pharmaceuticals and online

Mithun Kidambi

et’s have a small Q & A
session. There are three
alternatives to pick from.

The question is the obvious; which
one of these would you choose?

a] You get a lot of money, but work
very hard for it.
b] You get a decent amount of
money with a little bit of effort.
c] You pluck money off the trees.

The answer is a practical no-
brainer. Option [c] is what we all
wish could happen. But it seems
implausible, as long as the incum-
bent divine force decides other-
wise. Now, if you are working very
hard for the money in option [a],
chances are you won’t get enough
time to spend it. That leaves us
with option [b], the one option
practically everyone chooses. 

A universal fact, this has been
exploited by various Internet
companies. But the big daddy of all
new forms of simple innovation is
Google. And they have put the
above fact into the heart of their
AdSense programme.

What Is AdSense?
Small time Web publish-
ers never had it so good.

L

Add monetary value to your online thoughts! Get money sense... 
get Google AdSense 
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AdSense is a good instrument
to supplement the income from
your site. But if your Web site is
your prime source of revenue, then
you must consider other advertis-
ing and/or marketing sources.
Mathew adds, “AdSense can’t be
the only source of revenue. We are
also part of the Amazon Associates
programme, and sell ad space on
our site directly to companies.” 

If you are the owner of a Web
site or are a prolific blogger, it’s
sensible to have AdSense as a
supplementary source of revenue.
Even popular sites like Indiatimes
and Sify use AdSense. Don’t expect
to start with a five-figure packet
using AdSense—a couple of thou-
sands every month is more realistic
and achievable. 

Competitors Any?
There are other affiliate
advertising programmes

such as the Amazon Associates
and the Yahoo Overture Affiliates.
Nevertheless, users claim that
Google’s AdSense pays far more
than any of these—as much as 35
per cent more. It has fewer caveats,
and is prompt with payments.

Amazon Associates claim that
the Amazon brand ends up getting
a lot of visibility but doesn’t neces-
sarily translate into revenue for the
Associates. AdSense, on the other
hand, places ads of third parties so
the relevance increases. Yahoo’s
Overture programme needs your
site to have a very high number of
page-views to get an approval. This
is a major deterrent for smaller
sites and bloggers. 

On the flipside, in other affil-
iate programmes, the parent
company provides you with the
contact info of the person, who
was referred by you and made a
sale. This helps you in making
future sales. However, AdSense
does not give you this informa-
tion. Still, this is of mere academic
interest to most AdSense users
who are by and large, small Web
site owners or bloggers.

As a medium that places rele-
vant text ads on your Web page or
blog, AdSense is fast becoming the
de facto advertising and sales tool
for small time Web publishers.
With rumours of how people have
made $1000 a day by using
AdSense, hundreds more are queu-
ing up. Don’t lag behind—get ready
to make that extra buck. 

mithun_kidambi@jasubhai.com

gambling. You can also play
around with your content to
attract specific advertisements.

Mathew agrees that it is possi-
ble to tweak your content to attract
high revenue ads. “If you keep play-
ing around with your content to
get such ads, you can be chucked
out of the programme. But once
you are out, there’s no coming
back,” cautions Mathew.

On a more rational note, it’s
unwise to make your content adver-
tisement-centric. “You risk losing
your readers,” says Kiruba Shankar,
blogger, who runs
www.kiruba.com—one of the most
widely-read blogs in India. “I once
had an ad for Sri Lankan tourism
on my site—it attracted a lot of
clicks, which gave me a decent sum.
However, if I keep displaying ads on
Lankan Tourism alone, how many
readers would I get?” aks Kiruba. 

Mastering The Game
The wisest thing to do is to
stay focused on the

content of you site/blog. Chances
are, if people are interested in the
data you’re offering, they may be
inclined to click those relevant
links, which is actually what the
ads really are. While, you’re unable
to determine what kind of ads
show up on your page, you can
filter out the ads that you do not
want, say, competitors’ ads.

You can include the Google
search on your page, which is a
good value-add to your site. Now, if
you are wondering whether using
AdSense increases the number of
hits, the answer is “No, it doesn’t”.
The bot that searches your site for
content to place the ads is differ-
ent from the one that visits your
site to rate it on the search. Google
has made sure that using AdSense
is not a criterion for turning up
high on the search results. 

The Ayes And Nays
A clean, transparent, non-
intrusive advertising serv-

ice that let’s you earn some shekels
without investing a cent. That’s
probably why we have the Internet,
right? Well, there are no free
lunches, but this one comes really
close. All the same, don’t expect to
generate all your revenue by using
affiliate advertising services. It’s
good to have AdSense as it’s free,
though a high number of page-
views is just what the 
doctor ordered. 

If you are a
Web site
owner or a
prolific 
blogger, 
it makes
sense to 
have Adsense
on your 
site as a 
secondary
source of
revenue

Sensible Dos 
And Don’ts

Dos
Keep the content of your

site updated and relevant.
If you have a blog, use

publicising tools to publicise
you are a blog. More readers
mean more click-through
rates, which translates 
to more revenue.

Play up certain parts of
your content if you think it
would attract high 
revenue ads.

Add the Google search to
your Web page. It adds flexi-
bility to your site, and
increases page views.

Don’ts
Don’t tweak your site just to

attract high revenue ads. Too
much tweaking will bring you
under the Google scanner and
could lead to an ouster from
the programme. Remember,
the story of the goose that laid
golden eggs?

Don’t go overboard and clut-
ter your entire page with ads.
You’ll lose out on visitors.

Don’t hire some one to sit
and click the ads on your site.
This attracts automatic
disqualification from the
programme.

Don’t keep clicking the ads
on your own page, obviously!

Digital Tools l Smart SoHo

A typical AdSense payment
report. See the $55 (approx
Rs. 2,365) earnings figure!
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An Error Message Niggle

My computer configuration is as follows: an
Intel Pentium 4 2.4 GHz processor, 128 MB of

DDR RAM, a Samsung SP0401N 40 GB hard disk,
and a Gigabyte 8LD533-C-P Titan Series
motherboard. Each time I boot into
Windows I get this message: “ccRegVfy.exe -
unable to locate component: this applica-
tion has failed to start because ccTrust.dll
was not found. Re-installing the application
may fix this problem.”

I am not facing any problems as a result
of this, but I want to get rid of the message.
It began showing up after I uninstalled
Norton AntiVirus 2003. I installed the soft-
ware again but the message persists.
What’s up?

Kangkan Goswami

This is happening because Norton
AntiVirus has not been properly

uninstalled. Uninstall it—delete all the folders
that it created in the ‘C:\Program Files’ folder.
Now, ‘ccRegVfy.exe’ is being called upon at
startup, so go to Start > Run and type in ‘mscon-
fig’. Under the Startup tab, uncheck the entry
for ccRegVfy.exe, and restart your machine. You
should not see the error message again.

*.GBA?!

I have a file called ‘29 NES Games (PD).GBA’.
What is this file, and what software is

needed to open it?
Chetan Gupta

A .GBA file is a
G a m e B o y

Advance ROM file,
which is a dump of
the original
GameBoy console
game cartridge. This
file can be played
using a tool known as
a GameBoy emulator,
which emulates the
GameBoy console on a
PC. Bear in mind that it
is illegal to play the
game on your
computer if you do not
possess the original
cartridge for the game.

Error Messages Again

I use Windows XP. While playing the Digit CD
or surfing the Internet, I see a message on

the screen. I have installed the latest versions of
Flash and DirectX from the Digit CD, but I have the
same problem. The message is as follows: “Your
current security setting prohibits running ActiveX
controls on this page; as a result, the page may
not display correctly.”

Jignesh S Paradava

In the Control Panel, open ‘Internet
Options’ and go to the ‘Security’ tab. Click

‘Custom Level’ and select ‘Prompt’ for every-
thing under ‘ActiveX controls and plug-ins’.
Though this will solve your problem, there is
ActiveX content on some Web sites that has the
potential to harm your computer—so you will

have to be extra careful while surfing the
Internet with these settings.

More RAM, Please

One of my clients has a VIA chipset HIS
Motherboard. The model is P4M266.

The problem is, he wants to add an addi-
tional 512 MB of DDR RAM. Will it be OK for
me to add an additional 512 MB of 266 MHz
DDR RAM, parallel to the existing 256 MB?

Juzar

You will definitely be able to install
an additional 512 MB DDR memory

module. Keep in mind, though, that the
motherboard supports up to 2 GB of 200

MHz or 266 MHz DDR RAM only. We advise
that you install a RAM stick of the same speed
as the one already in place, in order to avoid
any problems.

I Want Space, And I Want It Now!

I had a 40 GB HDD with four partitions of 9.75
GB each. I have two OSes, Windows XP and

98. While trying to install Linux Mandrake 8.2 on
one of the free partitions, the installation failed,
citing insufficient disk space, although I’d twice
allotted 3 GB for this purpose. After that,
Windows shows only 3.88 GB of space in that
partition, which means I lost almost 6 GB! How do
I get this space back?

Arindam  Mookherji

A 3 GB EXT2/3 file system partition was
created by the Mandrake 8.2 installer

during each of your two failed attempts 
to install it. The EXT2/3 file system is 
only accessible under Linux, and so the 
partitions thus created are not visible from
within Windows.

However, using ‘Disk Management’ in
Windows XP, you can format the EXT2/3 parti-
tion to a FAT32 or NTFS partition, which will be
accessible from Windows. (Note that NTFS
partitions will only be recognised by Windows
XP, not 98.)

To access this utility, open the Control
Panel, click ‘Administrative Tools’, then click

Your Questions, Our Answers

Illustration Harsho Mohan Chattoraj
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‘Computer Management’ and then ‘Disk
Management’. You’ll see your partitions in
graphical format. Right-click your partition,
select ‘Format’, and you’ll see the file system
options available for the partition. Remember,
you need to be logged in as an administrator to
be able to do this.

An AntiVirus For All Occassions

I installed Windows 2000 Server, and then I
tried to install Norton AntiVirus 2005, but

could not. I then tried McAfee Virus Scan version
9.0 trial with the same results. I changed the OS to
Windows 2003 Server Standard version. Even
then, neither of the two AntiVirus software are
getting installed. Can you suggest an AntiVirus
from either Norton or McAfee?

If I purchase Norton System Works 2005, can it
be installed on the above operating systems, and
also on Windows 98 SE? I would like to to
install a single AntiVirus software for all
the above operating systems. Which
AntiVirus should I purchase?

B R K Swamy

Since you wish to install the same
AntiVirus on different versions of

Windows, you will have to use Symantec
AntiVirus Corporate Edition. No other
AntiVirus software runs on all the oper-
ating systems you mentioned.

Who Does This Computer
Belong To?

On a branded system, when I right-
click on ‘My Computer’, it shows a company

name such as Compaq or Acer. I want to change
this. How do I do this?

Mubin Nandavar

If you are using Windows
NT/2000/2003/XP, search for the file

‘OEMInfo.ini’ in the ‘System32’ folder in your
Windows directory—for Windows 9x/ME,
search in the ‘System’ folder in the Windows
directory. Open the file using Notepad, and
change the entry next to ‘Manufacturer=XYZ
company’ to whatever you wish to see. Save 

the file and
you will see
the change
immediately.

Where Do I Find The Drivers?

My PC has an AMD K6-II processor on a SiS
530 motherboard and 192 (128 + 64) MB of

SDRAM. The FCC ID of my sound card is
LWHA411G7. I am not sure about the make of the
card, though I was told at the time of purchase
that it was a Yamaha sound card (from the FCC ID
it seems like a Labway). I find the following
etched on different parts on the card: “XG”,
“XWAVE”, “QS300A”, and “9846”. My problem is
that the sound card is supported by Windows 98
and ME, but after installing Windows XP, the
sound card driver—YMH 734—is not supported. I
have downloaded several YMH 734 and also YMH
724 drivers said to be supported by Windows XP
from sites such as driverguide.com,
driverpit.com, and windrivers.com, but to no
avail. What do I do?

Arindam Kaushik Sharma

The sound card you have is the
Labway XWave QS3000A. This sound

card is not supported under Windows
XP. Though XP drivers used to be avail-
able from labway.com, Labway has
stopped distributing the drivers. You
will be able to download the drivers
from http://snipurl.com/dzf8. You are
required to register (for free) in order to
download the drivers.

Gimme DMA

I have an AMD Athlon XP 2400+, an
ASUS A7N8X-X, 256 MB of DDR333

RAM, and Windows XP Pro SP1. I use Alcohol
120% and Nero Express CD. My problem is that I
can’t write at maximum speed; if I try to, my
writer takes about 10 to 15 minutes to write at a
speed of 52x, as well to image a CD. I formatted my
C: drive and reloaded XP.

At first, my device manager showed me that
Direct Memory Access (DMA) was enabled, and
my writer worked properly. But right now, the
transfer mode is auto-detected as PIO. How can
I change the transfer mode to DMA instead of
PIO without formatting my C drive?

Debasis Dash

Get XP to
display your
name in System
Properties,
instead of what
your computer
came with Make XP detect your drives as DMA-capable, if they are
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Use Macromedia Captivate

Macromedia Captivate enables you to
create movies, complete with sound,
to develop e-learning content. You

can also use it to come up with short movies
that teach how to do tasks such as backing
up mail, configuring a network and so on.

Captivate is easy to use, complete with
a detailed help menu. Here’s how to go
about creating a tutorial movie. 

To create a new movie, you have
the option of either starting from
scratch or using a template. Here,
we will not use a template, so start

with ‘Record or create a new movie’.

When you click ‘Record or create
new movie’, you are presented with
two options—‘Record new movie’
and ‘Create other movie type’.

Under ‘Record new movie’, select ‘Custom
size’ and press OK.

In the window that opens, select the
screen size for your movie. You have
the option of selecting from preset
modes, for instance, full screen.

Start up the application (or any
window, for example, the ‘Network
Connections’ window in XP) for
which you intend to create the

movie. This application or window will show
up in a drop-down menu. From this menu,
select the appropriate application.

Select ‘Snap window to fit inside
the red recording area’. This will fit
the chosen application window in a
red box of the size you chose in

Step 2. This should give you an idea of how
large your video will be.

You can start recording right away,
or else, click the ‘Options’ tab to set
recording options. In the ‘Recording
Options’ window, you can change

such settings as language, custom recording
options, enabling or disabling the ‘camera’
sound, recording of a narration, and so on.

Once you have completed tuning
all the settings according to your
script, it’s time to hit the record
button. However, be careful: what-

ever you click now, wherever you move your
mouse, and so on, will be recorded. Go
through your script thoroughly before actu-
ally starting to record.

Click the ‘Record’ button and go
about performing tasks as
mentioned in your script. Every
time an action is performed,

Captivate generates the sound of a
camera shutter. 

Once the movie is recorded, it will
be saved to a predefined location.
The entire recorded ‘reel’ will be
displayed for further editing in the

main window. At this stage, you can delete
slides that you feel don’t fit. Moreover, you
can change the timing by moving the
‘Timeline’ slider.

For this, you will have to go to the ‘Edit’
section: click on the ‘Edit’ tab beside the

‘Storyboard’ tab in the main window. Here,
you will be presented with the timeline of
each recorded slide, which can be adjusted
simply by sliding the red line.

Next, preview the edited movie for
accuracy. To preview the movie,
click the ‘Preview’ icon in the main
toolbar and select ‘Movie’, or

simply press F4. Publish the movie if every-
thing is all right. To do this, click the
‘Publish’ icon beside the ‘Preview’ icon. This
gives the option of publishing the recorded
movie to HTML or SWF, or as an executable
file for Windows, Linux or Macintosh, or to
upload it to your FTP site.

Captivate lets you capture screens and create movies of what’s going on on the screen.
It’s the perfect way to teach someone how to do something on a computer

In the screen that comes up when you start
Captivate, choose to start off a new movie

Choose the size of your movie. If you want,
you can precisely define a custom size

Under ‘Recording Options’, there are three
tabs with a comprehensive set of options

The Timeline gives you an exact idea of what
happens at each moment of the video

Under ‘Publish’, you can choose from several
saving options, and also upload to an FTP site
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To enable DMA, Go To My Computer >
Properties > Device Manager, and click the

‘Hardware’ tab. There, expand ‘IDE ATA/ATAPI
Controllers’. You will find your hard disk and
CD-ROM controllers listed under ‘Primary IDE
channel’ and ‘Secondary IDE Channel’. Double
click ‘Primary IDE Channel’ and click the
‘Advanced Settings’ tab. Set the transfer modes
to ‘DMA if available’ for both the Master and
the Slave devices—these could be listed as
‘Device 0’ and ‘Device 1’. Repeat the above
steps for the Secondary IDE Channel.
Once you change the settings, reboot and
you are good to go!

DirectX Woes Yet Again

I recently installed Windows XP with SP2.
I had DirectX 9.0b, but after installing XP

with SP2, I am unable to install DirectX 9.0c. I
even tried the redistributable version, which
was given with the March issue of Digit.

Using the Everest diagnostic software,
the OS shows up as Windows XP Professional
(5.1, build 2600) Service Pack 2, v.2096
(2600.xpsp_sp2_rc1. 040311-2315), while the
DirectX version is DirectX 9.0b
(4.09.0000.0903). 

Karan Pratap Singh 

It’s evident that you have Release Candidate
1 of Windows XP SP2 installed. Install the

final version of SP2, which was supplied with the
Digit September 2004 DVD. Alternatively, you
could download it from the Microsoft Web site.

Where’s The Colour?

I have an Athlon XP 1700 processor on a
Gigabyte KT400 board, 512 MB of SDRAM, and

an nVidia GeForce FX 5200 AGP card with 128 MB
of RAM. The display card has a 4-pin S-Video out
socket. I have a Sony combo drive, and also an LG
52X CD-Writer. I tried connecting my TV using an S-
Video to RCA cable (S-Video out to the video-in of
the TV). I adjusted the necessary configurations in

‘Display Properties’, and selected my TV as the
secondary analogue clone display.

My problem is that the display on the TV monitor
is Black and White. I tried to configure the TV display
properties to the lowest resolution of 800 x 600, but
am still unable to get the TV to display colour.

K Ramanathan

Your problem is that your display card’s TV
output is conformant with a TV standard

other than the one for which your TV is config-
ured. There are three widely-used TV
standards, PAL, NTSC and SECAM—PAL is
the one used in India.

There are three solutions to your
problem. The first and best is to install
the latest version of the nVidia
ForceWare drivers from the Digit
CD/DVD. Your display card should now
correctly detect your TV. Otherwise, you
can download and install a utility called
TV Tool from http://snipurl.com/dzfa.
Using this, you will be able to change the
TV standard of the TV-out signal of your
display card. The third solution is that if
your TV supports multiple standards, try
changing the TV signal standard of your
TV from PAL to NTSC.

Umm, I Deleted Some Folders...

I deleted the folders of some unwanted
programs, and cannot remove them from the

‘Add/Remove Programs’ list. How do I do this?
Abhishek Kumar

To remove entries from the ‘Add/Remove
Programs’ list, use the registry editor. Be

very careful when using it: one false move can
render your PC unbootable.  Click Start > Run,
type in ‘regedit.exe’ and click OK. Go to
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\
CurrentVersion\Uninstall. Here you will find
the various registry entries that correspond to
the entries in the Add/Remove Programs list.
Just delete the entries you don’t want. 

E-mail us your computing
problems along with your
contact details to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we may answer them
here! Since we get more
mails per day than we
can handle, it may take
some time for your 
query to be answered.
Rest assured, we are
listening!

Get Help Now!

Just WAV Doesn’t Do It

I bought a new Aiwa CD Player, model XP-V416C, EASS 10
sec, 1-bit DAC, CD-R/RW playback. It can play only Audio

CDs. When I convert MP3 files to .wav using mp3 decoder soft-
ware and burn them onto CD, the player doesn’t play
anything. But when I copy an audio CD, it plays. I have
MP3 Work Shop 2.01 by Donal Riordan. Please tell me
how to create an audio CD using an MP3 decoder and
Nero Burning Rom 6 Express Edition.

Krishna Caitu

An audio CD contains audio tracks in RAW form (which
is a form of the wave file format), but if you notice, the

files on an audio CD are .CDA, just a few KB in size. These
files point to the location of the RAW audio tracks on the
audio CD, while the tracks themselves are not visible.

You can create an audio CD using Nero Express. To do
so, move your mouse over ‘Music’ in Nero, and click on

‘Audio CD’. Click
‘Add’ in the next
window, browse
to the folder
where you have
stored your
songs, select the
songs to be
added to your
audio CD compi-
lation, and then
click ‘Add’. 

After you are
done, click on
‘Finished’. Now
click ‘Next’, select

a burning speed of 8x for backward compatibility with older
CD players, and click ‘Burn’. The audio CD thus created will
be playable on any audio CD player.

Question 

of the

Month

Compiling an audio CD using Nero Express
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If any of you ever happen to be at Jasubhai
Digital Media, more often than not, you
would be greeted with a warm smile unless

you bump into some of the drones working at
the Test Centre. Strike a conversation with any
of them and within no time, jargon would be
thrown at you; sure to make you feel ‘inferior’
and left out. Thanks to my understanding of
technicalities and jargon, I am often spared,
but not always! 

Luckily for me, fate does present me with
one of those rare moments, wherein I can land
some punches to make my point clear, ‘I am the
Agent 001’. This month, fate offered me with
such an opportunity. 

Our guys in the Test Centre were conduct-
ing a speaker comparison and wanted to buy
the best sound card available. Did someone say
the best available? Well that’s my hunting
ground, isn’t it? So it was decided that I would
look out for the best available sound cards to
drive those 7.1 speakers, which the guys could
be testing very soon.   

If I remember correctly, in the days of
Pentium-II, sound cards were a rage, more so
the SoundBlaster range from Creative. Though
there were a few others, such as Yamaha and
Aureal, it was Creative that sold like hot cakes. 

Interestingly, things have since moved fast
and there is barely a sound card market
to speak of, thanks to the integrated revolu-
tion brought about by Intel’s AC’97 standard
that integrates a rudimentary sound solu-
tion in all motherboards.

Integrated solutions themselves
have evolved from the stereo on-board
solutions offered in the early stages
to high-definition audio on the new
915 and 925 chipset based mother-
boards—good for casual everyday
use. As for audiophiles, these inte-
grated solutions hardly deliver. So
let’s tumble down the rabbit hole and
see where it all leads to.

My first destination was a
small shop on good old
Lamington Road.
Imagine my shock
when my very first
inquiry turned
out to be a dud.
I was told that
they don’t
stock sound
cards any more
but the ‘next big
shop’ might just
have one. 

So I moved on and found out that only
Creative cards are available and are certainly
worth the money. Here’s a word of advice:
Creative has stopped making the ‘Vibra’ range
and if you do come across one, don’t buy it; it is
bound to be old stock.

I asked for a ‘Live’ series card and was pre-
sented with a 7.1 card. As far as I could remem-
ber, the ‘Live’ series was a 5.1 card. Soon
enough, I received some more gyan and
realised that the new ‘Live’ cards are 7.1 capable
while 5.1 cards have been discontinued.

The new Live 7.1 card costs Rs 2k; not bad for
a 7.1 card. Point to be noted: the newer card
does not have a separate ‘Digital Out’ connec-
tion. The Mic/Line-In connector serves as Digital
Out and you need a Digital I/O module to use it.
This 7.1 card supports EAX and EAX Advance
standard, so it’s good for gaming too! Thanks to
the lack of support for standards such as THX
and Dolby, the Live 7.1 card was not suitable for
the Digit Test Centre.    

My sources inform me that there is a dupli-
cate ‘Live’ card on sale too. Despite my best
efforts, I couldn’t get the shopkeepers to tell me
how one can distinguish between the two. For
now, as a thumb rule, if you happen to come
across a ‘Live’ card for around Rs 1.4k, be
warned that it’s not the real one. 

The next on my list was an Audigy series
card and I was promptly offered an Audigy 2
Value card. This card does support Dolby
Digital EX, EAX and 24-bit DVD audio.
The Audigy Value card is available for approx-
imately Rs 5.5k.

I had to ask for a better card and I was pre-
sented with the Audigy 2 ZS Platinum Pro—just
the onse I was looking for. This card supports
THX, Dolby Digital, DTS ES 6.1, 24-bit DVD
audio and EAX Advanced HD effects. 

Moreover, the Audigy 2 ZS also conforms
to nearly every standard and will make a dif-
ference when watching a movie, playing
games or just listening to music. This card
also supports ASIO 2.0, a standard for inter-

facing software on a PC to any audio hard-
ware. The external I/O module comes in

handy when connecting various instru-
ments to your PC. Considering the
needs of our Test Centre, I bought
the Audigy 2 ZS Platinum Pro at a
whopping Rs 14k. 

Agent 001

The Audigy 2 ZS
conforms to
nearly every
standard and
will make a 
difference 
when watching
movies, playing
games or just
listening to
music

Sound Solutions
Agent 001 embarks on a quest for fidelity and quality… of speakers!

Want more of Agent 001? Turn over
to read his answers to your buying
questions

Illustration Shyam Shriram
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Apple, Compaq or IBM?

I need a laptop for high-end multimedia
applications such as Autocad, CorelDraw, and

a few other processor-intensive programs. I like
the Apple PowerBook (15”), but my friends say
that the Compaq B8000 series and IBM R series
are equally good. I don’t want the laptop to be too
heavy, and my budget is Rs 1.1 lakh. Which one
would you suggest?

Vinay Anand 

I suggest you to go for a Windows-based
system for the wide array of software

available. As far as processing power goes,
Apple’s PowerBook and Windows-based lap-
tops are pretty much neck-to-neck. However,
when it comes to application support, Mac OS
isn’t quite popular with software developers
and hence, very few professional applications
are available for Mac OSes. The R-series from
IBM is good.

Also, opt for a Centrino-platform laptop over
a Pentium 4-based laptop, simply for the per-
formance and better battery life offered by the
Centrino platform.

Mobile Mania
I want to buy a mobile phone; it should have
Bluetooth, a camera with at least 10 minutes of

recording (preferably with Night Shot), FM, MP3, a
good screen, and four hours of talk time, and it must
look great! I have a budget of around Rs 15k.

Jishad

First, I would ask you to look at the
K700i from Sony Ericsson. An upgraded

version of the K700i, to be called K750i, is on
the horizon. It has a 2-megapixel camera and
support for a memory stick, which the K700i
lacks. You can also look out for the Nokia 6600,
but the video recording is limited to just 10
seconds. The Nokia 6230, despite having most
of the features you asked for, doesn’t have a
large screen.

More On Mobiles
Is there a mobile phone with Bluetooth, add-on
memory capability, and an easy programmable

interface (J2ME), but without a camera?
Raja Sekar

Almost all smart phones from Sony
Ericsson and Nokia are J2ME-capable.

However, it is difficult to point out a particu-
lar phone that does not have a camera and
still has memory upgradeability. 

At the same time, older J2ME phones with
no camera have very little memory onboard—
around 700-odd KB, which is not good for any
programming that you may be interested in.

Of Thumb Drives
I want to buy a 128 MB thumb drive for under
Rs 1,500. I want to transfer data files smaller

than 100 MB from my college computer to my home
PC. A plug-and-play drive would be preferable.

Rajiv Bhalotia

You can buy a Transcend Thumb drive for
around Rs 1,500. Contact Mediaman

Infotech on 022-23828100. Also, almost all pen-
drives are plug-and-play devices. If your PC has
Windows 98 or ME, you will need to install the
drivers, otherwise it will be automatically
detected and initialised for use by Windows XP.

DVD/Combo Writer Please!
I want to buy a DVD/Combo writer for backing
up my data. Could you suggest a good one? I

need a drive with 52X writing speed and 16X DVD
writing speed.

Dr V K Saxena

Typically, a combo drive costs between
Rs 2,500 and Rs 2,950 depending on the

brand. You can go for Lite-On, Sony, Asus or
BenQ. In case of DVD-writers, buy them if your
data set is going to be larger—that is, above 1
GB. You can buy a 16X DVD-Writer too, but as of
right now, DVD media availability is an issue.
For your information, DVD-writers will cost
upwards of Rs 4.5k. 

As far as 
processing
power goes,
Apple’s
PowerBook
and 
Windows-based
laptops are 
pretty much
neck-to-neck

Want a tech product, but
don’t know how to go
about buying it? Send an
e-mail to
agent001@thinkdigit.com
to get your queries
answered

Ask Away

Ask Agent 001

Rs 
7,500
6,500
3,500
2,650
6,500

300
300
500

2,000
2,750
2,400

34,900
12,000

3500
4500
1600
2650
4500

300
300
500

2000
700
450

2211,,000000

Choose Your Computer

AMD 939 pin Athlon64 3000+ or
3200+ 
MSI RS480M2
512 MB DDR 400 Hynix
80 GB SATA Samsung/Seagate
17” Acer 715 
Logitech 
Logitech Optical Mouse
Any cabinet you like
Antec / VIP 350 W power supply 
Lite on / Sony Combo drive
Creative Inspire 2.1 

XFX Geforce 6600 card 

AMD Sempron 2500+ 
ASUS A7N8X-VM
256 MB DDR 400 Hynix
80 GB SATA Samsung/Seagate
15” Acer 715 
Logitech 
Logitech Optical Mouse
Any cabinet you like
Antec / VIP 350 W power supply 
Sony CD-Rom 
Creative SB15

Make Cost (Rs) High-End
CPU 
Motherboard
RAM
HDD
Monitor
Keyboard
Mouse
Cabinet 
Power supply 
Optical Drive
Speakers
Total
Graphics Card
(optional)
Low-End
CPU 
Motherboard
RAM
HDD
Monitor
Keyboard
Mouse
Cabinet 
Power supply 
Optical Drive
Speakers
Total 

Month after month, I keep getting let-
ters asking for a high-end, low-end and

a mid-range PC configuration. I’ve decided to
answer them all at once (see adjoining box). 

I am addressing the low and mid-range
configurations. In case of a high-end PC, just
change the processor and graphics card in
the mid-range PC to the fastest and the best
available! You can even increase the memory
to 1 GB, if you please.



Meera Vankipuram

re small firms more susceptible to secu-
rity attacks? All organisations, irrespec-
tive of their size, are exposed to the same

set of malware (any form of malicious software
such as viruses and Trojans). However, SMBs who
do not invest as much in IT, and have mostly one-
man security teams, may be easy targets for  secu-
rity attacks as compared to bigger enterprises. 

Fetish For Security
Not all agree, though. Chennai-based DAX Net-
works takes security very, very seriously. A 17-
year-old organisation, DAX Networks specialises
in delivering networking solutions (with pre-

and post-sales support on projects) to
SMEs and  enterprise-level
organisations   throughout 
the country. 

With over 150 users accessing their internal
network on a daily basis, DAX has installed a Fire-
wall-cum-VPN security solution offered by
WatchGuard, a global security vendor. “We
create customised networking solutions for sev-
eral Indian companies, although some of the
core technologies are sourced from the US,” says
R Rajan, Head-IT Processes, DAX Networks. 

WatchGaurd’s Firebox
DAX purchased WatchGuard’s Firewall plus VPN
security solution, as it “fit the requirements of
our network,” according to Rajan. WatchGaurd’s
Firebox solution was customised by DAX Net-
works. He adds, “We first discussed our needs
thoroughly, with the WatchGuard reseller in
Chennai. This kind of expenditure requires
long-term planning.” 

Digital Business l Case Study

How Technology Can Help Your Organisation
Business
Digital

82 Your Café
On The Web

Case Study

Crystal Clear70

Learn how
Chennai-based
DAX Networks
stays on guard
with VPN,
firewalls and
digital signatures

Secure Thy Network
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access a remote server from their machines
(with an SQL backend) and use PPTP (point-to-
point tunnelling protocol) to access the server.
However, firewall authentication is required at
each and every stage.”

Rope In The Employees 
Active employee participation is critical for
any secure network. After all, a network is as
vulnerable as it’s weakest link; the link, which
most virus writers and spambots exploit—
the end user. Audits aside, employee aware-
ness programmes can go a long way in ensur-
ing that a network stays secure and active. 

As Pillai affirms, “The SMB segment in India
is growing at a 30 to 40 per cent rate every year.
Their employees are net-savvy and communicate
with a global clientele. Moreover, the US and the
UK-based companies are demanding rigorous
security norms before awarding contracts to
Indian firms.” 

Prevention Is Better Than Cure
SMBs such as DAX Networks, which may or may
not flaunt a full-fledged ‘IT team’, are certainly
reinforcing the ‘better safe than sorry’ norm. It is
by investing time and resources in security solu-
tions as well as enforcing stringent security pro-
cedures that SMBs can try and achieve minimum
‘downtime’ even when crippled by a severe viola-
tion of their security system. 

“Security vendors have begun to realise that
the ‘one size fits all’ paradigm doesn’t hold true in
the SMB space. Customised solutions coupled with
personal attention, and assisting  SMBs to promote
prudent network usage works best,” avers Pillai. 

meera_vankipuram@thinkdigit.com
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Ajit Pillai, country manager, WatchGuard,
says, “The customised Firebox solution by DAX
scans the perimeter of their network.” The firewall
protects the SMTP, FTP and HTTP servers from
unwanted traffic. The Firebox series includes
Firebox X, Firebox X Edge, and Firebox SOHO.

WatchGuard also offers unified threat man-
agement solutions including signature-based
intrusion detection systems (IDS), and a ‘State of
Network’ test, which is bundled free with its
Firebox. WatchGaurd’s dynamic ‘Live security
service’ provides regular updates and virus alerts,
identifies vulnerabilities, spyware, and intrusions.
Pillai elaborates, “Product updates, anti-spam and
anti-virus tools can be enabled by installing soft-
ware keys, thereby eliminating inventory issues.”

Remote Servers And Data Transfer 
“Our critical resources are accessed by about 35
users—they access Web sites, use FTP clients (two
users), CRM applications (25 users), and access
mail and domain servers as well. All functional-
ities are mapped and external users are authen-
ticated at every stage,” says Rajan.

Firebox has helped protect the company’s
critical resources. “With an edge-based firewall
(one that protects the perimeter of the network)
most vulnerabilities can be exposed. But we also
use digital certificates for our transactions,” adds
Rajan. Digital certificates are often used for
online transactions to validate one’s credentials,
and are used by companies operating in the e-
commerce or monetary transactions space.

End User Involvement 
In order to engage end-users in the security
framework, WatchGuard’s resellers conduct
training sessions, and also help update the par-
ticular company’s security resources. 

WatchGuard coordinates various security
audits and network maintenance programmes
in alliance with vendors and resellers in dif-
ferent cities in the nation. “While some com-
panies may want complete audits while others
may require only updates—the requirements
vary depending on the size of the network, VPN
tunnel speed and throughput among other 
factors,” says Pillai. 

Rajan agrees that end user involvement is
essential. He explains, “We use a Virtual Pri-
vate Network (VPN) so that our Customer Rela-
tionship Management (CRM) server can be
accessed by our sales team across India. Users

Most networks are vulnerable to intrusions and virus attacks. With virus
writers getting incredibly creative, and spawning by the dozen, a robust

network is one that can react immediately to an attack and bounce back to
normalcy, ASAP. A few tips to keep your SMB’s internal network secure:

Educating Your Employees
End users are extremely vulnerable nodes in any network. Enforcing
protocols, like not opening suspicious attachments, updating virus definitions
regularly, using ‘safe’ sites for e-commerce transactions, not responding to
spam, and perhaps subscribing to security updates/newsletters from a trusted
vendor would help prevent many attacks. Also, employees should report virus
attacks immediately, and download relevant patches. Setting complex
passwords for accounts, and using encryption keys for transfer of confidential
documents is equally imperative. 

Access To Key Network Resources
Access to key network resources should be restricted to one or two people
(preferably the CTO and the System Administrator) and all security breaches
should be reported to the concerned authority. 

Software Updates
It goes without saying that pirated software is a no-no. Regular updates of
existing software will safegaurd your PC safe from newer, malignant malware. 

Security Audits
Regular security audits—internal or external—are a must for any firm. With a
slew of viruses and Trojans hitting the Interent on a daily basis, audits will let
the administrative department know, how vulnerable a system is, to attacks.
Again, the SysAdmin needs to involve users in security exercises. 

Security And The SMB 

In February this year, Slashdot
(www.slashdot.org) published (unconfirmed)
reports of the SHA-1 algorithm being cracked by
a team of three Chinese researchers. The
Secure Hash Algorithm (SHA) is a secure
encryption algorithm used in security
applications for online banking systems, in the
creation of digital signatures for secure
document transfer, hashing and the like. 

Time now, perhaps, to shift to the next lot
of SHA variants—SHA-224, SHA-256, SHA-384,
and SHA-512—cumulatively called as SHA-2.

Security Alert: SHA-1 cracked?

Audits aside,
employee 
awareness 
programmes 
can go a long
way in ensuring
that a network
stays secure 
and active
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Compactness, flaunt value, crystal-clear viewing. That’s
what makes LCD monitors so desirable. With a further drop
in prices, expect to see them on more home and office desks
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rest of the bunch which maxed
out at 250 cd/m2. The Philips 150s
had the lowest luminance rating
of 200 cd/m2, which means you
need to make sure light doesn’t
hit the screen directly.

In the 17-inch monitor cate-
gory again, the CMV CT-712A had
a 400 cd/m2 luminance rating,
followed by the ViewSonic and
the Acer at 380 cd/m2 and 370
cd/m2 respectively. The CMV’s
better lamp makes it easy for the
user to tweak the brightness of
the monitor according to the
ambient light.

Contrast Ratio
The contrast ratio is the ratio of
the brightness of pure white
versus pitch black that the moni-
tor displays. A higher contrast ratio
means the user can set the moni-
tor to display images with better
visual depth. Also, a monitor with
a higher contrast ratio helps the
user fine-tune the panel to suit
different lighting conditions.

Although LCD monitors do
come with an ‘Auto’ setting
feature that takes care of the
brightness, contrast and geometry,
this feature is usually not perfect,

and the user almost always has to
do some tweaking. A contrast ratio
of 120:1 is enough to display most
colours. However, an even higher
contrast ratio allows the panel to
display more greyscales. This
means you’ll be able to see more
shades of colour on an LCD with a
higher contrast ratio.

Among the 15-inchers, the
CMV and the HCL claimed the
highest contrast ratio of 500:1,
which is impressive, and which
means the user has a wide range
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L
CD monitors have been on
the verge of mass usage for
a long time now. But the
fact that sales never took

off despite them catching the
fancy of computer users bears
ample testimony to the fact that
there are still some issues with
the products that need to be
sorted out—primarily, cost and
value for money.

The good news is that prices
have been dropping steadily 
over the past few months, to 
the point that many of us—
even home users—can easily
think of owning one. Nineteen-
inch LCDs, unlike their CRT
counterparts, remai beyond the
reach of most of us, so we tested
15-inch and 17-inch LCD moni-
tors—to be precise, 15 models
from 15 brands in the 15-inch
category, and 11 models from 10
brands in the 17-inch category.

Remember that unlike with
CRTs, you don’t get an inch or

two chopped off the viewable
area—if it says 15 inches, almost
all of it is viewable.

LCDs have suffered in the past
in terms of acceptance because of
their mediocre performance in
the movies and games depart-
ment, and also because of the
restricted viewing angle. With
better manufacturing processes,
not only have prices come down,
performance, too, in many areas
has improved. 

Apart from the fact that the
technology is entirely different,
LCD monitors differ in many non-
intuitive ways from CRTs. For
example, LCDs have a ‘native reso-
lution’ at which they work best.

Remember, LCDs aren’t the
ideal solution for everyone 
out there—read on to find out
whether to go the LCD way. We
compared several LCDs based on
aesthetic and technical aspects,

as well as price—so you can make
a sound decision on which 
one to buy. 

Key Features
Here are some features to look at
before you decide upon a model.
Although our list is not exhaus-
tive, it represents the most
important things you need to
know about and look out for.

Some things, such as the pixel
pitch, are different from the CRT
equivalent. Also, contrast ratios
and such have different typical
values in LCDs than CRTs.

Pixel Pitch
The pixel pitch is the distance
between two white pixels, or two
sub-pixels of the same colour. (A
white pixel is made up of three
sub-pixels—one red, one green
and one blue.) The monitors we
received in both the 15 and 
17-inch categories had pixel
pitches of 0.297 mm and 0.264
mm respectively—this is almost
a universal standard. The indi-
vidual size of each sub-pixel 
is, of course, smaller than the
pixel pitch.

Native Resolution
In LCDs, the pixels are hard-
etched on the panel, and there-
fore cannot display crisp images
at any resolution other than the
native resolution—unlike CRT
monitors. The 15-inch and 17-inch
models we received had native
resolutions of 1024 x 768 and 1280
x 1024 pixels respectively—this,
too, is almost universal.

If you change the resolution
setting, you will see a badly
focused image, and hard-to-read
fonts with blurred edges.

Luminance
Luminance and contrast ratio are
of prime importance in LCDs. The
luminance rating depends on the
monitor’s fluorescent lamp, built
into the casing. The brighter the
lamp, the better. The lamp rating
is what determines the brightness
level the monitor can achieve.

In the 15-inch category, the
CMV CT-529A had the highest
luminance rating: 450 cd/m2

(candelas per square metre). This
is the vendor-specified rating,
and, if correct, it means that the
LCD can look bright even in a
fully-lit room.

The Acer AL1512 claims a
luminance rating of 350 cd/m2,
which is higher compared to the

In LCD
monitors,
the pixels
are hard-
etched on
the panel,
and so
cannot
display crisp
images at
any
resolution
other than
the native
resolution
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of contrast and brightness to
play with, from pitch black to
really bright. The Philips 150s
has a poor contrast ratio of 250:1,
leaving little room for tweaking.

In the 17-inch models, the
highest contrast ratio—550:1—
was logged by the LG Flatron
L1730S. It was followed by the
BenQ and CMV at 500:1.

Dimensions
Tighter physical dimensions are
always talked about when LCDs
are compared with CRTs.

In the 15-inch category, the S-
Media and BenQ boasted depths
of just 12.8 and 13.6 cm respec-
tively. This takes into account the
base as well, and not just the
panel. The ViewSonic VE510b had
the smallest width and height of
just 32.5 cm and 32.3 cm—it was a
really neat package.

In the 17-inch category, the
LG Flatron L1730S was sleek—it
was just 11.5 cm deep, making it
stand out from the rest. The NEC
left enough space, width- and
height-wise, to place it on a table
under the file shelf and place
stereo speakers on either side.

The Winsonic L17X, a new
entrant in the LCD monitor
segment, on the other hand, was
comparatively very large—42.5
cm tall and 20.4 cm thick.

Weight
Monitors are not peripherals
that see often changes in physi-
cal placement—weight, there-
fore, doesn’t really matter that
much. But of course, you’d
always prefer a lighter monitor!

The monitors were tested keeping in mind performance, features, and
value for money. Before running the tests, the monitors were placed

perfectly vertical in order to eliminate any uniformity issues, and were
auto-calibrated. All monitors were set to their native resolutions, and
their drivers were loaded so we could get them to perform at their best.

The Test Bed Configuration: Both—the reference and test systems—
were running on a P4 3.0 GHz CPU with 1 GB of DDR SDRAM, an nVidia
5950 Ultra graphics card, and a 7200 rpm SATA hard drive. 

Features: In the Features tests, we looked for value-additions and
other aspects that aimed at increasing the user-friendliness of the
display. The features noted varied in significance—some were simple,
like the user-friendliness of the OSD (On Screen Display); some were
important, like power consumption, depth and weight. 

One important thing we looked at was the monitor base, which
decides the tilt the monitor is capable of—the more the better. 

Some LCDs can be rotated vertically—landscape to portrait. This is
useful while reading a long Word file or a PDF without the aid of a
scroll-wheel mouse. 

An oft-overlooked feature is the supplied user manual and quick
start guide. It is especially helpful if the manual clearly states the full
technical specifications of the monitor.

Performance: We used the DisplayMate benchmarking software to gauge
the LCD monitor’s performance. This software uses images to test a
monitor for criteria such as Point Shape and Visibility. For example, to
gauge how accurately the LCD can display a fine point, and whether or not
it is able to retain the round shape of the dot, can be guaged by this test.

In the colour and greyscale set of tests, we checked for colour
reproduction, the level shift problem, and the streaking or ghosting
effect. We ran the 16-intensities and 64-level primary and secondary
colour intensities tests to see how well the monitors could
display shades.

In the miscellaneous tests within DisplayMate, we checked for
screen uniformity. We also tested the Reverse Video Contrast. 

The Pixel Persistence Test was run to check for jerks or image
blurring. We used the Passmark Monitor Test to check for image
persistence at the edges.

For the viewable angle test, we used a protractor placed inline with
the LCD panel, and the screen was viewed from either side. A document
containing different fonts was viewed from various angles, letting us
determine the angles at which the text still looked sharp.

Price: We took the price of each monitor vis-à-vis its features and
performance into account.

How we awarded
The features, performance and price scores were given relevant
weightages, and an overall score out of 100 was calculated. The product
that scored the highest was adjudged the winner of the Digit Best Buy
Gold award for its category, while the second highest got the Digit Best
Buy Silver award.

How We TestedA higher
contrast
ratio
means the
user can
set the
monitor to
display
images
with better
visual
depth

Of the 15-inch monitors, the CMV CT-529A was the lightest at just
2.6 kg, followed by the S-Media at 2.7 kg. The Philips 150s, at 5 kg, was
the heaviest.

In the 17-inch segment, the CMV CT-712A was the lightest at 3.4
kg, followed by the Acer at 3.49 kg. The NEC LCD1770NXM is the heav-
iest, at 6.5 kg—which is very heavy by LCD standards.

Flexibility
If a monitor allows for height adjustment, you can set it to the level
that makes for most comfortable viewing. And monitors that do not
allow for height adjustment will require you to adjust the height of

PureView PV 17C

Viewsonic VA712



your chair, which is not a good
thing. In the 15-inch category, not
a single monitor had this useful
feature. It wasn’t much better in
the 17-inch category, either—just
three panels, the HCL, the NEC
and the Philips, had the height
adjustment feature. You can
adjust the height of these moni-
tors by about 11 cm. 

Horizontal and vertical
swivel is another good feature
found in a few LCD monitors.
Most monitors allow for vertical
tilt, but very few allow for hori-
zontal swivel. In the 15-inch
segment, the Digiview was the
only monitor that had both hori-
zontal and vertical swivel. The
rest came with the provision only
for vertical tilt. Amongst the 17-
inchers, again, just two brands—
HCL and NEC—offered horizontal
as well as vertical tilt.

Other Features
These days, some graphics cards,
including even some entry-level

ones, come with the
DVI interface.

If the monitor

has a DVI input, there is no
signal conversion happening in
the monitor, so the overall
image quality is much better
than with the D-sub interface.
Sadly, none of the monitors 
in the 15-inch category had a
separate DVI interface to accept
a pure-digital signal from a
graphics card.

This means that even if you
have a graphics card that can
deliver a pure-digital signal, you

will be forced to feed it to the
monitor through the D-sub
connector. In the 17-inchers,
the BenQ, NEC and Philips had
DVI inputs.

Power Consumption
A salesman selling an LCD 
monitor will never forget to
mention the power consumption
rating of LCD monitors vis-à-vis
CRT monitors. It is a fact that LCD
panels consume less power
compared to CRT monitors, but it
is also true that the power
requirements are often not
substantially lower.

Fifteen-inch LCDs need
anything between 21W and 35W.
Seventeen-inchers need between
40W to 60W of power, which,
compared to the 64W needed by
the Philips 107E5 CRT monitor, is
just a small improvement.

Always remember to check the
power rating of the LCD you are
thinking of investing in, and note
whether there is substantial power
saving possible. Of course, 
for a home user, this
doesn’t make

too much difference—it’s in an
office, where several monitors are
deployed, that power costs add up
to make a difference.

How They Fared
The monitors were tested using
DisplayMate Video Edition and
the Passmark monitor test util-
ity, along with several real-world
tests—these included the viewing
angle test and looking for the
ghosting effect during movies.
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Scoreboard                              15-inch LCD Monitors

Sharpness And 
Resolution
We checked for the sharpness of
the image using the Point Shape
and Visibility screen in Display-
Mate, consisting of a fine white
dot. We looked for pixel bleeding,
and found that most monitors
had some amount of bleeding at

the edge. This bleeding results in
a red, green or blue tinge at the
edge of the dot. Only the View-
Sonic VE510b (15-inch) and
VA712 (17-inch) returned accept-
able results. 

In the video bandwidth test,
a fine white line is drawn on a
black background. This screen is

used to see how accurately the
lines are drawn and whether
there are any discrepancies.

In the 15-inch category, the
AOpen and S-Media displayed
blue tinges running across the
length of the line at the edge,
whereas the Winsonic L1562S,
due to its high brightness, 

BRAND
Model
Features
Pixel Pitch

Luminance (cd/m2)

Contrast Ratio

Native Resolution 

Response time (ms)

W x H x D (cm)

Weight (KG)

USB hub (Y/N) / No. of ports

Built in Speakers (Y/N)/watts

VESA Wall Mount

Swivel Base (Angle) verticle/

horizontal axis

Height Adjustment (cm)

Landscape/Portrait

In-buit TV Tuner

Power Consumption (W)

Input types

Bundled Accessories (Manuals,

Colour Profile, Driver and

Calibrating software…)

DISPLAYMATE VIDEO EDITION
Sharpness and resolution
Point shape and visibility

Video Bandwidth test

Colour and Gray-Scale
Streaking and Ghosting

Bar Streaking

Colour Streaking

Mid-Range streaking

White-level shift

Black-Level shift

RGB purity

Text colour combination

16 intensities levels

64 intensities for primary

colours

64 intensities for secondary

colours

256 intensities level

Colour scales

Miscellaneous tests
Reverse Video Contrast

Screen uniformity

Passmark Monitor Test
Pixel Persistance test (So5)

Miscellaneous tests
Movie Test (ghosting effect)

Viewable angle test (Text)

Viewable angle test (Movie)

OSD usability test

OVERALL SCORE
Feature
Performance
Price Index
Price (Rs)

Acer
AL1512

0.297

350

450:1

1024x768

23

34.6x33.7x18

2.5

✖

✔/NA

✔

✖/✔

✖

✖

✖

33

D-Sub, Stereo pin

Quick setup guide,

Electronic user’s

guide on CD

3

3.25

5

5

5

3.25

3.875

3.5

4

3.375

3.375

3.125

3.25

3.25

3.25

3.75

3.5

1

2.375

147.5

135

4

70.20
7.25

44.95

18.00

9,999

MAY 2005MAY 2005

HCL
HCM 510LSA

0.297

250

500:1

1024x768

16

35.6x35.5x15

3

✖

✔/1W

✔

✖/✔

✖

✖

✖

35

D-Sub, Stereo pin

Quick setup guide,

Electronic user's

guide on CD

2.75

3.375

5

3.5

4

2.5

3.25

3.25

4

2.375

4.25

3.375

3.375

3.125

3.125

3.75

3.375

0.5

2.5

137.5

122.5

4

61.41
6.00

41.55

13.86

12990

BenQ
FP537s

0.297

250

400:1

1024x768

15

33.8x33.1x13.6

3.7

✖

✖

✔

✔/✖

✖

✖

✖

30

D-Sub

Quick start guide,

Driver and Manual

on CD

3

3.625

5

4.5

4.875

3.25

3.375

3.25

4

3.625

4.5

3.75

4

4

4.25

3.75

4.375

0.5

1.25

155

125

4

63.32
6.23

46.17

10.92

16,490

CMV
CT-529A

0.297

450

500:1

1024x768

16

34.8x34.4x18.6

2.6

✖

✔/NA

✔

✖/✔

✖

✖

✖

33

D-Sub, Stereo pin

Quick setup guide,

Electronic user’s

guide on CD

2.75

3.75

5

5

4

2.75

3

3.25

4

2.25

4.25

3.75

4

3.875

4.125

3.25

3.125

0.75

2.875

150

125

4

66.07
7.21

43.86

15.00

12,000

Digi-View
DGL-115AS

0.297

250

350:1

1024x768

25

47x45x14

3.3

✖

✔/NA

✔

✔/✔

✖

✖

✖

25

D-Sub, Stereo pin

User guide, Driver

CD, Calibrating soft-

ware

3.5

3.875

5

4.875

4.875

3.5

3.25

3.5

4

2.75

4.25

3

3.25

3.375

3

4

3.25

0.75

2.625

140

122.5

4

65.18
7.00

44.33

13.85

13,000

LG
Flatron L1530S

0.297

250

400:1

1024x768

16

36.8x39.9x21

3.6

✖

✖

✔

✖/✔

✔

✖

✖

25

D-Sub, Stereo pin

User guide, Driver

CD, Calibrating

software

2.625

3.875

5

5

4.875

3.5

3.375

3.375

4

3.25

3.875

2.875

2.875

3

3.125

4

3.25

0.375

2.25

150

135

4

58.07
5.84

43.66

8.57

21,000

NEC
AccuSync LCD 52V

0.279

250

400:1

1024x768

25

34.4x35.2 x16.5

3.2

✖

✖

✔

✖/✔

✖

✖

✖

21

D-Sub

NaViSet software, 

3.5

3.5

5

5

4.75

3

3.75

3.5

4

3.5

3.75

3.25

3.25

3.25

2.75

3.75

3

0.5

2

155

125

3.5

55.92
4.40

43.52

8.00

22,500

Aopen
F1513

0.297

250

400:1

1024x768

25

35.5x36.5x19

2.9

✖

✔/2W

✔

✔/✖

✖

✖

✖

30

D-Sub, Stereo pin

Power/D-sub

cable and power

adapter

2.25

2.5

3

3.25

2.75

2.75

2

3

4

3

3.75

3.125

3.25

3.25

3.25

3.75

3

0.5

2.5

152.5

137.5

2.5

55.19
6.15

37.79

11.25

16,000
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made the black background
look like a shade of grey. In the
17-inch category, except for the
Philips, all monitors returned a
crisp line.

This test is important for
those who use imaging software,
where accurate reproduction of
finer elements is important. 

Ghosting
The ghosting, or streaking, effect
is a major problem with LCD moni-
tors. Ghosting is basically the pres-
ence of light or dark shadows that
trail an image in areas where large
changes in intensity are present. It
is visible when images on the
screen move at a speed faster than

Philips 
150S

0.297

200

250:1

1024x768

50

38.7x37.5x18.3

5

✖

✖

✔

✖/✔

✖

✖

✖

27

D-Sub, Stereo pin

Quick setup guide,

Electronic user’s

guide on CD

2.875

3.75

4.5

4

4.5

3

3

3

4

2.5

4

3.875

3.875

3.75

3.875

3.125

3

0.75

2.75

145

127.5

4

62.86
5.31

43.16

14.40

12,500

PureView
PV 15C

0.297

250

300:1

1024x768

20

34.2x34.5x18.2

4.5

✖

✔/2

✖

✖/✔

✖

✖

✖

33

D-Sub, Stereo pin

NA

2.5

2.75

4.875

4.625

5

3.125

2.75

3.125

4

3.125

2.875

3

3.125

2.5

0.5

3.75

3

0.5

2.125

151

125

4

56.18
4.83

40.76

10.59

17,000

Samsung
SyncMaster 510N

0.297

250

450:1

1024x768

16

38.5x39.3x20.1

3.1

✖

✖

✔

✖/✔

✖

✖

✖

33

D-Sub

Quick setup guide,

Driver CD,

Calibrating software

3

3.5

5

4.875

4.875

3.25

3.625

3.5

4

3.5

3.375

3

3

3.125

2.625

4

3.25

0.5

2.75

152.5

137.5

4

62.14
6.05

44.09

12.00

15,000

S-Media
EY-15NB

0.297

250

400:1

1024x768

16

35x34x12.8

2.7

✖

✔

✔

✔/✖

✖

✖

✖

30

D-Sub, Stereo pin

Manual, Power/D-

sub/stereo cable,

Power adapter

2.25

2.5

4.25

4

4

2.75

3.25

3

4

3

3.75

3.375

3.5

3

3.25

3.25

2.5

0

2.75

150

137.5

4

60.54
7.29

40.39

12.86

14,000

Umax
MaxVision V5

0.297

250

400:1

1024x768

20

46x45x23.5

3.55

✖

✔/2

✔

✖/✔

✖

✖

✖

Na

D-Sub, Stereo pin

Quick setup guide,

Electronic user’s

guide on CD

2.375

3.625

5

5

5

3.5

3.25

3.5

4

3.75

3.875

3.375

3.25

3.125

3.25

3.75

3.5

0.5

2.75

150

127.5

4

62.05
6.08

44.72

11.25

16,000

ViewSonic
VE510b

0.297

250

400:1

1024x768

25

32.5x32.3x17

3

✖

✖

✔

✖/✔

✖

✖

✖

30

D-Sub

Quick start 

guide, CD

3.375

4

4.875

5

5

3.25

3.5

3.5

4

3.5

4

3.375

3.375

3.375

3.25

4

3.5

0.75

2.75

150

140

3.75

62.37
6.16

45.92

10.29

17,500

Winsonic
L1562S

0.297

300

400:1

1024x768

NA

36X34X18.3

NA

✖

✔

✔

✖/✔

✔

✖

✖

NA

D-Sub

NA

1.25

0.75

3.75

3.75

3.75

2.5

2.125

2.25

3.75

2.5

2.25

2

2

2.25

2

2.75

2.625

0.5

1.75

150

135

3.25

53.52
5.61

32.91

15.00

11999
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Scoreboard                             17-inch LCD Monitors
Acer
AL1714 sm

0.264

370

350:1

1280x1024

14

38.3x39.4x21.1

3.49

✖

✔/NA

✔

✖/✔

✖

✖

✖

51

D-Sub, Stereo Audio

Quick start guide,

electronic user

guide on CD

2.75

3.5

5

5

5

3.125

3.25

3.25

4

3.5

4.25

3.75

3.75

3.75

3.625

4.25

3

0.75

3

152.5

135

4

71.16
6.63

45.86

18.67

14,999

BenQ
FP783

0.264

300

500:1

1280 x 1024

12

38.7x39.8x25

5.2

✔/2

✖

✔

✔/✖

✖

✖

✖

60

D-Sub, DVI, USB,

Audio driver and

manual on CD, USB

camera

2.88

3.13

4.88

4.88

4.88

2.88

3.00

3.00

4.00

4.13

4.13

3.38

3.38

3.50

3.25

4.00

3.50

1.00

3.13

152.50

147.50

4.13

61.31
5.95

46.02

9.34

29,990

CMV
CT-712A

0.264

400

500:1

1280x1024

14

39.5x41.4x20.8

3.4

✖

✔/2

✔

✖/✔

✖

✖

✖

51

D-Sub, Stereo pin

Quick setup guide,

electronic user

guide on CD

3

3.75

5

4.75

4.25

2.25

3.625

3.625

4

2.625

4.25

3.25

3.25

3.25

3.25

3.625

3.5

0.75

2.875

150

132.5

4

67.17
6.60

44.10

16.47

17,000

HCL
HCM729LDA

0.264

250

450:1

1280x1024

25

38.2x39.8x23

5.9

✖

✔/2W

✔

✔/✔

11

✖

✖

45

D-Sub

User guide

3

4

4.5

4.5

4.5

3.25

3.75

3.75

4

3.5

4

3.75

3.75

3

3

3.75

2

1

3.25

152.5

132.5

4

60.09
4.20

44.68

11.20

24,990

BRAND
Model
Features
Pixel Pitch

Luminance (cd/m2)

Contrast ratio

Native resolution 

Response time (ms)

W x H x D (cm)

Weight (Kg)

USB hub (Y/N) / No. of ports

Inbuilt speakers (Y/N)/watts

VESA Wall Mount

Swivel base (angle) vertical/

horizontal axis

Height adjustment (cm)

Landscape/Portrait

Inbuilt TV tuner

Power consumption (W)

Input types

Bundled accessories (manuals,

colour profile, drivers, calibrat-

ing software…)

DISPLAYMATE VIDEO EDITION
Sharpness and resolution
Point shape and visibility

Video bandwidth test

Colour and greyscale
Streaking and ghosting

Bar streaking

Colour streaking

Mid-Range streaking

White-level shift

Black-level shift

RGB purity

Text colour combination

16-intensities levels

64 intensities for primary

colours

64-intensities for secondary

colours

256-intensities level

Colour scales

Miscellaneous tests
Reverse Video Contrast

Screen uniformity

Passmark Monitor Test
Pixel Persistance test (So5)

Miscellaneous tests
Movie Test (ghosting effect)

Viewable angle test (text)

Viewable angle test (Movie)

OSD usability test

OVERALL SCORE
Feature
Performance
Price Index
Price (Rs)

LG
Flatron L1730S

0.264

250

550:1

1280x1024

16

39.8x39.3x11.5

4.9

✖

✖

✔

✖/✔

✖

✖

✖

40

D-Sub

User guide,  

drivers, Colorific

software

2.75

4

5

4.75

5

3.25

3.5

3.875

4

3.75

3.75

3.25

3.25

3.25

3.125

4

2.75

0.75

2.5

155

132.5

4

62.07
6.76

44.94

10.37

27,000

NEC
MultiSync

LCD1770NXM

0.264

250

500:1

1280 x 1024

25

36 x 36.86 x 19.8

6.5

✔/4

✔/NA

✔

✔/✔

10.4

✖

✖

55

D-Sub, DVI-D

Speakers, D-Sub

cable

3

4

5

5

5

3

3.5

3.5

4

4

3.5

3

3

3

2.5

4

2.5

1

3

140

140

4

58.23
6.72

44.42

7.09

39,500

Philips
170S5FB/00

0.264

250

450:1

1280 x 1024

16

37.5x42.3x17.4

4.2

✖

✖

✔

✖/✔

10.4

✖

✖

55

D-Sub, DVI-D

D-Sub cable, power

cable, drivers CD 

2.75

2.5

3.75

3.75

4

2.875

3.875

3.625

4

4

4.5

3.75

4

4

4.25

4

4.25

1

1.5

127.5

147.5

3.25

65.69
6.09

44.86

14.74

19,000

MAY 2005MAY 2005

the pixels’ response time. This puts
undue strain on the eyes.

To check for ghosting, we ran
four different ghosting screens in
DisplayMate, and found that most
monitors returned good results, the
exception being the 15-inch AOpen
F1513, which displayed streaking in
the Colour Streaking screen.

In this test, the monitors
managed such good results

because they didn’t have to deal
with moving images. We there-
fore ran an additional test that
involved watching a movie clip
that showed fast-moving objects. 

In the 15-inch category, we
found the BenQ FP537s giving the
best results, with very little ghost-
ing visible. In the 17-inch cate-
gory, it was again the BenQ—the
FP731—which came out on top. 

Level Shift
Here, we looked for the white and
black level shifts, which happen
when two adjacent areas differ
greatly in contrast. In this test,
most 15-inch displays fared well
with very little level shift visible,
except for the AOpen F1513, where
the white level shift was evident.

Of the 17-inch monitors, the
BenQ FP783 did suffer from level

BenQ
FP731

0.264

260

450:1

1280 x 1024

25

37.5x37x15.5

4.2

✖

✖

✔

✔/✖

✖

✖

✖

45

D-Sub

Quick start

guide, driver and

manual on CD

2.625

3.125

5

5

4.75

2.875

3.125

3.375

4

3.625

4

3.375

3.375

3.5

3.5

4

4

0.75

2.75

155

140

4

64.59
5.83

45.58

13.18

21,250
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PureView
PV 17C

0.264

250

500:1

1280x1024

25

41.5x39x14

4.5

✖

✔/2

✔

✖/✔

✖

✖

✖

40

D-Sub, Stereo pin

User guide,  

drivers, Colorific

software

3

3.75

4.75

4.5

4.75

3.375

3.625

3.625

4

3

3.5

3.25

3.25

3.25

2.875

3.625

2.75

0.5

2.75

152.5

135

4.125

62.36
7.60

43.56

11.20

25,000

ViewSonic
VA712

0.264

380

350:1

1280x1024

8

38.6x41.1x17.7

4.3

✖

✔/1W

✔

✖/Y

✖

✖

✖

60

D-Sub, stereo pin

Quick start

guide, CD

3.75

4

5

5

4.375

3.25

3.625

3.625

4

4

4

3.5

3.625

3.5

3

4

2.875

0.75

2.5

155

145

4

64.04
5.40

46.19

12.44

22,500

Winsonic
L17X

0.264

300

400:1

1280x1024

NA

41X42.5X20.4

NA

✖

✔

✔

✖/✔

✔

✖

✖

NA

D-Sub

NA

2.75

3.25

2.5

2.5

2.5

1.5

1.5

1.5

2

1.75

2

1.75

1.75

1.5

1.75

2

0.75

0.25

0.75

75

75

1.5

63.10
4.78

41.85

16.47

16,999

shift, but not to the extent that it
could cause eye strain.

Level shift, if high, can be a
big problem in Photoshop-like
applications, where there are
often light and dark areas adja-
cent to each other.

Text-Colour Combination
In this test, we checked for a moni-
tors reproduced coloured fonts on
backgrounds of different colours. 

LCDs have red, green and blue
sub-pixels that make up a pixel.
When coloured text, say magenta,
is displayed on a grey background,
you can easily identify the black
space between two magenta dots,
making the font look serrated. 

Of the 15-inchers, the Umax
returned impressive overall
results—it had no problems with
magenta fonts. The CMV CT-529A
and the Winsonic L1562S, on the
other hand, returned poor results:
both yellow and magenta fonts
appeared like a collection of dots.

In the 17-inch category, it
was again the CMV CT-712A that
returned lower-than-average
results. The rest of the 17-inchers
fared pretty well too.

Intensity Levels
In this set of tests, we looked for
how well the LCD monitors could
display 16, 64 and 256 shades of
grey (these are the ranges that the
benchmark suites provide for).

The 64-Intensities test with
secondary colours, and the 256-
Intensities tests, are rather difficult
for LCD monitors—hardly any
monitor can display more than 64
shades correctly. In this, contrast
and brightness play an important
role, as an overly bright screen will
not display shades of grey in the
light region, and a dark screen will
merge shades on the darker side.

All the 15-inch monitors fared
well in the 16-Intensities and 64-
Intensities tests for primary
colours, except for a couple: the
Winsonic L1562S and the LG
L1530S merged a few levels on the
brighter and darker sides respec-

tively. In the 256-Intensities test,
the PureView PV 15C displayed
thick black and white bands (mean-
ing that it merged the shades) on
either side of the spectrum. This
can be a problem, especially while
watching movies, where dark
scenes will appear overly dark,
hence snuffing out the details.

The Winsonic L17X, in the 
17-inch category, scored low
compared to the others in this test.
This means that the user will need
to manually calibrate the monitor
for contrast and brightness rather
than relying on the auto setting.

Miscellaneous Tests

Screen Uniformity And
Reverse Video Contrast
In this test, coloured text on white
and two different shades of grey
was used. In the 15-inch category,
the S-Media was the only monitor

that suffered in screen unifor-
mity: it displayed several shades of
grey. The reverse video contrast
test was easy for all the 15-inchers;
they all passed it without much
variation in quality. 

Among the 17-inch monitors,
the Winsonic, HCL and NEC scored
lowest: there was clearly-visible
variation throughout, in the screen
uniformity test. The Philips 170s
returned solid results, with a very

Philips 170S5FB/00 NEC MultiSync LCD1770NXM
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consistent screen, corner-to-
corner. The reverse video contrast
test did not pose problems for any
of the 17-inch monitors. 

Passmark Monitor Test
We used the LCD pixel persistence
test in the Passmark monitor test
to check for the pixel persistence
problem with the panels. In this
test, a bright white block moves at
various speeds across the monitor,
ranging from 100 pixels/second to
800 pixels/second.

The entire set of monitors in
both categories failed to display
even the slowest moving block
without persistence—all of them
scored very low.

Our test results lead us to
believe that none of the LCDs we
tested are at a stage where they
could be considered good for
games or movies. If you’re
into gaming, you’re better off
with a CRT. If you want to
watch movies on an LCD panel,
don’t expect an exceptional
viewing experience.

Viewable Angle Test
Here, we used a text screen 
in DisplayMate, and a movie scene,
to find the maximum viewing
angle of each monitor. In the 15-
inch category, the HCL HCM
510LSA had the smallest viewing
angle in text and movie mode—137
and 122 degrees respectively. 

Most panels returned a higher
viewing angle in text mode—this
was because of the bright back-
ground. They suffered in the
movie test because the movie was
a mix of bright outdoors and
dimly-lit indoors scenes. The View-
Sonic VE510b reached 140 degrees
in the movie, which was highest
we saw in the 15-inch category.

In the 17-inch segment, the
Philips 170s managed only 127
degrees in the text test, whereas
the CMV, HCL and LG returned 132
degrees in the movie test. The
BenQ FP783 and the Philips 170S
managed 148 degrees, which was
the highest we saw.

Cost
The Acer AL1512 carries a price
tag of Rs 9,999 excluding taxes,
whereas the 17-inch Acer is avail-
able for as low as Rs 14,999, which
makes it cheaper than some of
the 15-inch models. There are still
brands such as NEC, which sell at
a premium—Rs 22,500 for the 15-
inch model, which is about Rs
5,000 more than other well-
known brands such as Philips,
ViewSonic and BenQ.

And The Winner Is…
If you take into consideration just
pure performance, the 15-inch
BenQ FP537s comes out tops. A
worthy mention where perform-
ance is concerned is the ViewSonic
VE510b. But neither of these moni-
tors could make it to the top
because of their price tags.

Price played an important role

in deciding our Gold winner,
which is the Acer AL1512. It fared
comparatively well in both
performance and features, but its
really low price—just Rs 9,999—
helped it edge pass models that
performed equally well. The 
CMV CT-529A, which is our Silver
winner, returned features and
performance scores similar to the
Acer, but is slightly higher priced.

In the 17-inch category
again, price played a major role
in deciding our winner, and the
Acer AL1714sm, with a price tag
of just Rs 14,999, won Gold.

Most of the other monitors
had similar features and per-
formance scores, but are priced
very differently. The Acer, which
is the cheapest 17-inch model,
retails for just Rs 14,999. This
makes it cheaper than many 15-
inch models, whereas the NEC
1770NXM is priced at a whop-
ping Rs 39,500. The kind of per-
formance that the NEC 1770NXM
and the BenQ FP783 gave was
similar to that of less expensive
models from other brands, and
at the same time, they did not
carry features that could justify
the high prices.

The Silver winner in the 17-
inch category is the CMV CT-
712A, which is very competitive-
ly priced at Rs 17,000.

To Buy Or Not To Buy…
LCDs have their pluses and their
minuses. We’ve mentioned the
main pluses. And they have their
cons too—movies and games are
CRT territory.

One reason LCDs are not suit-
able for games is that they’re fixed
resolution—so you end up either
playing your game in a small win-
dow, or with all the action
blurred. The fixed resolution can
be a problem in other areas as
well. As for movies, it depends.
Some of us really will not find
fault with the way movies look on
an LCD; some of us will.

Whether to go in for an LCD
monitor is something to think
about for a while. LCDs look good,
have flaunt value, and the image,
in general, is crisper than that on
a CRT. For popularity to grow, how-
ever, costs have to come down, the
nitty-gritties that persist have to
fade away and the user needs to
know that this makes the best
sense—for business or pleasure. So,
are you ready to go slim? 

aliasgar_pardawala@thinkdigit.com
jayesh_limaye@thinkdigit.com
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Acer AL1714sm CMV CT-712A

Telephone Web siteCompany E-mailBrand

Contact Sheet LCD Monitors

Acer
AOpen
BenQ
CMV
Digi-View
HCL
LG
NEC
Philips
PureView
Samsung
S-media
Umax
ViewSonic
Winsonic

Acer India Pvt Ltd
Xserve India Pvt Ltd
Benq India Pvt Ltd
Cee Vision Technologies Pvt Ltd
D-Link India Ltd
HCL Peripherals
LG Electronics India Pvt Ltd
Shiba Comp Pvt Ltd
Philips India Ltd
Pureview Technologies Pvt Ltd
Samsung India Electronics Ltd
Xserve India Pvt Ltd
Neoteric
Roop Technology Pvt Ltd
Winsonic Technologies

080-5219520-23
080-5113 1001
022-25705230
022-26733353
022-26526696
044-5200 6570
0120-2560900 
011-26413437
022-56912324
022-56633726
011-51511234
080-5113 1001
022-39828600
022-26680022
022-55969222

Rajesh_Aiyar@acer.co.in
info@xserves.com
SalesEnquiryIn@BenQ.com
chemoplastmumbai@vsnl.net
sales@dlink.co.in
kiruba@hclp.com
avarshney@lgezbuy.com
sales@shibacomp.com
pcp.india.info@philips.com
sales@pureviewindia.com
marketing@samsungindia.com
info@xserves.com
trajesh@neoteric.co.in
roop@vsnl.com
kavita@winsonicindia.com

www.acer.co.in
www.aopen.com
www.benq.co.in
www.cmv.com.tw
www.dlink.co.in
www.hclperipherals.com
www.lgezbuy.com
www.nec-mitsubishi.com
www.india.philips.com
www.pureviewindia.com
www.samsungindia.com
www.aopen.com
www.umax.com.tw
www.viewsonic.com
www.winsonicindia.com
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This isn’t very different in principle from
Internet message boards, or even Yahoo! Groups,
blog-rings help personalise the community—one
can know more about the person he or she is
communicating with, the simple reason being
that the writer’s thoughts and expressions are
recorded on his or her blog.

By Invitation Only
Then, Gmail happened. Gmail used the most
potent marketing gimmick ever—exclusivity—to
launch its much-hyped 1 GB mail account. Gmail
accounts, offered on a trial basis to select blog-
gers, pushed the ego button: they were available
‘by invitation only’, causing an online stampede
to secure invites—even spawning sites such as
gmailswap.com, where people made ludicrous
offers in exchange for Gmail invites.

Along with Gmail, Google launched their
social networking venture, Orkut
(www.orkut.com). Securing membership to
Orkut was, again, ‘by invitation only’. Orkut
shared space with other communities such as
Friendster (www.friendster.com), and business
networking site Ryze (www.ryze.com), which
also organises regular, paid offline events. These

Meera Vankipuram

Then: BBS, Usenet, IRC, Yahoo! Groups, IMs
Now: Orkut, Ryze, Wallop, Bebo, Friendster, Yahoo!
360o, Tribe, Hi5

hen blogs first hit the Internet a few
years ago, almost everyone viewed them
with suspicion and disdain: “Online

diaries? Who cares?”
A lot has changed since. Blogs have made

news—both good and bad. While blog-writing is
still a long way from being considered main-
stream journalism, some bloggers have managed
to bag lucrative book deals from publishing
houses. Several online organisations have even
instituted annual awards for the best blogs in
categories ranging from striking design to
thought-provoking content.

Blogs have also helped people across the
world connect, almost instantly, with people
they share interests with. By leaving notes or
comments on each other’s blogs, and being part
of blog-rings, people can now form micro-
communities on the Web. 
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Social
networking 
online can 
help your
business 
grow

Illustration Shyam Shriram

Your Café On The Web
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events—called Ryze Mixers—are popular with the
members of a particular group, and provide them
the opportunity to meet people, and develop
personal and professional relationships. 

Different Strokes For Different Folks
The recently-launched beta versions of Yahoo!
360o (http://360.yahoo.com/) and Microsoft’s
Wallop (www.mywallop.com) are the new
entrants in the social networking realm. 

Both let you store and share pictures and
music, and provide additional features such as
blogs, and the facility to send instant messages
via existing instant messenger clients such as
MSN, Yahoo! or AOL Messenger. Yahoo! 360o also
allows users to send personalised notes to their
Yahoo! 360o contacts, which the latter can view
on their home pages. 

Wallop’s Flash
interface is groovier
than the existing
networks. Apart from
providing a blogging
tool and a music
player, Wallop also lets
users set up an RSS
(Rich Site Summary or
Really Simple Syndica-
tion) feed—RSS is an
XML format for distri-
bution of news head-
lines on the Internet. 

RSS enables blog-
gers to share their
latest entries and
other news from across the Web.

Orkut’s personalised message boards are
popular among its users, but Orkut has had seri-
ous issues with speed, with members complain-
ing that pages “take forever” to load. [See box below]

Ryze (www.ryze.com) and LinkedIn
(www.linkedin.com) are more serious business

Digital Business l Smart Business

We asked our forum members what they thought of online communities.
Yahoo! Groups wins hands down, polling 44 per cent of the votes—out of,

umm, nine responses! Here’s what some of our members have to say.
Enoonmai: “I’ve been using Ryze for quite some time now, and find it very
good. I signed up for Yahoo! 360o recently. I doubt if Yahoo! 360 can take off
as a popular business networking site, but it might do quite well with
youngsters and those into semi-casual social networking.”
TuxiaN: “Well, Ryze is great. You develop contacts with a lot of important
people. Orkut sucks when it comes to speed… (and is) not that attractive.
Yahoo! 360o still needs to be evaluated...”
Deep: “I was on Orkut for a while. In the beginning, I found it pretty cool...
but that’s it. No one even cared to reply to messages after that... so it was

kind of bad. People signed up
there in all the excitement, but
no one cared to keep in touch.
It’s also way too slow.”
Din: “My college friends are
all in different parts of the
world now, but we’re
connected through mailing
lists and Yahoo! Groups.”
Link to Discussion Thread:
http://snipurl.com/dzn4

Digit Forum Votes For Yahoo! Groups

networking communities. With a clean, func-
tional interface, Ryze lets you import contacts
from your e-mail client. Members can add and
remove contacts as they like, and regulate the
amount of information that is disclosed
to each contact. 

LinkedIn is a ‘white-collar’ business network-
ing community, targeting executives at the
CEO/CTO level.  It enables companies find suitable
candidates, clients, partners and industry experts.
Members can invite and apply for job offers listed
on the site. Again, membership and referral is
strictly by invitation only.

Friendster (www.friendster.com), a global
networking community, categorises members by
personal details and geographic location. It
claims a membership of nearly over 13 million. 

Tribe (www.tribe.net) is a compilation of thou-
sands of moderated discussion threads on specific
topics, such as, cinema, music, and news. You can
post your profile and be part of numerous ‘tribes’,
or special-interest groups. 

Hi5 (www.hi5.com) is another popular
networking site. Hi5 also enables photo shar-
ing and blogging, along with RSS feeds, and
a message board.

Almost all these networking sites are still in
the beta or test stage, and need to resolve secu-
rity and speed issues. By ensuring that members
get to decide whom to invite into their
networks, theses sites attempt to avoid the entry
of online marketers and spam, to which several
Yahoo! Groups fall prey.

Six Degrees Of Separation
Social networks attempt to capitalise on the
‘Six Degrees of Separation’ theory, according 
to which, each human being is separated 
from another by no more than six degrees, or
six friends’ friends (or six clicks, in case of 
the Internet!)

Whether social networks help you find a
good companion, soul mate, life partner or busi-
ness associate depends largely on your attitude
towards online communities: be patient, don’t
expect miracles, and be honest while commu-
nicating with your online buddies.

After all, as Baz Luhrmann said in the
‘Sunscreen Song’, “Your choices are half chance.
So are everybody else’s”. 

meera_vankipuram@thinkdigit.com

LinkedIn is popular among top business executives  

Wallop’s ‘flashy’ interface offers various add-ons 
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Is Toll-Free 

“G enerally, we use our toll-free
numbers for pre-sales activity.
Customers call up to get detailed

information on our products. Toll-free
numbers are especially helpful for customers
who want to seek information prior to
purchasing a product. They call the number,
which is routed to our call centre in Mumbai.

“Since we also provide after sales support,
we have a different number for this, but this is
a charged number and the rates as per local
calls. The service provided on these calls is
more specialised. The person answering the
call identifies the problem and in most cases,
engineers personally go to the location to
resolve the issue. 

“I feel that the option of businesses having
toll-free numbers is a good one. It makes the
customer more confident when opting for a
product from the vendor.”

“P roviding support to customers is
quintessential for businesses. Now-a-
days, having a toll-free number is a

trend; every company has one. Besides,
customers expect support to be free of cost, so
it makes more sense to have a toll-free
number. Most customers use our products at
work and not every employee has STD facility
on their phone. So, in order to make it
convenient for such customers to reach us, it
makes sense to have a toll-free number which
can be accessed from anywhere. 

“However, we provide only a basic level of
support at the toll-free number. Higher-end
support is also given, but it is charged. We
have two toll-free numbers—calls are routed to
a call centre in the Philippines. Apart from
the toll-free numbers, customers can also
reach us through e-mail, all of which are
answered within 24 hours. Additionally, we
also provide online support.”

Sandeep Mehrotra
Sales Manager, Adobe
Systems India Private Ltd

Devita Saraf
Executive Director,
Marketing, Zenith
Computers 
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Almost every company, irrespective of what they are selling, has a toll-free number that can be
used by the consumer for making inquiries or complaints. Is this the future of customer service?
We spoke with a few computer and related companies that offer this service
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Alok Bharadwaj
VP, Canon India Private
Limited

M Vinayagamurthy
Country Manager,
Consumer Support,
Hewlett Packard 

Ruchika Batra
General Manager,
Corporate
Communications, Samsung
India

“We have set up a national call centre facility to provide
pre- and post-sales support to customers. It’s extremely
convenient for customers as they can call that number

from any part of the country and need to only pay local call charges.
The call centre is a single point of contact for Canon’s customers and
plays a critical role in driving business growth and customer
satisfaction. 

“We respond to each and every customer query without
exception. We also have a feedback mechanism wherein we try to see
how satisfactorily the customer’s problem was resolved.  

“Customer Delight is Canon’s theme for this year. For instance,
for our copier customers we have launched 24 x 7 service facility for
service support. This type of facility is well appreciated in the
changing business environment where working hours differ from the
conventional 9 to 5 routine.”

E-mail: preethi_chamikutty@thinkdigit.com

The Way To Be
“Y es, at HP, we do have a toll-free number for customers. There

are different phone numbers for different business segments,
such as, pre- and post-sales support for the consumer, and

commercial and enterprise customers. Pre-sales queries are largely
related to price, specifications, availability, taxes and warranty. Post-
sales queries are about product usage. But the number is bound by
timings. For instance, the toll-free number for consumers is six days a
week from 9 am to 9 pm, but callers can reach the toll-free number for
the commercial call centre five days a week from 9 am to 5 pm, in
accordance with the timings of corporate customers.

“Some calls are routed to the call centre while others are handled by
professionals. Our call centre executives are well-trained and undergo
rigorous training on product, technical specifications and other details.
They are also constantly updated on the new models we introduce. 

“It’s beneficial for businesses to have toll-free numbers—it’s
certainly the fastest way a customer can reach HP. The caller doesn’t
pay for the call. Moreover, it’s cost-effective for us, as we can handle a
large volume of queries efficiently. Toll-free numbers can offer instant
solutions to issues.”
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“W e provide a single toll-free number that caters to the
entire country. Customers can seek support for
consumer electronics, home appliances, IT and telecom-

related queries. We have a dedicated team that answers calls routed to
our call centre. 

“The queries are varied and deal with installations, technical
issues, product features, services or demonstration requests. Basically,
customer calls are divided into three tiers—the first handles queries
related to product features and general inquires; the second comprises
technicians who handle queries that could not be answered by the first
tier, and finally, the third comprises managerial level individuals who
may handle queries that are not resolved by the first two tiers.

“We believe in servicing customers at all times. Every year, we
conduct an annual free service camp where customers can come and
seek support. It is during this time that our call centre receives the
maximum number of calls.”
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Renuka Rane

Devarapalli, Koyyalagudem
and Jangareddygudem are
tongue twisters, and one

look at the scenery around these
villages would make you wonder
if they could have any other
claim to fame. They are located
deep in the interiors of Andhra
Pradesh, and are dotted with
lush green tobacco fields. The
Telugu-speaking inhabitants are,
by and large, tobacco cultivators. 

The villages act as hub
points for tobacco trading. They
actually constitute four auction
platforms  for tobacco under
the Northern Light Soil
(NLS) category of the
agro-climatic zone in

Andhra Pradesh. The entire area
has more than 6,000 farmers
registered with the Tobacco
Board, Ministry of Commerce,
Government of India. Hundreds
of these tobacco farmers can
now claim to be ATM-savvy,
courtesy ICICI Bank’s Kisan
Loan Card scheme. This, then, is
their claim to fame…

ICICI’s Eye For Progress 
While a majority of companies
try to appease the all-important
global consumer, ICICI Bank
modified its loan offering to
cater to one specific user group,
in this case, the tobacco cultiva-

tors of Andhra Pradesh. 
In September 2004,

ICICI Bank launched
the ‘Kisan Loan Card’

Technology Beyond WorkReturn My
VideoRobot Races112 148

Leisure
Digital

in Devarapalli in association with
the Tobacco Board. Along with it,
ICICI Bank also inaugurated four
India-specific ‘Asan’ ATMs (manu-
factured by NCR Corporation) in
Devarapalli, Koyyalagudem and
Jangareddygudem. A pilot project
by the bank, it involves the dis-
bursing of cash and crop loans to
farmers who are registered with
the Tobacco Board. 

Brahmananda Hegde, deputy
general manager, ICICI Bank,

Touched By Tech
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Agri-loans Made Asan
The installation of ATMs in rural Andhra Pradesh has made the disbursing and accessing of
loans easier for the native tobacco farmers



says, “We installed four innova-
tive, low-cost ATMs designed
specifically in Andhra Pradesh.
This has protected our invest-
ment in rural areas, which  have
lower transaction volumes.”

The Kisan Loan Card
Using the Kisan Loan Card, the
tobacco farmers in Andhra
Pradesh were able to avail of
loans using an electronic card
with easy access to withdrawal
of cash through ATMs. 

Of the 2,200 applicants for
the Kisan Loan Card till date,
1,763 farmers who own 2,066
tobacco barns—30 per cent of
all barns in the NLS area— are
using the loan card.

A bank account that allows
ATM use is increasingly becom-
ing a preferred option with
users. The tobacco farmers need
only have a loan account with
ICICI Bank to get ATM access. 

In addition to the cash loan
through the card, farmers can
also receive crop loans to
procure fertilisers, seeds, pesti-
cides, and diesel, among other
agricultural supplies. 

Hegde adds, “The Asan ATMs
give farmers access to money 24
hours a day through cash with-
drawals as against withdrawing
from the local brick-and-mortar
setups, and reduce third-party
involvement. Through Asan, we

can extend self-service banking
to rural masses sans the huge
operational costs, the benefit
of which can be given to farm-
ers in the forms of subsidised
interest rates.” 

Why NCR? 
Deepak Chandnani, managing
director, NCR India, says, “NCR
India spoke to various banks
about their needs before
beginning their India-specific
projects. We carried out a
survey of ATM users through
the Industrial Design Centre of
IIT-Mumbai. Asan is a result
of the work done by the NCR
R&D teams abroad and in India
with IIT-Mumbai.”

As a matter of fact, NCR was
named the winner in the Self-
Service category of The Banker
Technology Awards 2004 (insti-
tuted by the UK-based finance
publication The Banker) for
its EasyPoint 57i machine,
the one deployed in Andhra
Pradesh as Asan.

Easy Does It! 
Asan has a physical appearance
and user interface designed to
appeal to Indian consumers. A
rugged machine, Asan provides
convenience shelves—something
we would like to see in our
urban ATMs. 

It supports wireless connec-
tivity through GPRS and CDMA,
suitable for areas with inade-
quate telecommunications. Asan’s
enhanced dust filtration mecha-
nism facilitates deployment in
non-air-conditioned areas.  

Moreover, Asan’s NCR Intelli-
gent Power Management (NIPM)
system, comes with an integrated
UPS, which ensures the ATM
completes an ongoing transac-
tion before shutting down in case
of a power failure.

Loan Dilemma No More
S Karthikeyan, manager, Agri
business, ICICI Bank, has been
associated with the Kisan Loan
Card project since its inception,
and has interacted with farmers
on field. He says, “Earlier, land
or other assets had to be mort-
gaged to procure loans through
banks; however, to get the Kisan
Loan Card, farmers don’t have
to make any mortgage pay-
ments at all. 

“This eliminates mortgage-
related documentation and
saves time and effort for both
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parties. While other banks
charge a slab-wise interest rate,
ICICI charges a flat rate of seven
per cent simple interest per
annum, irrespective of the
amount of loan.” 

Karthikeyan continues, “Five
acres of cultivated tobacco
equals one barn. Under the Kisan
Loan card scheme, the scale of
finance is fixed at Rs one lakh
per barn of tobacco owned by the
farmer. So, even if a farmer has
half a barn, he is assured of a
loan of Rs 50,000.” 

In rural banks, loans are
distributed at the discretion of
the bank manager, and a speci-
fied amount must be withdrawn
at one go. In contrast, with the
Kisan Loan Card, farmers can
withdraw the amount they need
periodically through Asan. 

Easy Get, Easy Repay 
While disbursing of a loan is
made easy through Asan, repay-
ing it, too, has been made easier.
Farmers repay the loan using
the cash flow generated through
the sale of cultivated tobacco. 

Karthikeyan explains further,
“Tobacco being a regulated  crop,
the final produce can be sold
only by auction. For instance, the
FCV (Flue Cured Virginia) variety
can only be sold by the auction-
eer—the Tobacco Board—through
an open auction. 

“Altogether, one crop of the
NLS FCV variety is sold in
eight instalments to various
buyers including ITC Limited,
Godfrey Philips, Transcontinen-
tal and other local traders who
export most of the tobacco. They
pay the Tobacco board, which
pays ICICI, which in turn clears
part of the debt and remits the
remaining amount to the
farmer,” adds Karthikeyan.

Promise For The Future
This transparency in operation
acts towards building trust and
encourages other tobacco farm-
ers to take advantage of the
scheme. Whether farmers want
to buy a new farm or bore a
well—the low cost loans and
easy availability of credit suits
their needs perfectly. 

By leveraging technology,
this innovative banking solu-
tion of disbursing credit will, in
all probability, eliminate any
vestiges of the Shylock way of
lending money in rural India. 

renuka_rane@thinkdigit.com

The Asan ATM takes up less space than
conventional ATMs, and also has
convenience shelves 

The Asan
ATMs give
farmers 
24-hour
access 
to cash
withdrawals,
and reduce
third party
involvement
Brahmananda
Hegde  
Deputy General
Manager, 
ICICI Bank 
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Watching movies or listening to music is no fun without a good set of
speakers to complete the experience. So listen up!
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Varun Dubey

H
ot: “5.1”. Not: “300 W
PMPO”! Gone are the
days when the typical
home or personal sound

setup consisted of a home-made
Videocon or Philips mini stereo
system. Also gone are the days
when we were satisfied with the
sound that those systems deliv-
ered. We want—in fact, demand—
good speakers these days.

For a wholesome aural expe-
rience when listening to music,
playing a DVD or screeching off
the start line when playing NFS
Underground2, you need a sound
system that does not just drum
out the beats, but enhances
the listening experience by
putting you smack in the middle
of the action!

The problem, of course, is that
there’s such a range out there—
and they are all good—that apart
from word of mouth, we have
very little to go by when we
decide to get a good speaker set.
Hence this comparison.

Read on and find out which
one of these aural delights will
satisfy your craving for the ulti-
mate audio experience!

A Nomenclature Primer
First off, what does ‘2.1’ or ‘4.1’
mean? This nomenclature denotes
the number of satellites and
subwoofers. So in a 4.1, you would
have four satellite speakers and one
subwoofer. Similarly, in a 5.1, you
would have five satellites—three in
front of you and two behind you—
along with a subwoofer.

Two’s Company (2.1)
Because the prices of 5.1 and 4.1
speaker sets are tumbling, irre-
spective of VAT, we decided to
compare only the absolute top of
the line 2.1 sets available. So we
had the Creative Mega Works THX
250D, Harman/Kardon Sound-
sticks II, JBL Creature II, and of
course, the Bose Companion 3.

The feature list here wasn’t
exactly exhaustive, with JBL and
Harman/Kardon not even bother-
ing to put in remotes. The Bose
Companion 3 comes with a wired

circular remote that lets you
adjust the volume and also mute
the output. The Creative remote
had the most features, it let us
control volume and bass, and
also had a power button.

Compared to the Bose set, the
build quality of the Creative
speakers was just OK—nothing
you would hang in an art gallery,
but sturdy. The JBL Creature II
speakers looked like something
straight out of Independence Day,
and were built with material that
looked rather cheap, especially
the chrome plating.

The Harman/Kardons were
made of glass. The construction
quality was really good, and we
thought the speakers were neat!

Looks and build quality apart,
what really matters, of course, is
how these babies perform—so we
put them through their paces
one by one.

Let The Tests Begin!
We started with our bass and
treble tests, where the king and

Our test PC was an AMD Athlon 64 FX 53 with 1 GB of Corsair
dual-channel DDR RAM. The sound card was a Creative Audigy

2 Platinum, and the hard disk, a 120 GB SATA.
We put the speakers through an exhaustive test process,

including multiple music-specific tests, a Game Test, and of
course, a Movie Test.

The Game Test consisted of running the d3_c17_12 demo—a
benchmark—with all the audio settings set to maximum quality.
For the DVD Movie Test, we used the Fast and Furious clip from
our DTS sampler. 

The DTS sampler disk is a widely-used disk for demonstrating
home theatre system capabilities. It contains very high-quality
songs and movie clips in 5.1 surround sound format.

On the music front, the process was divided into CD Audio,
MP3 and DVD Audio. The CD and MP3 tests were further divided
into English and Hindi, which were then divided into instrumental
tracks and vocal-specific tracks. 

The DVD audio was rated on bass, treble, and vocal
reproduction based on a DTS sampler disk. The songs we used
were Eric Clapton’s Broken Hearted and Sheila Nicholas’s Faith.

For the English Audio CD Test, the vocal-specific track we used
was I’m Ready by Bryan Adams; this was chosen because there is
very little electronic equipment used in the song, and was
performed live. The instrumental track we used was Sadness I by
Enigma, because of the variety of instruments the song uses.

In the Hindi Audio CD test, we used a rendition by Pandit
Bhimsen Joshi for the vocals, and Pandit Ravi Shankar’s Sitar
recital for the instrumental test.

In the MP3 test, the tests were performed just as above, with
Dido’s Don’t Leave Home being used for the English vocals and
Sadness I by Enigma for the instrumental music test.

In the Hindi Music test, we used the song Mitwa from Lagaan,
and Strings’ Anjaane Kyon for the vocals and instrumental tests
respectively. All MP3 files were encoded at 192 Kbps.

Apart from these, we also tested the speakers by playing
specific frequency files, from as low a range as 30 Hz all the
way to 15 KHz.

We then specifically tested the bass and treble strengths of
the audio systems at various volume levels using THX-certified
bass and treble files.

How We Tested

A new breed of speakers out there is bringing out the
audiophile in every one of us. Which one will you buy?

Believe Everything 
You Hear!

Harman Kardon Soundsticks II (2.1)
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emperor was the Bose set—you
really need to hear them to
believe it. The speakers are down-
right tiny, but the depth and
punch of the bass simply blew us
away! No matter what file or
what frequency we threw at it,
the speakers just stood there
smugly and played it with
absolute perfection! There wasn’t
even a hint of distortion at even
the highest volumes, a feat that
even our high-end 5.1 systems
could not manage. 

The Harman/Kardon (H/K) set
did the worst in these tests, and
due to their peculiar design, the
bass started sounding a bit raspy
if we increased the volume
beyond 50 per cent. The only
other speaker that did commend-
ably well here was the Creative
Megaworks THX. It could
produce clean distortion-free
bass at nearly 80 per cent of the
volume level.

We then ran our Half-Life 2
game test and yet again, the 
Bose came out tops with
absolutely unbelievable clarity.
We could hear every bombshell
exploding, and each bullet being
fired—but what really set this
speaker system apart was
another unmatched feat: despite
all the chaos that was happen-

ing, we could distinctly hear
everything that was being
spoken in the game. Each and
every syllable! 

The JBL and H/K tied for
second spot, and the Creative did
rather badly—we heard a lot of in-
game distortion, and most
dialogues were lost. As expected,

the Bose beat the rest comfort-
ably in the movie test, and The
Fast and the Furious came alive
with the car chases, gun        shots
and what not! 

This time, the JBL marginally
edged out the others for second

spot, with the Creative third and
the H/K a distant fourth.

We couldn’t wait to get to our
music tests. We were in for a
shock, though—the Bose refused
to live up to our expectations,
especially in the Audio CD instru-
mental track. Sure, it was still one
of the best speakers, but at high
volumes, the sound was getting a
bit too tinny for our tastes, and for
the first time, we felt the satellites
weren’t complementing the
wonderful subwoofer (Acousti-
mass, as Bose calls it).

The Creative and the Bose tied
for top spot here, with JBL second
and the H/K a distant third. 

In the vocals test, however,
both Hindi and English, using the
audio CD, MP3s or the DVD, the
clarity of the Bose was unmatched,
and it decimated the opposition
with ease. JBL came in second and
Creative third, while the H/K
brought up the rear.

And The Winner Is…
This was quite simply a fight for
second place. The Bose was the
outright winner, with the JBL
Creature II coming in second.

If you are a performance
junkie or an audiophile, and if
money is no object, you can’t do
any better than the Bose. 

Root Mean Square (RMS): The
sustained power in watts that an
amplifier can output at any given time.
Peak Music Power Output (PMPO): The
maximum power that an amplifier can
output over a short period of time.
Frequency Response: The range of
frequencies that the device is set to
operate within.
Dolby Digital 5.1 (Dolby AC-3):
Developed by Dolby, this system has five
discrete sound channels in addition to
Low Frequency Effects (LFE) that are
directed to the subwoofer. 
Dolby Pro Logic: An older standard, this
packs in information for a centre and
surround channel in the regular stereo
channel. Essentially, there are no
discrete left and right channels for the
rear or surround speakers.
Dolby Pro Logic II: Audio encoded with
Pro Logic II carries five channels of
sound in a traditional two-channel
stereo audio signal, which is then
decoded back to five speakers using a
Dolby Surround Pro Logic II decoder.
This technology can be used on any
console that does not support Dolby
Digital 5.1. The advantages of using it in

game applications include minimal latency,
full frequency range, compatibility with
existing cables, and backwards
compatibility with mono, stereo and legacy
Dolby Surround Pro Logic equipment.
DTS: Short for Digital Theatre Systems,
this is a standard invented by Steven
Speilberg, and made its debut in Jurassic
Park. It uses a sampling frequency of 96
KHz with 24 bits allocated to each of the
six channels. Collector’s edition DVD
movies normally feature two soundtracks
featuring both Dolby 5.1, and DTS.
Dolby Digital EX and DTS ES: These are
comparatively new standards that add
an additional channel—the rear centre
channel—and is implemented in 6.1
speakers. Both standards implement the
rear channel in a similar way. For Dolby
Digital EX, a special Dolby Pro Logic
decoder is added to the surround
channels, creating a rear centre channel.
This decoding method first came to light
with the theatrical release of Star Wars
Episode 1. For DTS ES, an additional rear
centre channel is supplemented to the
two surround channels.
Dolby Pro Logic IIx: This is a spanking-
new technology developed by Dolby

Laboratories and is the first and only
technology to process native stereo or
5.1 signals into 6.1 or 7.1 channel output.
Different modes such as Movie, Music
and Game are available with this
technology, with the Music mode
featuring additional user controls such
as Dolby centre width, Dolby panorama,
and Dolby dimension.
THX: This is an abbreviation for
‘Tomlinson Holman’s eXperiment’. It’s
not a surround sound standard, but a
seal of approval that is granted to audio
equipment and theatres that meet its
standards. This standard is further
divided into THX Select (for installations
up to 2000 cubic feet) and THX Ultra (for
between 2000 ands 3000 cubic feet). 
S/PDIF: Sony/Philips Digital Interface;
a standard audio file transfer format.
Developed jointly by Sony and Philips
corporations, S/PDIF allows the transfer
of digital audio signals from one device
to another without having to be
converted first to an analogue
format. Maintaining the viability of a
digital signal prevents the quality of the
signal from degrading when it is
converted to analogue.

Jargon Buster

MAY 2005

Bose Companion 3 (2.1)
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But, for those on budgets who
want excellent value for money,
and don’t really care if their
speakers look like they’re manu-
factured on Venus, buy the JBL
Creature II. The set costs Rs 6500—
just about a third of the price
of the Bose.

Quadraphonic Sound (4.1)
This category is for people who
want surround sound, which is,
of course, not possible with a 2.1
system. The products we tested
here were again the premium sets
from Altec Lansing—the 641 and
the AVS 500B—and the Creative
Inspire 4400, as well as the Cyber
Acoustic CA4100.

Straight out of the box, the
speakers were beginning to look
impressive, until we took out the
Altec Lansing AVS 500B. This set
was so unbearably bad-looking
that we wanted to drop it—from
the test, that is! The build qual-
ity was just abysmal—the rear
of the woofer looks like it is
made of plywood!

The speaker didn’t perform
any better than it looked either,
and this was a shocker, as Altec
Lansing is generally known for

volume. The Creative only offered
bass and volume.

Sounding Them Out!
As always, we started out with
our bass and treble power tests.
The Altec Lansing 641 aced
them. Housing dual drivers in 
its massive woofer case, this
speaker set decimated the 
opposition. It has a massive 109-
watt subwoofer, as compared to
the meagre 14-watt and 17-watt
ones of the Altec Lansing AVS
500B, the Creative Inspire 4400,
and the Cyber Acoustic CA4100. 

The Altec Lansing 641 topped
all our bass and treble tests,
followed by the Creative Inspire,
with the Altec Lansing AVS 500B
coming in third and the Cyber
Acoustics last.

In our DVD audio tests, 
the Altec Lansing 641 was again
in a league of its own, scoring
nearly twice as much as the
nearest competitor, the Creative
Inspire 4400. 

The Cyber Acoustic comfort-
ably beat the AVS500B in all DVD
audio tests except for the vocals,
where Eric Clapton sounded flat
and hollow. This trend was repli-
cated in all our music tests. The
641 was miles ahead, and left the
Creative Inspire 4400 with the
title ‘best of the rest’. 

The speaker that shone some-
what here was the Cyber Acoustic
CA4100. It managed to equal or
beat the Altec Lansing AVS 500B
in every music test. The voice clar-
ity of the Altec Lansing 641 was
simply outstanding, with every
tremor in Dido’s voice being
reproduced with aplomb.

What we really liked about
the Altec Lansing 641 was that
even at high volumes, the
speaker never sounded like it was
going beyond its capabilities. To
be fair, though, it did succumb 
at the maximum volume level.

We then popped in our DTS
sampler disk and ran our movie
test. With the 641, we could hear
every groan and creak of the cars,
every tyre squeal and every rev of
the engine as they raced along the
massive truck. The Creative, with
its good bass reproduction and
clarity sounded good too, but was
no match for the Altec Lansing 641.

The Winner Is…
Despite significant weightage
being given to price, we still had
to concede that the Altec Lans-
ing 641 was the clear winner. It

high-quality products. The other
Altec Lansing, the 641, however,
looked as sturdy as a tank. 

The Creative speakers also
had decent build quality, and
the Cyber Acoustic set was just
plain ordinary. But the Altec
Lansing 641 was simply in a
league of its own!

In terms of features, none of
these had Digital Input, SPDIF or
coaxial inputs. Only the Creative
and the Altec Lansing 641 came
with remotes—both wired. The
Altec Lansing 641 remote was the
most comprehensive, with
controls for surround,
treble, bass and

Creative Inspire 4400 (4.1)

To understand how
speakers work, you need

to first understand how
sound works. At the very
basic level, an object
produces sound by vibrating
the air particles around it.
These in turn vibrate those
next to them, and so on, until
the sound reaches you.

The speaker translates
electrical signals into sound
by creating the requisite
vibrations. Depending on the
accuracy of the vibrations that are
produced, we classify the speakers
as good or bad!

The sound from a speaker is
produced using one or more drivers.
The driver produces sound by
vibrating a diaphragm.

The diaphragm, which is conical
in shape, can be made up of plastic,
metal, and even paper! In fact, you
can make basic (but bad-sounding)
speakers from everyday chart paper!

The narrow end of the
diaphragm is then connected to
something called the voice coil. This
coil is then placed in the magnetic
field of a permanent magnet.

When you pass a current
through this coil, it turns into an
electric magnet, and will have the
properties of a regular magnet—but
unlike a regular magnet, on
reversing the flow of current, the
polarity of the magnet changes. 

Now when we alternate the
current flow in the coil, it keeps
changing the magnetic forces
between the coil and the permanent
magnet. This moves the coil back
and forth—due to attraction and
repulsion—and moves the
diaphragm along with it. 

This movement of the speaker
cone vibrates the air around it
leading to sound production. 

How Speakers Work
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has excellent bass reproduction
and extremely good treble. The
clarity is unmatched in this
class, and if you have the dough,
this is the way to go! The dark
horse here was the Cyber
Acoustic CA4100. 

Compared to the 641, it was
quite simply outclassed, but you
must also remember that for the
price of the 641, you can get a

really good 5.1! So to be fair to the
Cyber Acoustic, it did a very
commendable job for the right
price, to come in second.

The Creative, on the other
hand, paled in comparison to the
Altec Lansing, and was also quite
clearly beaten by the Cyber
Acoustic in terms of price versus
performance. But it is still a fairly
good buy at Rs 3,290—especially
when compared to the 641’s price
tag of Rs 20,000!

The Real Thing: 5.1
If you are positively appalled at the
notion of pseudo-surround at 4.1,
and will settle for nothing but the
real thing, then 5.1 systems are for
you! We sounded out a whopping
20 systems in this category.

Out Of The Box
This was the category where we
expected to see speakers crammed
with features and to be of top-
notch quality, both in terms of
build quality as well as sound
reproduction, and most manufac-
turers did come through.

Almost all the speakers lacked
multiple input types, and mostly
came with the regular 5.1 input
along with auxiliary and stereo
inputs. Very few had digital inputs,
whether optical or coaxial, except
for the Altec Lansing BS 3151R,
which had a digital DIN. None of
the speakers had S/PDIF input.

Almost all these speakers came
with a remote control, either wired
or wireless; the exceptions were
the Altec Lansing 251, Jazz and
Mercury. None of the speakers
came with an inbuilt FM tuner,
either; again, this could have been
a useful addition.

The process of setting up the
speakers was more or less iden-
tical with all the brands, except
for the Logitech and Philips
speakers, which used coulour-
coded wires making installation
even easier.

The other type of speakers, in
terms of setup, came with raw
wires and clamps—no plugs, noth-

ing. You need to
open the clamp,
and put in the
wires with care so
that the clamp
and connector is
actually touching
the metal inside
and not the
wire insulation.

But actually,
wires of this

type are better than the ones
provided by Philips or Logitech,
since the sound quality of speak-
ers is very much dependent on
the wires (they carry the sound,
remember?). It can sometimes
make sense to go for a higher
quality wire than the one
provided, and thus enhance the
listening experience.

An additional benefit is that if
you need to extend the wire or
replace a broken one, it is far easier
to do it with this kind of wire.

The weirdest systems to set up
were the Mercury systems. On
connecting and calibrating the
systems, we realised that the
colour coding at the back of the
subwoofer was mixed up, so we
spent some agonising minutes
trying to figure out which wire
went where—a wholly unneces-
sary excercise, since colour
coding is supposed to make 
the task easier!

We got very varied designs in
terms of speakers. The snazziest
looking were the Artis S7100.
These tall, slim speakers with glass
bases are what you put in your
house if you are looking for
elegance and class. 

The Creatives looked rather
plain in comparison to most of
the others, and continued to
carry their usual design. The
Logitech Z5300 looked to be on
track with Logitech’s design

1 col Ad
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ideology: make it look sleek,
futuristic and sexy as hell!

On opening the Artis X10 box,
we were greeted with some really
sturdy and top-quality speakers.
We were really impressed with
the quality metal stands and the
woofer. The design, however,
seemed to be inspired by Bose. 

An interesting entry was the
Jazz mini home theatre. This is
a tiny system. It isn’t fair to
compare this system with the
biggies we had, but even
by itself, the sound
quality was pretty poor,
and got extremely tinny
even at mid-volume
levels. We didn’t have
any great expectations
from the extremely
small bass unit, and as
it turned out, it
produced less bass than
the satellites did!

Another really jazzy
looking system was the
Soomoku 5.1. The satel-
lites and the woofer
were made of shining
brown wood, but the woofer had
a rather cheap- looking pseudo-
metallic finish. The woofer had a
nice LCD for various operations,
but made the entire system look a
little too loud. 

We also had a set of Hyundai
speakers. One look at these and
we knew that Hyundai kept
compactness only to the Santro
(Xing or otherwise). Put
together, these huge speakers

could probably measure up to a
Hyundai Santro!

Put Your Money Where
The Sound Is!
The test process used for the 5.1
systems was exactly the same as
for the previous systems. As

usual, we started with our bass
tests, and plugged in the Creative
5.1 system first. 

This was the single most
devastating thing we could have
done for the other speakers,
because there was simply no
match for the depth and punch of
the Creative 5.1 MegaWorks.

The second in this category
was the Philips A 3.610, followed
closely by the Artis X10. The

main reason that the Artis X10
lost out was that at high
volumes—beyond 90 per cent—
there was extreme distortion
in the bass. 

The Creative Inspire 5200
came in a commendable fourth,
considering it costs just a third
of the abovementioned speakers.

These results were, however,
not entirely replicated in our indi-
vidual frequency tests. The Artis
X10 edged out everybody else in
the 30 Hz test, with the Philips
A3.610 a close second, followed by
the Creative MegaWorks. 

In the 50 Hz test, Philips was
head and shoulders above the
rest, with the MegaWorks coming
in second, followed by the X10. It
kept rotating back and forth
between these speakers for the
remaining frequencies, but the
fight was mostly between the
Artis X10 and the Creative Mega-
works 5.1 THX.

We then popped in our DTS
sampler disk and heard Eric Clap-
ton and Sheila Nicholas crooning
their hearts out.

The Altec Lansing BS3151R
thrashed almost all the other
speakers comfortably, and beat
everyone to the top slot. The
sound from this speaker set was
extremely impressive considering
the size and price. 

The Philips 3.610 tied for the
second slot with the Creative
MegaWorks 5.1.

Both provided excellent blend
of bass depth and vocals. At no
time did we feel that the bass was
overpowering the satellite sound
or that the bass was too timid. 

In the case of the Mega-
Works, it seemed that the bass
had just no limits! It went on
without too much trouble at
higher and higher volumes, and
the Philips 3.610 pretty much
kept up all the way, until both
the speakers’ satellites began to
crackle slightly. 

The third place was jointly
held by the Creative PC works
LX520 and the Soomoku 5.1. 

We found that at higher
volumes, the Soomoku’s bass
tended to be slightly weak,
whereas in the Creative PC
Works, the bass gave up when
the volume was turned all 
the way up. The loser here, and
by a fairly large margin, was the
Artis X10. It was comprehen-
sively beaten by all the above
speakers, as well as by the
Creative Inspire 5200.

Soomoku 5.1 (5.1)

The lone ranger in the 6.1 category,
the speaker has a very decent set

of features, though we do wish it had
a few more controls on the remote,
akin to the Logitech Z5300, which
lets you control everything you can
think of!

The setup was fairly straight-
forward (you start feeling that way
after installing and un-installing 25
odd speaker systems!). The bass was
trademark creative-the thumping of
bomb explosions will have you
running for cover. In fact, the bass is
so powerful that it made CDs and
other assorted items lying on our
desks vibrate! The overall audio
experience of these speakers was
extremely impressive, though not
quite exceptional.

The movie surround experience
and sound clarity was really good,
and when watching a clip where

glass shatters, we could make out
where every little piece of shattered
glass fell. 

In the music department, these
speakers gave us really good
results so long as there were only a
few instruments and a little
electronic mixing, but once we
started running the Enigma songs,
we found these speakers to be
slightly low in clarity and individual
sound reproduction. Also, the
speakers had trouble reproducing
the lower frequencies. The low
frequency reproduction was better
at lower volumes, but then you
want your music loud, don’t you?

We don’t mean to imply that
these speakers are bad, but we are
saying that they could have been
better. Then again, for just Rs 7,500,
they are a steal for those who want a
budgeted 6.1 audio experience.

Creative 6.1 6600
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The rear in this test was
brought up by—apart from the
Jazz mini home theatre—the
Mercury HT 5800, which came
very close to the performance of
Artis S7100—the slim, elegant
and expensive-looking speakers.
“Never judge a book
by its cover” never
sounded truer! 

In our audio CD tests,
however, the Artis X10 fought
back—and with gusto! It
comfortably beat all the other
speakers or tied with them 
for the first spot, except for 
in the Hindi Instrumental 
Audio CD test, where, surpris-
ingly, it lost out in a big way to
the Hyundai, Altec Lansing
BS3151R and Creative Inspire
5200. As a matter of fact, it came
in fourth, after the second-
placed Creative MegaWorks and
Soomoku 5.1 systems.

We then came to our DVD
movie test. This was the first test
where we were going to hear the
sound in real 5.1 surround, so we
fell over each other to get the
best seats!

Here, the Artis X10 was not
alone at the top spot; the
Creative Inspire 5200 tied with it
and marginally beat the Creative
5.1 MegaWorks. The Philips
A3.610 was slightly disappoint-
ing in this test. We found signif-
icant distortion at even mid-
volume levels. 

We were really taken aback by
the sheer clarity of sound repro-
duction done by the X10. In the
clip, there is a scene where a guy
puts his helmet on the car-boot,
while the car is motion and is
surrounded by four other cars
and a truck. 

In all the other speakers,
the thud of the helmet was
mostly lost in the chaos

of sound all around, but not in
the X10: it was faithfully and
distinctly reproduced, without
compromising on the bass
punch we were getting from
the revving truck engine. Really
great stuff!

The Typhoon 5.1 Amplified
System Pro was outstanding in
this particular test, and stood 
a proud third. Soomoku did
quite well and stood fourth, 
but started to sound a bit too
harsh in the scene where the car

glass shatters. 
The sound of broken

glass falling on the
ground wasn’t repro-
duced with much 
clarity, either. The
speaker that really lost in
this roundwas the
Creative PC Works LX520.
There was so much distor-
tion in this system that
the only aspect of the
scene it demonstrated
was confusion and chaos!

The Altec Lansing BS 3151R’s
performance was just about
average when compared to the
other speakers. The slim Artis
S7100 performed terribly. There
was a huge amount of distor-
tion, even at a volume level of
less than half! 

We now come to the last and
final performance test—the Half-
Life 2 demo run.

The minute the demo starts,
there is some music, and that in
itself is a pretty good indicator
of how good or bad the speaker
will perform here. The minute
we plugged in the Creative
MegaWorks, we knew we were in
for a treat. 

The thump of the sound
made everyone around sit up
and take notice. The

speakers gave an excellent
performance, and reproduced
even the faintest sound in
detail. The bomb explosions and
the gunshots, the sound of the
gun reloading… it was all so
realistic, and it was all we could
do to not look around us!

There was, however, a
strange distorted sound during a
specific part of the demo—it was
very faint but noticeably there.
Turning up the volume made it
really clear, and that’s where it
lost out on in this test.

Once we unplugged the
MegaWorks, we knew it for sure
that we would not be getting a
better performer in this test. We
were wrong.

The minute we plugged in
the Artis X10, the controlled
bass and excellent treble repro-
duction indicated that we had
to eat our words, and boy, did we
feel happy about it!

We fired up the demo, and
the sound was in every way
comparable to the MegaWorks.
What we were looking for was if
it would get distorted at higher
volumes, as was the case with
the Creative MegaWorks.

The demo began, and we
were highly impressed with the
clarity of this system. The resem-
blance to the Bose was not just
limited to design! This baby
could perform and beat the best
systems out there!

We turned the volume
all the way up, and unfortu-
nately were greeted with disap-
pointing distortion. However,
the distortion began  at  a
marginally higher level than the
Creative one, and hence it edged
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Hindi Audio CD
Instrumental Track
Vocal Specific Track
English MP3 Test
Instrumental Track
Vocal Specific Track 
Hindi MP3 Test
Instrumental Track
Vocal Specific Track
DVD-Audio
Treble
Vocals
Bass
Special frequency test files
30 Hz
50Hz
100Hz
250Hz
500Hz
1000Hz
15000Hz
Power handling Test
Ultimate Bass Test
Ultimate Treble Test
Price Index
Price
Grand Total

Speaker Type
Scoreboard -                                     Speakers
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Creative
MegaWorks THX 250D
16.69

150W
Not Applicable
75W

25Hz-20KHz

30.5x29x32.5
14.3x10.8x16
Not Applicable

✔

✖

✖

✖

✔

✖

✔

✔

✔

✖

Mute, Power

✖

✖

✔

Wired
✖

✖

✖

✖

✖

0
3.125
0
2.875
3.125
3.25
27.73
2.875
2.625

3.375
3.375

3.125
3.125

3.25
3

3.375
3.125

3.125
2.875
3.5

3.125
3.25
3.625
3.625
3.375
3.125
3.375

3.25
3.125
3.85
12990
48.27

Harman Kardon
Soundsticks II
12.04

20W
Not Applicable
10W

44Hz-20KHz

23.2(diam)x25.8
5.08(diam)x25.4
Not Applicable

✔

✔

✔

✖

✖

✖

✖

✖

✔

✖

None

✖

✖

✖

✖

✖

✖

✔

✔

✖

0
3.25
3.125
3.5
3.75
3.25
24.35
3
2

2.625
3.125

2.375
2.125

2.5
2.875

2.375
2.875

3.375
3.25
2.75

1.875
2
2.5
3.5
3.125
2.875
3.5

3
3.125
4.00
12500
40.38

JBL
Creature II
14.93

27W
Not Applicable
9W

45 Hz-20Khz

22.86x22.86x22.86
7.62x7.62x7.62
Not Applicable

✔

✖

✖

✖

✖

✖

✔

✔

✔

✖

None

✖

✖

✖

✖

✖

✖

✔

✔

✔

0
3.25
2.375
0
2.625
3.25
27.18
3
2.75

2.875
3

3.375
3.125

2.625
3

3.25
3.875

2.25
2.5
2.625

4
2.625
2.75
2.375
3.625
3.375
4.125

3.5
3.125
7.69
6500
49.80

Altec Lansing
641
22.52

109W
Not Applicable
32W

27Hz-20KHz

45.72x46.99x21.08
21.59x13.71x12.7
Not Applicable

✔

✔

✔

✖

✖

✖

✔

✔

✔

✔

Mode/Channel
select

✖

✖

✖

Wired
✖

✖

✔

✔

✔

3.375
0
3.625
0
3.625
3.25
35.48
4.25
4.25

3.625
3.75

3.375
3.875

3.5
3.5

3.375
3.75

4
3.875
4.25

3.125
4.25
4.25
3.375
3.25
3.625
3

4.5
4.125
2.33
17200
60.33

Altec Lansing
AVS 500B
17.46

14W
Not Applicable
4.5W

70Hz-18KHz

16.5x17.9x28.1
11.4x10.15x12.7
Not Applicable

✔

✔

✖

✖

✖

✖

✔

✖

✔

✔

None

✖

✖

✖

✖

✖

✖

✔

✔

✔

0
2.875
3
0
2.5
3.25
15.77
1.5
2.125

1.5
1.625

2.875
1.875

1.125
1.625

2.125
1.875

1.625
2.75
1.625

0.875
1
1.125
1.5
2.375
2.375
1.625

1.75
1.5
16.00
2500
49.22

Creative
Inspire 4400 4.1
16.23

17W
Not Applicable
6W

40Hz-20KHz

21.1x19.2x19.2
8.7x9.5x9.5
Not Applicable

✔

✔

✖

✖

✖

✖

✖

✖

✔

✖

None

✖

✖

✖

Wired
✖

✖

✔

✔

✔

0
2.75
3.875
0
3.75
3.5
22.93
2
2.875

3.125
3

2.125
2.5

2.625
2.5

2.75
2.625

2.75
2.375
2.75

1.875
1.875
1.5
1.25
2.375
2.625
3

2.875
3
12.16
3290
51.32

Cyber Acoustic
CA 4100
17.46

NA
Not Applicable
NA

35Hz-20KHz

17x17x21.7
7.5x5.5x16
Not Applicable

✔

✔

✔

✖

✖

✖

✖

✖

✔

✔

None

✖

✖

✖

✖

✖

✖

✔

✔

✔

0
3.25
3.625
3.125
3.375
3.25
20.12
2.875
3

2.125
3

2
2.625

1.75
2.375

2.125
1.875

2.125
2.375
2

1.125
0.875
1
2.125
2.125
2.375
2.625

1.125
2
16.03
2495
53.60

2.1 4.1
MAY 2005MAY 2005

Bose
Companion3
18.15

NA
Not Applicable
NA

NA

35.56x18x21.8
6.1x6.35x8.89
Not Applicable

✔

✖

✖

✖

✖

✖

✖

✖

✔

✖

Feather touch 
mute

✖

✖

✖

Wired
✖

✖

✔

✔

✔

0
4.375
4.125
4.25
4.25
3.75
35.28
4.25
3.875

3.375
3.75

4
4.125

3.625
3.75

3.25
3.875

3.125
4
3.5

4
4.125
4.5
4.25
4.375
4.375
4.125

4.375
3.75
2.65
18900
56.08
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MAY 2005 MAY 2005
5.1

Altec Lansing
251
16.24

25W
7W
7W

35Hz-18Khz

19.05x17.56x28.448
9.14x9.65x14.224
9.14x9.65x14.224

✔

✔

✔

✖

✖

✖

✖

✖

✔

✔

Centre volume

✖

✔

✔

✖

NA
✔

✔

✔

NA

2.5
2.5
2.375
3
3.25
3.25
22.27
2.375
2

2.25
2.25

2
2.25

1.875
1.875

7
2.375

1.75
2.625
2

1
1.5
3.5
2.5
3
4.5
2

1.625
1
8.00
5000
46.51

Altec Lansing 
BS 3151R
22.95

20W
10W
5W

40Hz-20KHz

18x18.5x27.3
21x7.9x8.1
11.1x7.9x21

✔

✔

✔

✔

✖

✖

✔

✖

✔

✔

Centre

✖

✔

✔

Wireless
✔

✖

✔

✔

✔

0
3.75
3.5
3.5
4
3.25
30.50
2.5
3.25

3
2.5

3.75
4

3
3.75

2.75
3.5

4.5
4.5
4

1.25
1.5
1.75
2.25
2.75
3
2.75

2
3.75
5.80
6900
59.25

Artis
S5500R
18.46

NA
NA
NA

20Hz-20Khz

25x24.5x24.7
9.5x9.5x8.5
9.5x9.5x8.5

✔

✔

✔

✖

✖

✖

✔

✖

✔

✔

Input Select,
Centre, channel
select mute, power

✖

✔

(In built)
Wireless
✖

✖

✔

✔

✔

2.875
0
2.875
0
2.5
3
19.23
1.875
2

1.375
1.625

1.875
1.375

1.25
1.875

1.875
2.625

2.625
2.125
2.25

1.875
1.5
1.125
1.375
1.625
2.125
1.625

2.375
2.125
8.00
5000
45.68

Artis
Artis S7100
22.82

30W
12W
12W

20Hz-20Khz

20.8x35.5x38
10x6x9.5
25x5.5x10.5

✔

✔

✔

✖

✖

✖

✔

✔

✔

✔

centre volume/
balance, mode
select, Input select

✖

✔

✔

Wireless
✔

✔

✔

✔

✔

3.125
2.75
2.875
3.375
3
3.5
22.41
3
2.375

1.25
1.5

2.375
2.125

2.375
1.875

1.75
2.625

1.75
2.625
2

1
1.25
1.375
1.5
1.5
2.125
3.125

1.75
3.375
5.33
7500
50.57

Artis
X10
24.09

90W
28W
28W

25-20Khz

27.5x37.8x38
7.5x10x15.5
7.5x10x15.5

✔

✔

✔

✖

✖

✖

✔

✔

✔

✔

centre volume/
balance, mode
select, Input select

✖

✔

✔

Wireless
✔

✖

✔

✔

✔

3.25
3.875
2.75
4.375
4.5
3.5
38.06
4.375
4.25

3.75
3.75

3.25
3.375

4.375
4.25

3.25
3.875

3.5
3.375
3.25

3.25
3.5
3.625
3.875
4
3.875
3.125

3.75
3.375
2.35
17000
64.50

Creative 5.1
MgW 550 THX
21.56

150W
70W
70W

25Hz-20Khz

32.5x29x30.5
16x10.8x14.3
16x10.8x14.3

✔

✔

✔

✖

✖

✖

✔

✔

✔

✔

Mute,Power

✖

✓

✓

Wired
✖

✖

✔

✔

✔

0
3.25
3.625
3.125
3.375
3.5
38.29
4.125
4

3.5
3.5

3.5
3.125

3.75
3.625

3.25
3.125

4
3.75
4.25

3.125
3.75
3.75
3.75
3.75
4
3.875

4.5
3.875
1.95
20490
61.80

Creative
Inspire 5200
17.70

17W 
6W
6W

40Hz-20Khz

17x22x19
12.4x12.3x9.7
12.4x12.3x9.7

✔

✔

✔

✖

✖

✖

✔

✖

✔

✖

None

✖

✓

✓

Wired
✓

✖

✔

✔

✔

0
4
2.5
3.5
3
3.5
34.73
3.75
4.25

3.375
3.5

3.75
3.125

3
3.375

3
3.125

3.5
3.5
4.125

2
2.625
3.125
3.625
3.75
3.375
3

2.875
3.375
8.02
4990
60.44

Creative
Pc Works LX520
17.70

16W
6W
6W

40Hz-20Khz

17x22x19
12.4x12.3x9.7
12.4x12.3x9.7

✔

✔

✔

✖

✖

✖

✓

✖

✔

✖

None

✖

✓

✓

wired
✓

✖

✔

✔

✔

0
4
2.5
3.5
3
3.5
29.59
3.25
2.75

3.5
3

2.75
3.25

3
3.75

3
3.25

3.5
4.25
3.5

1.25
1.5
1.75
1.75
2.5
2.5
2.75

2.75
2.75
8.71
4590
56.00

Cyber Acoustics
CA-5001
11.89

NA
NA
NA

NA

22.5x24.8x31
7.5x8.5x22
7.5x8.5x22

✔

✔

✔

✖

✖

✖

✖

✖

✔

✖

None

✖

✔

(In built)
✖

✖

✖

✔

✔

✔

0
2.875
2.5
0
2.75
3.25
24.17
2.375
2.625

2.375
2.125

2.625
2.875

2.875
2.875

2.625
3.125

1.5
1.875
3

1.125
1.375
1.75
2.125
3
3
2.625

1.875
2.875
8.01
4995
44.06

Hyundai
5.1
16.80

50W
14W
14W

NA

24.5x41x40
11x13x24.5
23x14.5x14.5

✔

✔

✔

✖

✖

✖

✔

✔

✔

✔

None

✔

✖

Wireless
✔

✖

✖

✖

✖

2.5
3.5
4
0
4
3
32.06
3
3

3
3.5

3.75
3.5

3.25
3

3
3.25

2
3
3.5

2.75
3.75
3.75
4
4
4
4

3.5
3.25
3.65
10950
52.52

Jazz
J7915A
12.92

12W
4.5W
4.5W

50Hz-20KHz

21.6x20.6x9.6
6.5x5.8x6.5
6.5x5.8x6.5

✔

✔

✔

✖

✖

✖

✔

✖

✔

✖

None

✔

✔

(In built)
✖

NA
✖

✔

✔

✔

3.625
0
1.625
0
2
3
9.66
1.375
1

0.25
0.625

1
1.125

0.875
0.875

0.875
1.125

1.5
1.25
0.375

0
0.25
0.875
0.375
2.125
2.125
0.25

1.125
0.875
16.06
2490
38.64
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BRAND
Model
Features Total
Power Rating (RMS)
Subwoofer
Center
Satellites (Front/Rear)
Audio specifications
Frequency response
Physicial Dimensions (LxDxH, in cm)
Sub-Woofer
Satellites
Center
Connectors on Speaker Set (Analog)
Front in
Rear in
Center/Subwoofer
Digital DIN
Connectors on Speaker Set (S/PDIF)
Coaxial
Optical
Controls on speakers/Remote control
Bass
Treble
Volume (+ / -)
Surround Effects
Others (List)

Bundled Accessories 
External Decoder
Power Adapter
Speaker Stands
Remote control (Wired / Wireless)
Batteries
Built-in FM Tuner (Y/N)
Manual & documentation (Y/N)
Listing of specifications
Quick setup guide
Troubleshooting
Build Quality
Speaker Wire clamps
The knobs/Buttons
The speaker veils 
The Speaker stands 
Overall build quality
Ease of Use
Performance Total
In Game Sound: (Half life 2)
DVD Movie Test (Fast and Furious)
English Audio CD
Instrumental Track
Vocal Specific Track
Hindi Audio CD
Instrumental Track
Vocal Specific Track
English MP3 Test
Instrumental Track
Vocal Specific Track 
Hindi MP3 Test
Instrumental Track
Vocal Specific Track
DVD-Audio
Treble
Vocals
Bass
Special frequency test files
30 Hz
50Hz
100Hz
250Hz
500Hz
1000Hz
15000Hz
Power handling Test
Ultimate Bass Test
Ultimate Treble Test
Price Index
Price
Grand Total

Logitech
Z5300
21.23

100W
39W
35.25W

35Hz-20KHz

36.83x29.84x29.97
8.89x9.5x20.32
7.62x16.8x12.7

✔

✔

✔

✖

✖

✖

✔

✖

✔

✔

Mixer/Power

✖

✔

✔

Wired
NA
✖

✔

✔

✔

0
0
4
4
4
4.5
30.93
3.5
2.75

3
2.5

2.75
3

3.25
3.75

2.75
3

3
3.25
3

2.75
2.75
3.75
3.25
2.75
2.75
3.75

3.75
2.75
2.96
13500
55.11

Mercury
HT5800R
14.64

NA
NA
NA

NA

17x33x23.5
10.4x10x11.2
20.8x9.5x9.8

✔

✔

✔

✖

✖

✖

✔

✖

✔

✖

Input Select

✖

✔

✔

Wireless
Yes
✖

✖

✖

✖

3.25
2.625
3.125
2.125
3.125
3.25
21.36
1.875
2

1.25
1.625

1.625
1.375

1.25
1.5

1.875
2.625

2.375
1.625
2.875

2.375
2.625
3.125
3.125
3.125
3.375
2.375

3.125
2.625
5.97
6699
41.97

Ozaki
Nukez 5.1 channel
16.17

50W
23W
13W

45-20KHz

20x37x39
9.8x23.4x10
9.8x14.3x23.9

✔

✔

✔

✖

✖

✖

✔

✔

✔

✖

None

✔

✔

Wireless
✖

✖

✔

✔

✖

3.5

3.125
0
2.5
2.375
3.25
3.25
30.33
3.5
3.25

3.5
2.875

2.625
2.5

2.875
2.375

2.625
3.125

3.25
2.625
3.375

2.125
2.375
2.375
2.625
2.875
3
3

3.25
3.125
7.02
5700
53.52

Philips
A3.6.10
15.26

100W
20W
20W

40-20Khz

23.8x36.5x26.3
9.5x7.5x18.5
9.5x7.5x18.5

✔

✔

✔

✖

✖

✖

✖

✖

✔

✖

None

✖

Y
(In built)
✔

✖

✖

✔

✔

✔

0
2.875
2.5
2.75
2.75
3.5
35.04
2.875
3.25

3.375
3.125

3.25
3.25

3.75
3.625

3.25
3.125

3.625
4
4.375

3.125
4.375
4.375
3.75
3.75
3.375
3.5

4.375
3.875
3.08
13000
53.38

Philips
A 5.600
15.34

50W
10W
10W

40-20KHz

19.7x29.8x21.3
8.5x8x9
8.5x8x9

✔

✔

✔

✖

✖

✖

✖

✖

✔

✖

None

✖

✔

(In built)
✔

✖

✖

✔

✔

✔

0
2.875
2.5
3
2.75
3.5
22.99
2.375
3.375

2.5
2.75

2.625
2.375

2.375
2.375

2
2.375

2.875
2.5
3

0.25
0.75
0.75
0.875
1.375
2.375
2.375

1.125
1.875
5.06
7900
43.39

Soomoku
5.1
18.86

40W
15W
12W

NA

25x23.5x41
11x10.5x19
32x11.7x10

✔

✔

✔

✖

✖

✖

✔

✔

✔

✔

None

✖

✔

✖

✔

✖

✖

✔

✔

✖

0
3.25
3.125
0
3.75
3
35.03
3.875
3.625

.5
3.125

3.375
3.25

3.25
2.625

2.875
2.75

3.375
4
3.875

3.625
3.625
4.375
3.5
3.75
2.875
3.5

3.625
3.5
5.93
6750
59.82

Typhoon5.1 
Amplified system Pro
20.69

30W
14W
14W

30Hz-25Khz

24.4x22.2x22.8
15.5x12.5x20.5
15.5x12.5x20.5

✔

✔

✔

✖

✖

✖

✔

✖

✔

✔

Balance, input, center,
mode, power, mute

✔

✔

(In built)
Wireless
✔

✖

✔

✔

✔

3.375
3.75
3.875
3.125
3.125
3.5
25.76
2.875
3.75

3.125
2.875

2.875
3

2.375
2.375

3.125
3.375

2.625
3
3

1.25
1.5
1.5
1.25
2.5
2.25
2

1.125
0.875
8.89
4500
55.34

Creative
6.1
17.79

22W
20W
8W

40Hz-20KHz

24.5 x 27.2 x 24.6
8.8 x 10.1 x 16.2
8.8 x 10.1 x 16.2

✔

✔

✔

✖

✖

✖

✔

✖

✔

✖

None

✖

✔

✔

Wired
✖

✖

✔

✔

✔

0
3
2.5
3
2.75
3.5
33.67
3.5
3.375

3.125
3.375

3.875
3.375

3
3.625

3.5
3.625
27.5
3.375
3.875
4

1.125
1.875
1.625
3.375
3.875
3.75
3.125

4
3.375
5.34
7490
56.80

Speaker Type
Scoreboard - Speakers 

5.1 6.1
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aside the MegaWorks model to
take the top spot.

Once again, the Soomoku
surprised us with its perform-
ance and stood   a gallant third
this time, beating its competi-
tor—Creative Inspire 5200           by
a hairsbreadth!

The other speaker system in
this category that performed
commendably was the Logitech
Z5300 speaker. However, this
system came with a rather weak
woofer. There was no way it could
match the bass of the Creative
MegaWorks and the Artis X10.

The Speaker Superstar
The winner, although only by a
slight margin, was the Artis X10,
followed very closely by the
Creative 5.1 MegaWorks 550
THX. Moreover, not only is the
Artis X10 a slightly better
performer, it is also Rs 3,000
cheaper than the Creative 5.1
MegaWorks 550 THX model.

The Artis X10 might not have
led in each and every depart-
ment, but was the most consis-
tent performer, and so gets the
Digit ‘Best Buy Gold’ award.

The 5.1 Creative MegaWorks
550 THX performed as brilliantly
as ever, but eventually lost out
due to its rather high price, and
slight lack of clarity.

Apart from these two,
an extremely worthy candidate
that you could look at for
a budget buy is the Creative
Inspire 5200 or the Soomoku 5.1
home theatre. 

In fact, both speakers were
neck-to-neck in terms of perform-
ance. While the Soomoku had
slightly more features, the
Creative Inspire 5200 was signifi-
cantly cheaper. 

varun_dubey@thinkdigit.com

The two Mercury speakers—
the HT5800R and the HT6200
performed poorly. Apart from
that, both the speakers systems
had extremely flat sounds. 

As a matter of fact, the sound
was so terrible that it almost
negated the spacing effect,
which is supposed to be created
by a 5.1 system.

It came as a surprise to us,
when the Philips A3.610 speaker
lost out in this test, and it was
quite comfortably bettered
by the huge Hyundai 5.1
speaker system. 

Telephone Web siteCompany E-mailBrand

Contact Sheet Speakers

Altec Lansing
Artis
Bose
Creative
Cyber Acoustic
Harman/Kardon
Hyundai
Jazz
JBL
Logitech
Mercury
Ozaki
Philips
Soomoku
Typhoon

Rashi Peripherals
Kunhar Peripherals Pvt ltd
Bose Corporation India LTD.
Creative Technology Ltd
Arc-Max Technology Company
Gautam Agencies
Palesha Electronics Industries
Mediatech India
Gautam Agencies
Logitech Electronic India P. Ltd.
Kobian India Ltd
Rashi Peripherals
Philips Sound Solutions
Palesha Electronics Industries
Aditya Infotech Ltd

022-28260258
022-56345758
1600112673
98203 57718
044-26440062 
020-25454270/71
020-26351752
022-26361111
020-25454270/71
022- 26571160
080-25566626
022-28260258
020-7124196
020-26351752
011-26223810

navinderc@rptechindia.com
salesbom@kunhar.com
customersupport@boseindia.com
india_getcreative@ctl.creative.com
ca@arc-max.com
sales@gautamagencies.com
palesha@vsnl.com
digit@mediatechindia.com
sales@gautamagencies.com
response@logitech.com
mumbai@kobain.com
navinderc@rptechindia.com
pss.sales.marketing@philips.com
palesha@vsnl.com
yogesh_dutta@adityagroup.com

www.altec-lansing.com
www.artis.co.in
www.boseindia.com
www.creative.com
www.cyber-acoustic.com
www.harmankardon.com
www.palesha.com
www.jazzspeakers.com
www.jbl.com
www.logitech.com
www.mercury.com
www.ozaki.com.tw
www.philips.com
www.palesha.com
www.anubisline.com
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I
n the recently concluded
India-Pakistan cricket series,
cricket fever was at its pinna-
cle. You may think, “Wouldn’t

it be nice if I could capture and
preserve those memorable
moments (read: sixes, catches,
wickets, or Afridi’s superb anni-
hilation of our bowling attack in
the fifth ODI), so I could re-live
the entire experience again?”

To add to your woes, that
obsolete piece of hardware
known as your VCR is no longer
operational. Rejoice then, for it is
that time of year again—time for
the TV Tuner shootout.

TV tuners today have become
so inexpensive and feature-
packed that, by the time you are
through reading this article,
chances are you will have made
up your mind to go and grab one
that suits your needs. 

This time around, we went
looking for both internal and
external TV tuners. External 
TV tuners were of two types—
USB devices and set-top TV 

boxes that are in-line gadgets
that connect between the PC’s
analogue VGA-out and the VGA-
in of your monitor.

Internal PCI TV 
Tuner Cards
This category is the most popular,
mainly due to lower prices, good
quality, features, and the fact that
these cards sit inside the PC cabi-
net and don’t occupy valuable
space on your desktop. 

We received 11 internal PCI
TV Tuner cards. The companies
that sent us cards included AVer-
Media, Compro, Mercury, MSI,
Pinnacle, PixelView and Tech-
Com. MSI and Tech-Com were the
newcomers this year.

Features
We noticed a major shift in the
manufacturers’ choice of TV
tuner chips this year. Last year,
the Conexant (Brooktree) Bt8x8
chip dominated the TV tuner
market. This year, the Philips
713x ranked high among most
manufacturers.

All the cards came with
bundled PVR software of some sort
that supported at least   MPEG-1
video capture. Time-shift was also
supported by all the cards, with
the exception of the Tech-Com
Super TV SSD-TV-670.

Barring the Compro Video-
Mate TV Gold II, Pinnacle PCTV
Stereo, MSI Mega TV Tuner card
and the Tech-Com Super TV SSD-
TV-670, all cards featured an FM
radio tuner. The TV tuners based
on the Philips SAA7130HL chip
supported only mono TV audio.
This really doesn’t make a differ-
ence, since India does not have
stereo cable TV signals.

The remote controllers that
came with the TV tuners
varied in size and functional-

ity. Many came with remote
controllers the size of a credit

card. The Compro had a medium-
sized remote controller, while
the PixelView MediaCentre
PlayTV@P3000’s was big enough
to club someone to death with,
though it was definitely the most
feature-rich of the lot—with exotic
features such as zoom and DVD
playback control.

We noted various features of the TV tuners, such as the chip,
whether FM radio is supported, and whether the TV sound

is stereo or mono. We noted the number of input/output ports,
and higher points were awarded when a higher number of
ports were featured. 

We also rated the bundled accessories such as remote
controller, cables and software packaging. Where PVR software
was provided, its functionality, such as whether time-shifting
was available, and whether MPEG-1/2/4 capture facility was
provided was noted and rated accordingly. The ease of
installation of the TV tuner was also noted and rated. 

The test bench comprised an AMD Athlon 64 FX-53
processor on a MSI K8T Neo motherboard with 512 MB of
Corsair DDR RAM running at 400 MHz and a 120 GB 7200 rpm
Seagate Barracuda SATA/150 hard drive. The video card was a
GeForce FX 5700LE, and the sound card was a Creative
SoundBlaster Audigy 2 Platinum. We installed Windows XP SP1
and installed the necessary hotfixes. We then installed Directx
9.0c and the latest drivers, and created a System Restore Point
to get a reference point to which we could restore the system
after testing each TV tuner. 

This was done in order to avoid possible driver conflict
issues, as many TV tuners that featured the same chip had
drivers that consisted of similarly-named files and only
different version numbers.

In the cable TV channel detection test, we deliberately
created a cable TV point with a weak signal strength. This was
done by introducing joints in the cable, which caused signal
strengths to drop at each point. The TV viewing utility provided
with the TV tuner was used to determine the number of
channels that the TV tuner could detect. 

After this, we rated the visual quality of the detected TV
channels on a scale of 5. This was a subjective test, and we
looked for artefacts and anomalies in different channels.

Next, we tested the TV tuners to capture content using
both cable and S-Video as the input sources. We used
VirtualDub 1.6.5 to capture content from the S-Video input in
uncompressed raw AVI format (RGB-555) with PCM
uncompressed audio. 

We noted the number of frames dropped, and checked the
quality of the captured content without any compression, made
by either the hardware or software. We used VirtualDub, since it
uses the minimum system resources. 

We also used the TV tuners to capture regular cable content
using the applications and software supplied by the
manufacturers. This was done to check both, the quality of
content, and also the real-world performance of the TV tuner.
Any other issues, such as crashing of applications and drivers
were also noted. In short, features, performance and pricing
were considered to choose the winners. 

How We Tested TV Tuners

Surprisingly, TV Tuners haven’t become as popular as they
deserve to be. Here’s the lowdown on what to buy and why

Tune That TV

PixelView’s MediaCentre PlayTV@P3000
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All the TV tuners came with
connecting cables. Some, such as
the Tech-Com card, came with an S-
video to S-video and a 3 to 1 AV
cable in addition to the stereo
cable, while the PixelView Media-
Centre PlayTV@P3000 came with
just a stereo cable. The software
packages also varied; while many
TV tuners came with just the driv-
ers and no-nonsense PVR software,
some, such as the
Compro VideoMate
Gold Plus II, came with
Ulead’s MovieFactory 
2 SE and VideoStudio 2
SE DVD software.

The MSI Mega TV Tuner Card came
with InterVideo WinCinema
Suite—a great software package.

All the cards came with PVR
software that had MPEG-1 and 2
capture capabilities, with the
exception of Mercury—it could
not capture to MPEG-2. Some

cards, such as the AVerMedia,
PixelView PlayTV Pro 2 and
Tech-Com, also supported
MPEG-4 capturing.

As far as looks go, the
Compro Videomate Gold II and
Gold Plus II stand out from the
crowd with their gold plating.
The Pinnacle and MSI cards had
sleek looking tuner units—the
Pinnacle was the sleekest. This

is an advantage because a
sleek form factor leaves

more room for air circula-
tion between adjacent cards

and the cabinet on
the whole.

Performance
Almost all the cards

performed well. The
ease of installation of the

drivers and PVR were noted.
We were very disappointed by

the Mercury card, as we had a
tough time installing the drivers
and PVR software. 

When we installed the Pinna-
cle PCTV Rave on our other test
machine, it couldn’t initialise
properly after the driver instal-
lation, and hence refused to
work. The device manager
showed that it had a problem.
You have to be careful when
buying such a card. 

The telephone always rings at the
wrong time, doesn’t it? People

only think of calling when you are
in the shower or while you are
watching your favourite show on
the telly. When it comes to the
shower, you’re on your own, but
you never need miss another
minute of your favourite TV shows. 

Wouldn’t it be cool to be your
own third umpire when watching a
cricket match? No need to wait for
the replay: just replay the last ball
automatically on your own! Perhaps
you would also love to skip or
fast-forward advertisements?

All the above is easy with a TV
tuner card. All you need to do is
invest in a TV tuner card that
offers time-shifting features.
Previously, this was only possible
using a set-top box such as the
TiVo. However, today, PVR software
is all you need. 

So, how does it work? While you
watch your favourite show the
audio and video is saved to your
hard disk in real-time. But this is

where the similarity between video
capturing and time-shifting ends.
Time-shifting lets you view the
recorded content while the
recording is being done. Thus, when
you pause the video, the recording
continues, and when you press play,
the delayed video is played back.

However, the quality of the
time-shifted video always seems to
be inferior to live video. This quality
depends on the video capture
format selected in the capture
settings of the PVR software. A
better capture format such as
MPEG-2 at DVD resolution would
result in better quality, but would
need a high-end system to run.

Also, the time duration for
which a programme can be paused
depends on the free space available
on the hard drive. Time-shifting is
critically dependent on processor
speed and hard disk speed, but
today, with even entry level PCs
being shipped with sufficiently high
processing power CPUs, this has
become a non-issue.

Time Shifting

1 Col AD

MAY 2005

Compro VideoMate PVR/FM
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The PVR application bundled
with the PixelView cards hogged
system resources so much that
they brought our test machine to a
virtual standstill for a few minutes.
The Pinnacle PVR application inter-
face needs a face-lift, while the
application provided by Mercury
can be best described as vanilla.

In the channel detection test,
all cards fared well except for the
Pinnacle PCTV Rave, which
detected a miserably low 27 chan-
nels, and the PixelView PlayTV
Pro2, which detected just 54 out
of the total 87 available channels. 

The problem probably lies in
the bundled PVR application,
because when we tried to use a
third party PVR application, we
could detect a lot more channels
with both cards.

After the channel detection
part of the test was over, we
observed the visual quality of the
channels, and found that the
Compro VideoMate PVR/FM had
the best image quality, followed
by its more expensive siblings—
the Compro VideoMate Gold II
and Gold Plus II. 

A point to be noted here 
is that the TV tuner cards with
the Philips SAA713xHL chip

offered a much better image
quality than the ones featuring
Conexant chips.

In the capture test, which
determines the number
of frames dropped.
Here, the PixelView
PlayTV Pro2
scored the
lowest by
dropping
seven frames—
the maximum
number of frames dropped.

The Mercury TV tuner card
dropped six frames, and came
second last, but the Compro TV
tuners that performed flawlessly,
and never dropped a single frame.

External TV Tuners
A PCI TV tuner card has inherent
downsides. The tuner unit is situ-
ated inside the PC cabinet, and
hence, is prone to interference
from various PC components,
which effects quality. 

When a tuner is at work, it
heavily loads the PCI bus. Also,
some motherboards might not
have a spare PCI slot to accom-
modate the PCI TV tuner card,
and those with laptops just
cannot use one.

In such situations, using 
an external TV tuner is a good
solution. Remember, external TV
tuners are sub-divided into two
categories: USB and set-top
tuners—which use a loopback
cable from the VGA-out of the
display card to the unit and from
the unit to the CRT. The Digit Test
Centre received three TV tuners in
each of these categories.

External USB TV Tuners
TV tuners of this type connect to
the USB port of the PC. Due to the
high data rate required for the
transfer of information from the
TV tuner to the PC, all the tuners
of these type work on the USB 2.0
interface, which ideally supports
a data throughput of 480 Mbps.
AVerMedia, Tech-Com and Pinna-
cle sent us TV tuners of this type.

Features
All the tuners in this category had
the necessary input/output ports.
The Pinnacle PCTV MediaCenter
came with just a single USB cable,
whereas the others came with a
few more cables. 

The AVerMedia AVerTV USB 2.0
did not come with a remote, which
is a must for any TV tuner. The

BRAND
Model
Features
Type(Internal/External)

Tuner Type (TV/FM)

TV Chip

Stereo or Mono TV Sound

I/O ports

Remote Control (Y/N)

No. of Buttons on Remote

Connecting cables provided

Software

PVR/Timeshift

MPEG1/MPEG2/MPEG4

Ease of installation (Scale of 5)

Performance
No. of TV channels detected 

(Out of 87)

Visual quality (Scale of 5)

Video capture Test (Frames

dropped)

Price Index
Price (Rs)

Overall Score (Out of 100)

AVerMedia
AVerTV GO 007
26.24
Internal PCI

TV/FM

Philips SAA7130HL

Mono

Coaxial In,Composite

In, S-Video In, Audio

In/Out

✔

34

Stereo cable, 

FM aerial

Drivers, PVR 

Software

✔/✔

✔/✔/✔

3

29.04
86

3.5

4

13.72
2950

69.00

Compro
VideoMate PVR/FM
26.08
Internal PCI

TV/FM

Philips SAA7130HL

Mono

Coaxial In, Composite

In, S-Video In, Audio

In/Out

✔

32

Stereo cable, FM

aerial

Drivers, PVR

Software

✔/✔

✔/✔/✖

4

32.42
84

4.25

0

20.29
1995

78.79

Compro
VideoMate Gold II
24.33
Internal PCI

TV

Philips SAA7134HL

Stereo 

Coaxial In,

Composite In, 

S-Video In, Audio

In/Out

✔

32

Stereo cable, FM

aerial

Drivers, PVR 

Software, Ulead

MovieStudio 2 SE

✔/✔

✔/✔/✖

4

31.50
87

3.75

0

13.72
2950

69.55

Compro
VideoMate Gold Plus II
28.01
Internal PCI

TV/FM

Philips SAA7134HL

Stereo

Coaxial In,Composite

In, S-Video In, Audio

In/Out

✔

32

Stereo cable, 

FM aerial

PVR Software, Ulead

MovieFactory 2 SE &

VideoStudio 7 SE DVD

✔/✔

✔/✔/✖

4

31.50
87

3.75

0

11.73
3450

71.24

Mercury
TV Tuner Card
23.02
Internal PCI

TV/FM

Philips SAA7130HL

Mono

Coaxial In,

Composite In, 

S-Video In, Audio

In/Out

✔

24

Stereo cable

Drivers, PVR

Software

✔/✔

✔/✖/✖

2.5

27.38
85

3.25

6

27.00
1499

77.40

MSI
Mega TV Tuner Card
18.03
Internal PCI

TV

Conexant CX23881-19

Stereo

Coaxial In, Composite

In, S-Video In, 

Audio In

✖

NA

Stereo cable, S-video

to S-video

Drivers, PVR

Software, InterVideo

WinCinema suite

✔/✔

✔/✔/✖

3.5

26.27
75

3

3

13.72
2950

58.01

MSI
TV@nywhere Master
27.39
Internal PCI

TV/FM

Conexant CX23881-19

Stereo

Coaxial In, Composite

In, S-Video In, Audio

In/Out

✔

24

Stereo cable, S-video

to S-video, FM aerial

Drivers, PVR

Software, InterVideo

WinDVD Creator Plus

✔/✔

✔/✔/✖

3.5

25.79
77

3

5

13.72
2950

66.90

Pinnacle
PCTV Rave
16.63
Internal PCI

TV

Philips SAA7134HL

Stereo

Coaxial In, Composite

In, S-Video In

✖

NA

Stereo cable

Drivers, PVR Software

✔/✔

✔/✔/✖

3

19.64
27

3.25

2

13.54
2990

49.81

Internal PCI TV Tuners

Scoreboard - TV Tuner 

MAY 2005 MAY 2005

MAY 2005

Mercury TV 
Tuner Card
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Pinnacle PCTV MediaCenter came
with the most feature rich remote,
and was comfortable to handle.

The build quality of the AVerTV
USB 2.0 was the most rugged, with
its aluminium-like finish and
compact, square form factor. 

The Pinnacle MediaCenter was
the most elegant looking of the
three, with its cool blue LED and a
nice curved shape.

When it came to bundled soft-
ware, the Pinnacle PCTV provided
the best PVR software, with all
the necessary features. It also
came bundled with Pinnacle
MediaCenter.  

The Tech-Com SSD-TV-811 came
with a PVR known as the TV Juke-
box, which supported MPEG-1/2/4
video capturing. The PVR software
provided by AVerMedia supported
MPEG-4 capture in addition to
MPEG-1 and 2 capturing.

Performance
Not only did Pinnacle
provide the best PVR appli-
cation, the application also
detected the most number
of TV channels—73. The
AVerTV and Tech-Com
lagged behind with
67 and 66 chan-
nels respec-
tively. Pinnacle
also had the best
image quality.

In the capture test,
the Pinnacle dropped no
frames, while AVerTV and
Tech-Com dropped three and
four frames respectively. Thus,
once again, the Pinnacle Media-
Center emerged superior to the
other two.

External Set-top Tuners
An external set-top TV tuner does
not require a PC at all. All they
need is a CRT monitor to display
the video, while the inbuilt
speaker delivers the audio. If you
need better audio quality, connect
the line out from the tuner to an
amplified speaker system. 

Tuners of this type display
the best quality video on a CRT
monitor as compared to the

previous two solutions, espe-
cially when the PC is off, because
the RF interference from the PC
is also shut off.

As you might have guessed,
these TV tuners are only meant
for TV viewing and cannot be
used for capturing. 

We received three tuners in
this category, two from AVerMe-
dia and one from Tech-Com.

Features
The AVerMedia TV tuners came
with an easy-to-use remote. They
also featured a function known
as PIP (Picture-In-Picture), which
displays TV video in a corner of
your screen, while you use the
rest of the desktop for your work.
We tried to use this feature but
failed. We even tried using differ-
ent resolutions but it just did 
not work. 

Both AVerMedia models
looked very elegant with their
silver finish and nicely placed
buttons—which gave good tactile
feedback. The difference between
the two was that while the Box 5
supported a maximum resolution
of 1024 x 768, the Box 9 model
supported a maximum resolution
of 1280 x 1024.

PixelView

26.95
Internal PCI

TV/FM

Conexant Fusion 878A

Stereo

Coaxial In,Composite

In, S-Video In, 

Audio In

✔

41

FM aerial

Drivers, PVR Software,

InterVideo WinDVD

✔/✔

✔/✔/✖

3.5

28.50
87

3.25

4

16.19
2500

71.64

MediaCentre PlayTV@P3000
PixelView
PlayTV Pro 2
27.31
Internal PCI

TV/FM

Conexant Bt878

Stereo

Coaxial In,

Composite In, 

S-Video In, Audio

In/Out

✔

32

Stereo cable, FM

aerial

Drivers, PVR

Software

✔/✔

✔/✔/✖

3.5

20.59
54

2.75

7

26.98
1500

74.88

Tech-Com
Super TV SSD-TV-670
22.06
Internal PCI

TV

Philips SAA7130HL

Mono

Coaxial In,Composite

In, S-Video In, Audio

In/Out

✔

32

S-video to S-video, 3

to 1 AV cable, Stereo

cable

Drivers, PVR Software

✔/✖

✔/✔/✔

2.5

29.60
87

3.5

3

20.25
1999

71.91

AVerMedia
AVerTV USB2.0
21.20
External USB 2.0

TV

NA

Mono

Coaxial In,Composite

In, S-Video In, Audio

In/Out, USB 2.0

✖

NA

USB cable, Stereo

cable, Stereo to 

S-video cable

Drivers, PVR

Software

✔/✔

✔/✔/✔

3

30.15
67

3.5

3

3.85
7000

55.20

Pinnacle
PCTV MediaCenter 100e
26.80
External USB 2.0

TV

NA

Mono

Coaxial In,Composite In,

S-Video In, Audio In, 

USB 2.0

✔

41

USB cable

Drivers, PVR Software,

Pinnacle Mediacenter

✔/✔

✔/✔/✖

3.5

34.23
73

4

0

3.86
6990

64.89

Tech-Com
SSD-TV-811
24.73
External USB 2.0

TV

NA

Mono

Coaxial In, 

Composite In, 

S-Video In, Audio

In/Out, USB 2.0

✔

22

USB cable, Stereo

cable

Drivers, PVR

Software

✔/✔

✔/✔/✔

1

25.51
66

2.25

4

9.00
2999

59.24

AVerMedia
AVerTV Box 5
16.14
Set-top Tuner 

TV

NA

Mono

Coaxial In, VGA In/Out,

Audio In/Out

✔

37

VGA to TV box cable,

Stereo cable, Power

adapter

NA

NA

NA

4

25.74
54

4.25

NA

5.40
7500

47.28

AVerMedia
AVerTV Box 9
16.84
Set-top Tuner 

TV

NA

Mono

Coaxial In, VGA

In/Out, 

Audio In/Out

✔

37

VGA to TV box

cable, Stereo cable,

Power adapter

NA

NA

NA

4

33.25
87

4.5

NA

4.91
8250

55.00

Tech-Com
SSD-TV-712
16.62
Set-top Tuner 

TV

NA

Mono

VGA In, VGA Out, 

S-Video In/Out, 

Audio In/Out, 

Coaxial In

✔

25

VGA to TV box cable,

Stereo cable, Power

adapter

NA

NA

NA

4

30.63
87

3.75

NA

20.25
1999

67.49

External TV Tuners
External USB 2 External Set-Top Tuners

MAY 2005 MAY 2005

Internal PCI TV Tuners

Pinnacle 
PCTV USB2

MAY 2005

AverMedia AverTV USB2.0
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The Tech-Com SSD-TV-712 has
not been mentioned in this
section because, quite frankly, it
is a no-frills device and there was
nothing noteworthy about its
features. All three TV tuners
featured decent OSDs.

Performance
Unfortunately, very little can be
said about the performance of the
external set-top TV tuners. The
only tests carried out here were
the number of channels detected
and the image quality.

The Tech-Com and the AVer-
Media Box 9 detected all the 87
TV channels, while the Box 5
could manage just 54. The image
quality of the Box 9 was the best,
with Box 5 not far behind.

The Broad Picture
We tested 17 TV Tuners in
this test. In the internal TV
tuner cards category, the
Compro cards outperformed
every other card. 

There was somewhat of 
a neck-and-neck competition

between the Compro Video-
Mate PVR/FM and the Mercury
TV tuner card. Each had their
own positives and negatives. 

While the
Mercury card
was priced
at a rock-
bot tom
Rs 1,499,
the Compro
was not too expen-
sive either at Rs 1,995.
However, due to better
image quality and PVR
features, the Compro PVR/FM
emerged the Gold winner
whereas the Mercury won Silver.

In the external USB TV tuner
category, the Tech-Com did make
itself notable by pricing its SSD-
TV-811 at Rs 2,999, as compared
to nearly Rs 7,000 for the other
two candidates from AverMedia
and Pinnacle. 

However, since this segment
is primarily aimed at laptop
users, the price factor isn’t as
important as the features and
performance.

Moreover, most laptop owners
probably would not mind spend-
ing a few extra bucks for better
quality. Performance-wise, the
Pinnacle and AVerMedia were the
only contenders for Gold. Due to
better image quality, channel
detection and video capture
score, the Pinnacle PCTV Media-
Center 100e was adjudged the
winner in this category.

The last category included the
external set-top TV tuners. Here,
the AVerMedia Box 9 tuner
performed exceptionally well—
better than the Tech-Com tuner
in the image quality test. 

However, the AverMedia
Box 9 was priced high at Rs
8,250—You should be able to buy
a decent colour TV for the price
of the AverMedia Box 9! The
Tech-Com SSD-TV-712, on the
other hand, was priced at a very
low Rs 1,999.

Due to huge price difference,
the Tech-Com SSD-TV-712 easily
won first place in this category. 

Most home users are opting
for a TV Tuner card nowadays
because of the flexibility it
offers. Unlike earlier TV cards,
today’s cards are more user-
friendly and offer an unbeliev-
able array of features.

If you find yourself missing out
on your favourite programs, or are
interested in recording content
from your TV to watch later, noth-
ing beats a TV tuner!  

jayesh_limaye@thinkdigit.com

Telephone Web siteCompany E-mailBrand

Contact Sheet CRT Monitors

AVerMedia
Compro
Mercury
MSI
Pinnacle
PixelView
Tech-Com

ACCESS
Mediatech India
Kobian India Ltd
Micro Star International
Aditya Infotech Ltd.
Rashi Peripherals
Shree Sagarmatha Distributors

022-23840789
022-26361111
022-23020767
022-8386711-13
011-26445915
022-28260258
022-26428541

rcshah@bom8.vsnl.net.in
sales@mediatechindia.com
mumbai@kobian.com
navin@cyberstarindia.com
yogesh_dutta@adityagroup.com
navinderc@rptechindia.com
techcom@touchtelindia.net

www.avermedia.com
www.comprousa.com
www.mercury-pc.com
www.msi-india.com
www.pinnaclesys.com
www.prolink.com.tw

PVR: Abbreviation for Personal Video
Recorder, this software allows a TV tuner
to record video content in real-time.
Timeshifting: Timeshifting is a feature
of PVR that allows you to pause, replay
or skip a portion of a live TV programme.
You have absolute control over how you
watch on TV.
MPEG: MPEG is a group (Moving Picture
Experts Group) that develops standards for
digital audio and video compression. There
are several versions of this standard,
including MPEG-1, MPEG-2 and MPEG-4.
MPEG-1: This standard was designed to
code progressive video at a transmission
rate of 1.5 Mbps. It is used in video CDs, but
gave way to the new MPEG-2 standard.
MPEG-2: This standard was designed to
code transmission rates above 4 Mbps,
and is used in DVD and digital broadcast
TV. It is superior to MPEG-1 in terms of
picture quality and sound clarity.
MPEG-4: This is a relatively new standard,
and is aimed at converging streaming

media from different sources. 
NTSC: This stands for National Television
Standards Committee, which developed
the protocol for colour television
broadcast transmission and reception
in the US. 

As a matter of fact, NTSC signals have
been used in the US and Japan since 1954,
and have hardly been altered since their
inception, except for the addition of new
parameters for colour signals such as Hue
and Tint control. 

Also, NTSC signals are interlaced, and
an NTSC TV image has 525 horizontal lines
per frame. Every other line is dropped,
and thus it takes two screen scans to
complete one image. 29.97 frames are
scanned every second.
PAL: Phase Alternation Line is the
standard that was developed in Germany
is used in India and Europe. 

In the PAL standard, the horizontal
image has 625 horizontal lines per frame.
25 frames are scanned every second. A

slight colour variation is seen between the
PAL and NTSC standards.
SECAM: This stands for Système
Électronique Couleur Avec Mémoire and
was put forward by Henri de France in
Paris. SECAM is prevalent in some parts of
Europe-mainly in France, Russia and
countries of the former Soviet Union
where it was adopted in 1967. 

In the SECAM system, the
luminance information is transmitted
in the usual manner, the chrominance
signal is interleaved with it, and the
colour information is reproduced with
minimal errors.
NICAM stereo: This stands for Near
Instantaneous Companded Audio
Multiplex, and was developed by the BBC
Research Centre in the early 1980s. 

NICAM stereo was first transmitted
with the PAL colour broadcasting system
in Britain. Interestingly, this technology
improves on the sound quality of the
transmitted TV signal.

Jargon Buster

Tech-Com 
SSD-TV-712

MAY 2005
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The MEGA PC 865 PRO is the latest in the series of small
form-factor PCs, such as the MEGA 180 and the MEGA

865. On the design front, the MEGA PC 865 PRO has
improved significantly, facilitating easy installation of
internal components—which was a pain with some of the
older models. 

The finish is a combination of brushed aluminium and
matte-black with orange backlights, giving the MEGA 865
PRO a sedate, classy appeal. The front facia is split into
three horizontal panels. The top panel covers the optical
drive, the middle one accommodates the display panel,
and the bottom panel covers the various ports—USB,
FireWire, sound jacks and the 7-in-1 memory card reader.

The i865G chipset-based motherboard supports an
LGA 775 Intel processor up to 3.4 GHz. DDR 400 MHz
memory modules in dual mode is supported, but there are
just two memory slots. The board offers 5.1 channel
sound, which is very good for DVD playback. The graphics
subsystem is driven by the onboard Intel graphics offered
by the i865 chipset.

One AGP and one PCI slot is provided, which will
almost certainly be used for plugging in a TV tuner card,
taking into consideration the media centre lineage of this
product. You can also opt for wireless connectivity via an
optional adapter.

For cooling, the case is provided with an 80 mm fan.
The processor is cooled by a combination of a heat pipe
and a large heat sink-fan combo.

Extensive manuals make sure you find your way about
the installation process.

The MEGA PC 865 PRO has two modes of operation—
as an A/V device and as a PC. There are dedicated buttons

for each of these modes. In A/V mode, the device allows
you to play FM radio, DVDs, MP3s and TV without booting
into the operating system. To enable this functionality,
one needs to install the ‘InstantOn’ software before load-
ing the operating system. Also, it does not support VGA
cards as of now.

Overall, the MEGA PC 865 PRO comes across as a well-
built product. There are plenty of features—the perform-
ance, of course, depends on the hardware you choose
to plug in. But at the end of the day, we feel Rs 22,000
for just a case and a motherboard is steep.

The AOpen XC Cube AV is a Small Form Factor (SFF) PC. It
is compact, has some really good features, and

resembles a portable audio system. The tradi-
tional black finish, up-front buttons
and large blue LED display accentu-
ate the ‘consumer electronics’ look. 

A large display dominates the
front facia. Menu navigation is
achieved by a combination of three
buttons beneath the display. Three
buttons are placed on either side of
the navigation buttons, and they
offer the play/pause, forward, reverse
and stop functions.

A memory card reader is inte-
grated just above the display panel. The
bottom flap covers two USB and two
FireWire ports, and the sound card jacks. The
back panel has the usual array of ports—two USB, one
FireWire, an optical/RCA SPDIF and an RJ45. 

Installing components such as processors requires
removal of the mounting brackets. This is not a good thing
when compared to MSI’s MEGA PC, where the mounting
cage can be swivelled and locked in position to install
components. Moreover, the cables are not properly routed,
contrasting with MSI’s systematic approach. 

The interiors, too, are cramped, and ventilation could be
hampered by this. The processor in the XC Cube AV is cooled
using just an ordinary, tall-fin heat sink-fan combo.
Moreover, the same fan is used for the case ventilation as
well and this could be a problem.

The XC Cube AV is sold as a complete solution with all
hardware plugged in, for out-of-the-box operation. In fact, a

5.1 speaker set and an anti-RSI wireless keyboard and
mouse combo come bundled.

The device we received had a
Pentium IV 2.4 GHz processor,
512 MB of DDR 333 MHz RAM, an
80 GB 7200 RPM SATA drive, and
an 8X DVD-Writer. A TV tuner
card was installed, too!

The XC Cube AV, too,
supports two modes of opera-
tion. In the first mode, you can
use it to play TV, FM radio, MP3s,
DVDs, VCDs, etc. without boot-
ing the OS. In the other mode it
can be used as a regular PC.

The XC Cube set, along with
the bells and whistles we’ve

mentioned, is steeply priced at Rs 78,990.
We think this is a little too much. Besides, if you

compare it with MSI’s MEGA PC 865 PRO, the latter is a
more refined product when it comes to component layout,
electrical cable routing and ease of installation.

MSI MEGA PC 865 PRO

Digital Leisure l Media Centre Devices

AOpen XC Cube AV

Company: Xserve India (Pvt) Ltd

Phone: 080-51131001

Email: info@xserves.com

Web site:  www.xserves.com

Price: Rs 78,990

Rating:

Company: Cyberstar

Phone: 022-28386711/13

Email: sales@cyberstarindia.com

Web site: www.msi.com.tw

Price: Rs 22,000

Rating:



130 DIGIT MAY 2005

Pinnacle MediaCenter is a media player applica-
tion in line with Windows MediaCenter

Edition. Once installed on the PC in conjunc-
tion with a certified Pinnacle TV tuner, it
allows you to watch movies and view your
photos from a hard drive, CD or DVD. You can
also watch TV and record TV programmes using
the time-shift feature. 

The package consists of the Pinnacle
MediaCenter SE software, a remote, and an
Infrared sensor for the remote that plugs into
your PC’s serial port. The TV tuner, though, is
not a part of the package, and needs to be
purchased separately. 

Currently, three TV tuner cards are supported by
this application—PCTV 100i, 100e and 300i. Also, you need to
install the drivers for the TV tuner prior to installing the
MediaCenter.

Once scanning for channels is done, you can view, record
and time-shift them. Some settings such as the recording
format, video aspect ratio, DVD language, etc. can be
adjusted from within the MediaCenter interface.

Four capture settings are offered by Pinnacle’s
MediaCenter—VCD, which is MPEG-1, and S-VCD,
DVD, and DVD long, which are all MPEG-2 and
hence require a high-end system.

These settings not only affect the quality of
captured video, but also the quality of live TV play-
back when time-shifting is enabled. The application
worked flawlessly except for a small glitch that was
taken care off by installing a newly released patch. 

Pinnacle MediaCenter is priced well at Rs
3,000 and is a good alternative to Windows

MediaCenter Edition, which isn’t available
through the retail channel. The only problem

is lack of support for TV tuner cards other than
those manufactured by Pinnacle.

The D-Link MediaLounge DSM-320 connects a PC wirelessly
to a TV, allowing for watching of video and photos and

listening to audio in the comfort of your living room. It’s an
excellent product for those who want to build a media centre
PC without dumping their old PCs.

The enclosure is finished in matte silver,
and has classy appeal. There’s
only one button on the front—
the ON button. The back panel
has digital and analogue audio
jacks, an S-video connector, a compos-
ite connector, component video-out jacks,
one Ethernet port, and a small switch that allows you to
choose between the NTSC and PAL standards.

Installing the device is as simple as it can get—you just
hook up the MediaLounge to a wall outlet. When you connect
the MediaLounge to your PC wirelessly, a server applet on the

PC scans for all supported media. You can also opt for a wired
connection via the Ethernet port.

For playing content, one can browse through the PC via
the sleek and easy-to-use interface. The DSM-320 supports

almost all the video, audio and image formats you’d
want. Priced at Rs 15,000, the MediaLounge

DSM-320 is a unique product that can
transform a standalone PC into a digital
entertainment centre—at just about a

fourth of the cost of a true media centre PC!

Netgear’s MP101 is a digital music player capable of
streaming audio files from your PC using a wireless

connection in your house.
There is a large LCD panel on the front of the MP101 which

displays song information. There are no buttons onboard; all
functions are controlled via the feature-rich remote.

For installation, all you need is an Access Point
connected to the PC with DHCP configured. Install the
server applet on your PC, and it scans for supported media.
On the device side, all you need to do is plug in the power
connector and speakers! 

The device scans for wireless connections within its
range. Select the SSID (Secure Set Identification) of the
Access Point connected to the PC where the server software
is running, and the MP101 will pick up the IP address and
subnet mask on its own—all you have to do is choose your
music and hit Play.

The MP101 comes with audio RCA jacks and stereo-in to
connect speakers, and an RJ45 10/100 Mbps LAN port to
connect to a LAN switch if you are using one at home. The

MP101 does not
support 5.1-channel
audio since it only
plays MP3s and
WMAs, which are
two-track formats.

We streamed MP3s
from a PC with the Access
Point placed 10 to 12 feet away.
Since the MP101 is 802.11b compliant, it can support a
throughput of 11 Mbps—so streaming 128 Kbps files was
no problem at all.

Netgear MP101 Wireless Digital Music Player

D-link MediaLounge DSM-320
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Pinnacle MediaCenter 

Company: Muggees Technologies Pvt Ltd

Phone: 022-28331321

E-mail: mtpl@muggees.com

Web page: www.netgear.com

Price: Rs 9,620 approx.

Rating:

Company: Pinnacle Systems

Tel: 011-26445915

E-mail: indianconsumer@pinnaclesys.com

Web site: www.pinnaclesys.com

Price: Rs 2,990

Rating

Company: D-Link India Pvt Ltd

Tel: 022-26526696

E-mail: sales@dlinkindia.com

Web site: www.dlink-india.com

Price: Rs 15,000

Rating: 
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Which of the following
countries is a forerunner in

converting all its conventional
movie projectors to digital?
a. Kyrgyzstan
b. Slovakia 
c. Ireland
d. Singapore

What is podcasting?
a. A Web-based broadcast

medium     
b. A TV broadcast medium   
c. Broadcasting across iPods   
d. A radio broadcast medium

Name the former chief
executive of WorldCom, the

second-largest telecommunications
firm in the United States, who was
found guilty of security fraud, false
regulatory filing and other massive
accounting fraud.
a. Bernard J Ebbers
b. Richard M Scrushy    
c. Kenneth L Lay
d. Jeffery K Skilling 

Science Applications
International Corporation

led a group which developed a
$312 million (Rs 1,537 crore)
surveillance system for the
Olympic Games in Athens. Which
of the following has not been
rigged with cameras as part of
this system?
a. Boats
b. Helicopters
c. Blimps
d. Police horses 

What does quantum
cryptography do?  

a. Allows two users on an optical
fibre network to form a shared key

b. Describes how electrons surround
the nucleus of an atom  

c. Scrambles plaintext into
ciphertext and vice-versa

d. Explains the behaviour of matter
on computer chips

Which of the following is not a
desktop search tool?

a. Blinkx v2.0
b. Yahoo! Desktop Search
c. Sphinx Desktop Search
d. MSN Toolbar Suite Beta

Name the new mobile video-
gaming device launched by

Sony Corporation.
a. PlayStation
b. PlayStation Mobile
c. PlayStation Go
d. PlayStation Portable

What has Ben Cohen recently
been in the news for? 

a. Pornography
b. A dispute with Apple over

itunes.co.uk
c. A lawsuit on Quickquid.com
d. For overturning a ruling

from Nominet

The Wiki got its name from the
Hawaiian word for... ?

a. Change 
b. Open
c. Quick
d. Value

10

9

8

7

6

5

4

3

2

Across
6. On maid transforms known area
of control (6)
8. Organised presentation of data
upsets porter (6)
9. Setting of a programme (4)
10. Web browser at theatre (5)
11. Write Once, Read Many (abbr) (4)
13. Electronics giant headquartered 
in Japan (7)
16. Company to have introduced the 
Castanet Tuner (7)
17. ______ Band (5)
20. Statement of fees (5)
21. One hundred thousand for 
shellac, we hear (4)
22. ______ Hollerith, creator of the
Hollerith Electric 
Tabulating System (6)
23. No response from computer to 
user commands a jail (4,2)

Down
1. Developer of the PowerPC
in Illinois (8)
2. Cyber ______ (4)

3. Plug-in from
Computer Mail
Services
confuses a
report (7)
4. Collect
information (8)
5. Short for
Infrared Data
Association (4)
7. Newbie is a
blessing
returned (4)
12. E-mail sent
to harass a
person (8)
14. Total loss of
electrical
power (8)
15. High-speed
network
developed by
UCAID blows up 
alien be (7) 
18. Bioinformatic Sequence Markup 
Language (abbr) (4)

19. Without monetary cost
advertisement (4)
21. Prevent access to a system (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
editor@thinkdigit.
com

Of Computerised Cushioning
What shoe company
showcased, at the Hannover

CeBIT trade show, a model with
sensors and a processor for
adjusting the
cushioning of
the shoe ? 
a. Converse
b. Puma
c. Adidas
d. Nike

1

Last Month’s Solution

Answers

Over a period of five years,
if left on during the

day and kept on
standby by night, the
typical CRT monitor
will consume as much
power as it is worth! 

Did you
know?

Send in
your
answers
to the crossword to
TQ@thinkdigit.com.
One lucky participant
will win Professional SQL Server 2000 DTS
by Mark Chaffin, Brain Knight and Todd Robinson,

published by Shroff Publishers and 

Distributors P. Ltd 
There was no winner for the April 2005 
crossword. Better luck next time!

Win!

1. Adidas 
2. Ireland
3. A Web-based

broadcast medium
4. Bernard J. Ebbers
5. Police horses 
6. Allows two users

on an optical fibre 
network to form a

shared key       
7.Sphinx Desktop

Search
8. PlayStation

Portable  
9.A dispute with

Apple over
itunes.co.uk

10. Quick
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Newsweek, April 18

Every Wi-Fi Cloud Has A
Broadband Lining
JOHN NESS OF Newsweek investigates whether two US
cities—Portland and Philadelphia—can become entirely
wireless cities by next year

NOBODY doubts the benefits of Wi-Fi broadband
technology. No longer is a computer user tethered to a wire
in order to surf the Web. All you need is to be within range
of a Wi-Fi hotspot, and thousands are sprouting up—at
airports, parks, hotels, bookstores, coffee shops, college
campuses. Business travellers rely on them. Students need
them. Everybody with a PC likes them. The only problem is
that, though Wi-Fi is spreading fast, access is hardly

universal. Most areas of any
given locale are not “hot”, and
even in those that are, being
only slightly out of range or
behind the wrong building
means no more service. The
irony of Wi-Fi convenience is
that, without ubiquity,
dependent users can pretty
quickly become frustrated.

The telecoms, while
deploying Wi-Fi in ever more
places, won’t likely be solving
the problem soon. Telecoms
“target lucrative, high-density
markets to make a profit,”
explains Jim Baller, a
Washington telecommunications

lawyer. That has led municipalities to begin creating
hotspots themselves, as a way to reach lower-density and
lower-income areas that a profit-making company would
ignore. More than a dozen communities—from downtown
Baton Rouge, La., to San Francisco’s Marina
neighbourhood—now have significant Wi-Fi coverage
provided by the government at nominal or no cost. But the
real tests of municipal Wi-Fi are in Philadelphia and
Portland, Oregon, both of which plan to begin blanketing
their entire areas with low-cost Wi-Fi next year. Cities like
Chicago and San Francisco are keenly watching those
efforts—as are telecoms that have spent millions in for—
profit efforts to provide wired broadband infrastructure.

There will inevitably be holes in any Wi-Fi cloud spread
across a major city. Signals often don’t extend into
basements, tunnels or larger buildings—but true believers
say the advantages make up for any gaps. They say the
poor will get access, cities will be able to run more
efficiently and storefront businesses will be able to work
online on the cheap. Naysayers, particularly the telecoms,
doubt cities or the technology itself is up to the task.

For business travellers, Wi-Fi clouds are being designed
to be so user-friendly that anyone can get online as soon as
he or she is in town. In theory, once your PC picked up a
municipal Wi-Fi signal, all you’d have to do is complete an
online registration and pay a small fee via a credit card.
Dianah Neff, Philadelphia’s chief information officer, says
city planners are talking to T-Mobile—a leading Wi-Fi service
for travellers—about a roaming agreement that would allow
visitors to surf big areas with their T-Mobile accounts.

http://snipurl.com/digit_wifi

Cnet.com, April 7

Do You Really Care For Faster
PCs?
C-NET.COM IS THE world’s most respected and certainly
the most exhaustive technology portal. Senior Editor
Molly Wood asks whether faster and faster PCs really
make sense

THE future of the desktop is here! The first PCs featuring dual-
core processors from Intel have arrived, presenting the first
over-clockable chips from Intel since 1998 and offering true
multithreaded performance. Just a day after Intel announced
its dual-core processors, nVidia unveiled its nForce4 SLI Intel
Edition chipset, which lets you run Intel’s dual-core Pentium
Extreme Edition 840 processor and two nVidia SLI graphics
cards. AMD’s dual-core chips are probably coming soon, 64-bit

versions of Windows are just
around the corner, and to deal
with all this horsepower, PC
cooling systems are bound to
get increasingly outlandish—
water’s just the beginning. But
the real question to ask here is:
who cares? 

Seriously, what are these
PCs for? Certainly not the
office. As far back as 1999,
Larry Ellison was championing
a second version of his thin-
client network computer, calling
the desktop PC a “ridiculous
device” and arguing that a
complete PC was a complete

waste on the desktops of most employees. Many analysts and
journalists are advocating the death of the corporate PC, and
it’s increasingly obvious to all that most of the horsepower of a
desktop PC is wasted on employees who primarily use
spreadsheets, word processors, custom applications, and e-
mail. Dual-core, SLI, water-cooled PCs in cubicles? Er, no.

So, that leaves gamers, the real target market of these
machines. I buy that—they’re about the only ones (other than
graphics pros, of course) who can justify a machine such as the
Alienware Area-51 ALX 7500. But how many gamers really need
a dual-core SLI PC that, when over-clocked and loaded to the
gills, costs around $5,000? For one thing, most current games
aren’t multithreaded, meaning you can’t really even take
advantage of the dual-core processors just yet. Obviously,
that’ll change over time, but won’t most hardcore gamers,
then, just stick to the DIY approach-adding high-end
components, over-clocking, and building elaborate cooling
systems themselves?

Moreover, although gaming is a $7.3 billion industry in the
United States, it would seem that consoles rack up much bigger
sales numbers: 160.7 million units sold in 2004, versus 45
million computer games, according to the Entertainment
Software Association. So, who’s really going to buy these PCs in
the future? And how many $5,000 machines does Alienware
have to sell to make the development worth its while?

So, on to the next presumed audience: the digitally savvy
home user, who’s processing gigabyte after gigabyte of video,
audio, and digital photos. Right, sure, we need 4GHz. There’s
no way the 2.8GHz Dell box I just bought, when properly
outfitted with nearly a gig of RAM and strapped to a 160GB
external FireWire drive, could possibly be up to the task.

http://snipurl.com/digit_pc
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Dunk The Spam
SPAM IS THE SINGLE largest irritant the information
economy has ever created. Joshua Goodman, David
Heckerman and Robert Rounthwaite of Scientific
American give a few tips on how to avoid spam

IN 1978, the first spam e-mail—a plug from a marketing
representative at Digital Equipment Corporation for the new
Decsystem-20 computer—was dispatched to about 400 people
on the Arpanet. Today, junk correspondence in the form of
unwanted commercial solicitations constitutes more than two-
thirds of all e-mail transmitted over the Internet, accounting for
billions of messages every day. For a third of all e-mail users,
about 80 per cent of the messages received are spam. Recently,
spam has become more threatening with the proliferation of so-
called phishing attacks—fake e-mails that look like they are from
people or institutions you trust but that are actually sent by
crooks to steal your credit-card numbers or other personal
information. Phishing attacks cost approximately $1.2 billion a
year, according to a 2004 Gartner Research study. 

The phenomenon of spam afflicts more than just e-mail.
Inside chat rooms lurk “robots” that pretend to be human and
attempt to convince people to click on links that lead to

pornographic Web sites. Instant
messaging (IM) users suffer from
so-called spIM-e-mail spam
cognates. Blogs can be corrupted
by “link spammers” who degrade
Internet search engine operations
by adding misleading links to sites
that distort the utility ratings of
Web sites and links. 

The suffocating effect of spam
sometimes seems likely to
undermine, if not wreck, Internet
communications as we have come to
know them. The reality, however, is
not so bleak. Several techniques for
intercepting spam and discouraging
spammers have been invented, and
more are on the way. The methods

we shall discuss focus on junk e-mail, but many of them could
apply to other incarnations of spam as well. No one of these will
be a magic cure, but combinations—if embraced by enough of
us—could work wonders. It is not unrealistic to hope for a day
when our e-mail boxes will once again be nearly spam-free. 

Google’s continuing refinement of its search technology
underscores the intensifying competition in that market, which
has carried Internet advertising back to life in recent years.
MSN, Yahoo! and others have seen Google parlay popular
search technology into a dominant business by selling text
advertisements to marketers whenever consumers search for
words related to a business.

Insidious E-mails 
The proliferation of fraudulent e-mail results directly from
favourable market forces: spam is exceedingly cheap to distribute.
It is not altogether free, though. We estimate that a message costs
about one hundredth of a cent to send. At these cut-rate prices, a
spammer can earn only $11 per sale and still make a profit, even if
the response rate is as low as one in 100,000. Hence, although
very few e-mail users ever buy anything advertised in spam, all of
us suffer because of those who do. 

http://snipurl.com/digit_google
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AdWise

Ignorance Is Bliss?
Citing previous ‘famous’ reasons for failure are no way to
justify your own failure. Backups are critical. Point made.
Point taken.

Watch Dog
Emphasising the improved security thanks to SP2, this ad
gets the message across loud and clear. But what happens
when the dog sleeps?
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Google co-founder Larry
Page recently

announced that the
company wants the public
to send in its homemade
videos—and it doesn’t
matter if they’re smutty.
“There might be an adult
section, or something like
that. I don’t think that is
going to be a big issue,”
Page told attendees at the
National Cable and
Telecommunications Show
in San Francisco in mid-
April. Google has yet to
formally announce the
proposal, but Page said to
expect the doors to open
“within the next few days”.

Officially, it’s in the
name of research. Google
started indexing TV shows
late last year, and Page wants
to use public contributions
to test its prototype video
search software, which uses

pattern matching to find
words or phrases in clips.

Unofficially, this could
be an acknowledgement of
the Web’s changing
demographic: in a recent
survey, 23 per cent of Britons
cited pornography as their
primary reason for getting
broadband, far outweighing
any other factor.

Google’s prototype faces
an uphill battle getting its
software into the
professional newsrooms,
where Autonomy’s
Dremedia—now Virage—has
a lead of several years.
Virage’s software, which
uses Bayesian pattern
matching, can perform
much of the work of a
traditional archivist, such as
segmenting and labelling
footage, recomposing it
with subtitles, and even
cleaning it up for broadcast.

The privacy-conscious
amongst you may wonder
how this giant database—
which knows your search
queries, your e-mail, and
the people you know
through social networking—
could have managed to stay
out of your bedroom for so
long. Here it is now!

SPAMMERS BEWARE!

US Man Gets
Nine Years
For
Spamming

In a first-of-its-kind ruling,
Jeremy Jaynes, 30, from

North Carolina in the
United States, has been
sentenced to nine years by a
Virginia judge for
spamming. Under Virginia
law, sending bulk e-mail
messages using fake
addresses is a crime.

Jaynes is the first person
in the US to get a prison

term under spam law. He
had sent millions upon
millions of spam messages,
and is said to have been the
world’s eighth-most prolific
spammer. Jaynes was
operating through an AOL
server in Loudoun County,

Think you have the most
beautiful, most innovative

desktop around? Send it to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit will publish the most 
eye-catching of them each month.

Debjyoti’s desktop is really easy on the eye
Sent in by Debjyoti Roy, Kolkatta

My Desktop

TThis is the official site
of the Indian Hockey
Federation. About a

year ago, there was stuff in
the newspapers about how
hockey is the country’s
national sport, that it should
be put on par with cricket,
and so on. People were
bemoaning the fact that
hockey seemed to be 
stagnating in India. The
Hockey Federation’s Web
site is an accurate reflection
of the state of the sport. 

The only material the
page hosts is the
“Constitution of Indian
Hockey Federation”. Then,
you can count, on your 
fingertips, the number of
links on the page: precisely
four. There is one link that
doesn’t work, and one that
points to a site very much
under construction; one link
to the International Hockey
Federation; and one link to
“Hockey International Year
of the Youth 2001.” That’s it.
And no, the site is not under
construction.

Actually, there’s more.
There are two pictures of
people playing hockey.

http://ihf.nic.in

Contact the Pope via e-mail!
Pope Benedict XVI has kicked off his pontificate by setting up
his e-mail address. The faithful can contact him at benedictxvi
@vatican.va. On his Web site, there is also a link to the Vatican
Television Centre, which streams ongoing events and
programmes live. Now that’s what we call a tech-savvy Pope!

Playboy Offers Free Pics For Your PSP!
After the iPod Photo, it’s a chance for PlayStation Portable
owners to take adult magazine Playboy on the road with
them—and they don’t have to bother with the articles, either!
The online arm of Playboy Enterprises said it will offer photo
galleries and videos shot and edited specifically for the PSP.

The winner
receives a copy
of professional
SLQ Server 
2000 DTS
By Mark Chaffin, Brian
Knight and Todd
Robinson, published by
Shroff Publishers & Distributors P. Ltd.
This month’s winner is  
Debjyoti Roy from Kolkatta  

INDEXING VIDEO

Google Wants Your Home
Porn Videos!



135DIGIT MAY 2005

where the world’s largest
Internet services provider is
based, and is believed to have
sent some 10 million spam
messages a day. By selling
sham products and services
advertised in his messages,
he earned up to $750,000 
(Rs 3.26 crore) a month!

Since Jaynes is from
North Carolina, and the
court ruling was in Virginia,
he can, and will, appeal on
the grounds that he has
been charged as an out-of-
state resident under a
Virginia law that has only
just come into effect. The
court has put off the start of
his prison term because the
new law raises questions.

In sentencing Jaynes,
Circuit Court Judge Thomas
D Horne said he would not
begin serving his term
because there are
“substantial legal issues”
related to the new anti-
spam law, enacted in 2003,
that still need to be
explored. Horne also said he
believed Jaynes does not
pose a danger to society.

According to prosecutor
Lisa H Thomas, it was not
just about the sending of
bulk mail; it was also about
falsifying routing
information and disguising
the origin of the mails.

Jaynes’ sentence is the
harshest punishment
handed down so far for
junk emailing in the US,
and appears to be a strong
signal that authorities will
not tolerate spamming. 

ROBOTS AS JOCKEYS

Robots Will
Be Employed
As Camel
Jockeys

The United Arab Emirates
has said it will use

robots as jockeys for camel
races from the next season.
The move comes after
widespread international

criticism of the use of
young children to ride
camels during the long and
often hazardous races.

A prototype of the Swiss-
designed robot has recently
been successfully tested. “The
mechanical jockey is light in
weight and receives orders
from the instructor via a
remote control system fixed
on the back of the camel,”
the daily Gulf News said.

The issue of child camel
jockeys has been an
embarrassing one for the
UAE. Aid workers say there
are up to 40,000 child
jockeys working across the
Gulf. Many are said to be
have been kidnapped and
trafficked from South Asia. 

TOLERATING SPAM

Survey Says
Americans
Are Getting
Used To
Spam

Arecent survey of more
than 1,400 US Internet

users conducted by the Pew
Internet and American Life

This month’s winner is 
Dhawal Damle from Delhi. 
He wins

Mathematician,
cryptographer and

war hero, Alan Mathison
Turing is widely
considered the father of
computer science.

Turing faced problems
with social adjustment.
His headmaster at
Sherborne school once
said, “If he is to be solely a

scientific
specialist,
he is
wasting
his time at
a Public
School.”

In 1935,
Turing

received a Fellowship of
King’s College of
Cambridge University. 
His famous mathematical
work ‘On Computable
Numbers’ was written in
Cambridge in 1936,
wherein he laid the
foundation for the modern
computer. In 1938, Turing
returned to Cambridge
as a logician and
number theorist.

During WWII, he helped
crack Germany’s secret
codes. In 1948, Turing
became deputy director of
the computing lab at
Manchester University. In
June that year, he first
demonstrated the Universal
Turing Machine—a
mathematical model of the
modern computer. He
projected a computer being
able to switch from
numerical work to code
breaking, file handling or
chess-playing, something
like ‘one single machine for
multiple tasks’.

In 1954, Turing
committed suicide by
eating a cyanide-laced
apple. A non-conformist
and freethinker, Turing
remains an enigma.

The Father
Of Computer
Science

People Who
Changed

Computing

Professional DCOM
Application Development 

from Shroff Publishers and
Distributors P. Ltd

Eight Days A Week...

WIN!
The ‘Professional DCOM Application Development’ book just by sharing an amusing picture with a tech
angle to it. The picture should be shot by you, and should not have been published earlier. Send your 
picture to digipick@thinkdigit.com. The prize-winning picture will be published each month.

Alan Turing



Project suggests that
Americans are learning to
live with spam. Basically,
the data suggests that
Americans are tolerating
spam better than they used
to. And what’s true of
Americans could well be
true for people everywhere. 

The news out of the Pew
survey is this: “Compared to
a year ago, fewer e-mail
users now say that spam is
undermining their trust in
e-mail, eroding their e-mail
use or making life online
unpleasant or annoying.”

“It’s one of the annoy-
ances in life that you even-
tually resign yourself to,”
Pew Internet chief Lee
Rainie told The Washington
Post in an interview.

So is spam gradually
becoming just another back-
ground distraction? After
all, humans are talented at
filtering out chronic distrac-
tions. We did it with the
daily rush hour, the annoy-
ance of overhearing
strangers’ cell phone con-
versations, and the threat of
nuclear annihilation. Now,
the Pew survey says, we’re
doing it with spam.

The findings are in con-
trast with the fact that over
half the Americans now say
they “trust e-mail less”
because of spam.

The survey is not really
groundbreaking—after all,
given the fact that spam is
only increasing despite all
the efforts to control it,
what else would people’s
reaction be except to get
used to it?

SMELL AND TASTE

Expect More
From Movies

Sony was recently
awarded a patent for a

technology that could
conjure up smells, tastes
and other sensations in the

brains of movie-goers.
Specifically, the patent
covers “a method for
generating sensory data
onto the human neural
cortex”. The patent
describes using “ultrasonic
transducers” to stimulate
neural activity in particular
areas of the brain, causing
the person to experience
smells and tastes as part of
the cinematic experience.

The technology is
outlined in the patent in
this way: “Changes in the
neural firing timing induce
various sensory experiences,
depending on the location...
the system induces

recognisable sensory
experiences by
applying
ultrasonic energy
pulsed at low

frequency in one 
or more selected
patterns on one or
more selected
locations of the
human cortex.”

Elizabeth
Boukis, a
spokeswoman for
Sony Electronics,
described the
invention as
“prophetic”,
New Scientist
reports. “It
was based on
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April 1, 2005: We had a new recruit join
us this month. Ishan, a soft-spoken,
polite boy from UP, who did his Masters
in Information Technology from
Melbourne, Australia, was hired to take
over the DVD and CD process, and also to
write stories.

Sachin, our Executive Editor, hit him
with the good news first: “No articles to
write this month!” That brought a broad
smile to his face—he thought he had time
to settle in, get a feel for the place, get to
know people. He was wrong!

April 2, 2005: Perhaps a day that will
haunt Ishan for a lifetime. He had a
meeting with Sachin and Raaabo
(Robert). Raaabo informed him that the
May 2005 DVD deadline was four days
away. He took it well, all things
considered, and
all we needed
were smelling
salts to get him
back to reality.

April 4, 2005: We were all awoken from
our Monday morning slumber by a shrill
scream, and subsequent sobbing. We
found Ishan with his head in his hands:
the screen before him said, “This page
cannot be displayed”. The Internet
connection was down—which is
something Ishan will have to get used to.
Like the rest of us have, over the years...

April 7, 2005: It’s amazing how mean
we can be at times. We purposely didn’t
tell Ishan he’d have tons of help from
seasoned Digit veterans, helping him
discover the secrets of the trade. Finally, a
day before his deadline, help flowed in
from everywhere, and Ishan was amazed
to see the impossible become possible: the
DVD was done on time.

Ishan smiles his soft smile as he sums
it up: “At Digit,
Internet access may
be fleeting, but
friends are made
for life!”

The DVD Dude
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Photoshop
Photoshop is all around us, at
least at the Digit office. Some of
us know how to use it a little
bit, and many of us have seen
that it is a powerful and
fascinating tool—and have
begun to ‘learn’ Photoshop.
How far the learners have
gotten is another matter
altogether—but these people try
to portray the image that they
‘know’ Photoshop. Here are
some terms they throw at us.
Unsharp Mask: In order to
bring out the details, most
scans need to be sharpened.
For this, most pros use Unsharp
Masking. There are three
parameters in the Unsharp
Mask filter: Amount, Radius and
Threshold. Threshold deals with
levels of tonal separation. The
Radius is the amount of
sharpening you want. The
Amount controls how effective
your choice of Radius will be.

Didn’t get all that? Well, we
didn’t either!
Blending Modes: These need
two or more layers for any
effect to work. You need at
least two layers to blend
together. A layer with a
blending mode specified will
blend with all other colours
from layers underneath it.
Photoshoppers call those
original layer colors the base
colours. The colours on the top
layer are called the blend
colors. The result is called the
result colour.
Texture Mapping: This is a
favourite of wannabe
Photoshoppers. They often
say something that sounds
like the following: “I've been
having problems with using
texture maps in my
renderings. I'm trying to
render a brick building using
a texture map, but when it
renders, I get these weird
patterns all over my image.
I've tried to increase the
actual scale of the text-map,
that didn't work. I tried to
increase the size of the tiling,
that didn't work. It happens
for every image map I use 
for brick. It’s getting
frustrating...”

Just throw something like
that at someone while looking
frustrated, and they’ll think
you’re a Photoshop pro!
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an inspiration that this may
someday be the direction
that technology will take
us,” she said.

Whether the patent will
revolutionise the way we
think of movies remains to
be seen, but one must
remember that when
talkies first arrived, a
famous personality said,
“Who wants to hear people
in movies talk?”

HARD DRIVE CUSHIONING

Sony Adds
‘Airbag’ To
MP3 Player

Late in April, Sony
shipped a hard drive-

based personal digital
music player adding a
removable battery and an
anti-impact system to the
hard disk as new features.

The NW-HD5 is
equipped with a 20 GB
drive, which has a ‘G
Sensor’ that detects sudden
drops and cushions the

storage medium to prevent
damage and data loss. IBM
recently added such a
mechanism to its ThinkPad
hard drives, as did Apple
with its laptops, but this is
the first time the technique
has been applied to
portable music players.

The player went on sale
in Japan on April 21 for
around ¥35,000 (Rs 14,000).

Compiled by Aditya Kuber,
Renuka Rane 

and Ram Mohan Rao

Urban75.org, among other things, has information on
drugs, punch and football. Among this is a link called

‘useless’ that lists over 25 utterly useless games (some are
fun, though!). The worst among these really is the World
Mouse clicking championship. To their credit, the site base-
line warns you these are useless games (and other links!). 

All one has to do is click on the given button and see how
many times you can click in 10 seconds. It can get addictive
for about 30 seconds (that’s about three attempts) but soon,
the novelty wears off, your IQ comes back to normal and you
decide to hit [Ctrl]+[W]. Please avoid. But we know you
won’t listen!

Some of the other totally inane games include a certain
Mr Insult who will shout insults (some as banal as “What are
you, insane?”) for anything you type. What makes this mind-
numbing is the fact that the insults are not even fresh, and
the same old ones get repeated every single time. Sheesh!

Mr Insult can also become a purist when it comes to the
language and insult you in Shakespearean English. Why is

that interesting? The insults
fade away à la Star Wars titles.
To his credit, he manages to
keep them scrolling for a long
time but once again, the
uniqueness wears off after
about 6.5 seconds and your IQ
rises yet again, and you will
rush for [Ctrl]+[W]. We suggest
you keep your fingers ready
for [Alt]+[F4]! 

whatweretheythinking.com

A1Great
http://a1great.com/

On popups and such 
The Bored site is doing gangbuster business right
now, attracting a lot of users and site submissions.
One of those submissions came from a webmaster
whose game site offered a lot of fun stuff, but
managed to throw a popup into my browser,
despite having that particular feature disabled
in Firefox.

So I got into it with the webmaster a little bit,
saying I wouldn’t link to anything that deliberately
breaks a setting on my browser. He responded with
the suggestion that he had to pay for hosting and
bandwidth, and thus was entitled to throwing any
advertising in there that he saw fit.

Jason Salas’ Weblog
http://weblogs.asp.net/jasonsalas

A primer on podcasting for newbies
An earlier casting call I made to co-host a weekly
podcast dedicated to all things ASP.NET has gotten a
pretty decent response from the Microsoft
community, with one thing common: all respondents
admitted they had heard of the podcast platform or
have listened to a podcast, but hadn’t ever produced
one themselves. No sweat!  Here are two great links
that show how easy it is:

Jake Ludington's podcast tutorial: great primer for
first-time audio newbies

Harold Gilchrist profiles the audioblogging
revolution: awesome breakdown of the differences in
the RSS feed for podcasting

Russ Nemhauser
http://weblogs.asp.net/russnem/

The Belated Active Directory Corruption Post
I had a power outage and my Active Directory got
corrupted. I’d (been using) Windows’ built-in
NTBACKUP utility to back up the network shares that
contained user-created data. What I never knew is
that the NTBACKUP utility can be used to back up
what is called “system state”.

If you have a relatively quiet domain like mine
here at home, you should be backing up your system
state about once a month.

Science Library Pad
http://scilib.typepad.com/

Thoughts on linkblogging
Mostly I do what is now called “linkblogging”.  I just
copy and paste a link of interest to me along with a
select few paragraphs.

Also it depends on your target audience. If you’re
blogging for yourself and a few friends, they
probably haven’t seen the links you’re mentioning. If
you’re blogging for a target audience of people who
are sucking down hundreds of Bloglines feeds per
day, they probably HAVE seen any link you’re going 
to uncover.

This month in the
Blogosphere: Russ
Nemhauser finds out
the hard way why he
should have had
power backup;
A1Great takes a look
at pop-ups; Jason
Salas puts up a
primer for podcasting
newbies; and Science
Library Pad puts
down thoughts on
linkblogging

www.urban75.org/useless

www.urban75.org/useless



Explore The BPO Industry
I have been reading Digit for over three
years, and every month, I find it more and
more useful in terms of IT information.
The variety of articles on software,
hardware, innovations, entertainment and
education is informative. We can say it is a
complete review of the IT industry.

Over the last five to six years, though,
we have seen that the industry has been
through many lows and highs (especially
in the software development sector). It
would, therefore, be useful if Digit could
publish an article on software
development companies—their history,
current and future—and what the scope is
of small Indian software companies
working only for Indian projects and what
will happen to mid- and large-size
companies working on national and
international projects. Such information
could be very useful for young aspirants
who wish to pursue a career in the
software development industry. 

I think software development has
already reached its heights in countries
such as India, the US and Singapore, but
other countries are not as computer-savvy.
Language in these countries is a barrier.
Do you think it would be beneficial if
Indians learned a foreign language that
could improve their chances of working in
non-English-speaking countries? An article
on this would be a great help.

Sandeep
Via e-mail

Dear Sandeep,
Thank you for your suggestions and we will try
and incorporate them. Generally, though,
knowledge of a foreign language would always
be an advantage if you want to work abroad.

Spim Exists Because Of Digit?
I don’t live in India; my friend has to
scan a copy of magazine and send it to
me—what a mess. Many magazines have
PDF versions we can subscribe to if we
cannot get the printed version. All the
software is attached to PDF or can be
downloaded from the links provided.

In general, a computer magazine
exists to educate users about technology
and write reviews about hardware and
software products, but you scarcely do
that. You should not write articles about
what one individual faces personally
about technology. “Spim is not a big issue
right now”, but you have given an idea to
the stupid people out there that  there
will be spim all over India. We can as well
say, “Spim exists because of Digit”.

The Internet is not what it was
supposed to be; people are finding ways
of getting rid of something but that’s
not their primary task. They are wasting
their time doing these things so that
they can do clean Internet stuff by the
end. Pop-up/Ad-blockers/Spyware
Cleaners would not have existed if
people didn’t get freaky ideas.

And what are you publishing about
‘Anti-piracy’? They say these technologies
should not exist just because it’s a pain.
As long as you are a genuine buyer, it’s
never a problem. On the contrary, it
gives you more satisfaction because you
are doing something good for the
community. I personally would have
banned these users but I kick them
virtually. It takes months and years to
write software... 

Digit, though, is doing a really good
job putting these things in print. I think
people in India take any software for
granted; they do not understand that
software is not their property. You
should write more articles about how
piracy can be reduced or how software
can be protected. 

Harry
Via e-mail

Dear Harry,
First of all, thank you for the vote of confidence
that Digit shapes the thinking of the Indian IT
enthusiast. However, we can assure you that
they have other sources of information too (the
Internet, for example), and are already aware
of things like spim. By Digit not addressing it,
it’s not going to go away. At Digit, we stare the
problem in the eye rather than look the other
way. Pop-up/Ad-blockers and Spyware cleaners
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Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum

Customer scare, customer care...

navneeth_snr
Analogue Novice
Location: Bangalore
Post subject: Beware : Digit Makes us
April Fool
I brought the Digit Mag of April 2005. The DVD
was not working. I just went to news stand and
got replaced. But the 2nd DVD was also not
working. I again went & exchanged. But no use.
From all 3 copies of Digit DVD is not working.
This is not FAIR! 

Also I just dialed Digit for help! 
All Bangalore numbers are fake

****************************************
hikapil
Warmed-Up Nerd
Location: Jaipur, Rajasthan, India
I think you have mistaken somewhere. I am
Digit subscriber for the last 2 years, and Digit is
giving DVD's from last 6-7 issues I think.  All my
DVD's are working properly, and have great
stuff in all of them. I suggest you check your
DVD drive. 

And I have talked to Digit people at their
helpline many times, I don't understand why
are you are not able to talk with them. Please
check once again.
****************************************
anurag_online
Analogue Novice
You people don't think of the good service that
Digit has been providing for so long... It is only
one small mistake, which can be removed easily
if you have some patience.
****************************************
Santosh Halemani
Analogue Novice
Location: Dharwad, Karnataka
Hey, many forum members are really cool. I
think all of u have girlfriends, that's why u don't
get angry, u don't panic, u calm others down.
****************************************
Ashis
Warmed-Up Nerd
Location: Bhubaneswar, Orissa
May be Technology Fooled The Digit Guys
This April! 
****************************************
Santosh Halemani
Analogue Novice
Location: Dharwad,Karnataka
Hey, u guys r a lot better than our country
leaders, at least u guys keep it up. I tell u if we
post this much letters to the Government, India
will be powerful in the next 5 years!
****************************************
Technovice
Analogue Novice
Hey! Thanks Sachin & Raaabo and the rest of
the Digit team. BTW, I think there could be
some other ways of using that April DVD: 

- Exchanging it with your friend for another
DVD and telling him that it is his DVD-ROM
drive that is the problem (use the new DVD to
prove it) when he complains!!  

- Play frisbee with it 
- Play fetch with your pet dog! 
- Store it as a souvenir in your showcase

just to remind yourself that even the best can
make mistakes!  Cheers!



are necessitated because twisted minds
decided to pollute the Internet.

As for kicking pirates, we are with you, and
hence the articles to educate our readers about
the various aspects of piracy. We will also
include this in future articles about the issue.

Digit, with every issue, also publishes a CD
and DVD that carries PDFs from the previous
month and earlier. The CD has PDFs for the last
three months, while the DVD has PDFs for the
last one year. We will be restarting this with
effect from July 2005. The last CD/DVD to carry
this was with the February 2005 issue.

What Is Anti-Virus Good For?
I am not an expert in computers. But when
I buy something, I understand it and use it.
As far as anti-virus is concerned, though, I
am totally confused. I had Norton
AntiVirus installed on my computer with
Windows XP (without Service Pack 2) and
used to update it regularly all these years. 

Hence, I was under the impression that
my computer was secure until one fine
morning, to my greatest dismay, a window
announced that my computer was infected
by the ‘Bloodhound’ virus, and that Norton
AntiVirus couldn’t control it! This point
forth, the computer started working on its
own, pasting different words whenever I
typed until eventually, I had to re-install
Windows to solve the problem. 

What do virus definitions mean? With
anti-virus definitions being updated, I am
under the impression that my computer is
protected. But ‘Bloodhound’ is an old
bandicoot and I am surprised that Norton
was not able to stop it. So what is the
purpose of the anti-viruses?

Is it only to create awareness that there
are ‘so many viruses’ being introduced, or
are anti-virus software actually capable of
protecting computers from attacks?

C V Padmanabhan 
Via E-mail

Dear Padmanabhan,
You may not be a computer expert, but you
have hit the nail on the head! It’s true, most of
us do expect anti-virus software to be
impenetrable, and are shocked when we realise
that they are just as fallible as any other
software. After all, whether it’s a virus, an OS
or anti-virus software, it’s all code, written by
imperfect humans.

In your case, you were probably hit by an
‘updated’ version of the Bloodhound virus,
which was rebuilt to bypass Norton’s security.
Most malicious software writers seldom write
code from scratch; instead, they rewrite or

‘improve’ the virus code, so as to bypass the
majority of anti-virus programs.

Virus definitions are nothing but
instructions given to anti-virus software about
how to detect and remove known viruses. They
don’t always work, and most anti-virus
software need you to also keep the software
engine that detects and removes the viruses
updated—not just the definitions. Another
drawback is the OS, which may have security
holes and allow malicious code to pass.

Nothing is ‘safe’ in the computing world
and anti-virus software are just helmets that
we wear as riders on the Information highway.
Accidents will happen. Be as cautious and
prepared as possible!

Corrigendum
In the story titled Pixel Palette on page
61 of the April 2005 issue, Sanjay
Kothari’s name was been misspelled.
The URL, too, was wrong—it’s actually
www.sanjaykothari.com. We apologise
for the error.

Inbox
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Seeing The Alternative Is
The Future

I purchased the Digit April 2005
edition from a newsstand, since I
was particularly keen to get my
hands on OpenOffice.org 2 Beta. I
had hoped that your distribution
would include both Windows and
Linux versions. 

I was disappointed to find
that you had included only the
former. Have you included
the Linux version previously,
or will I have to buy your
magazine again next month to
get it?

The abovementioned problem,
though, was the least of my worries,
as I found out that apart from
‘OoO2b’, nothing else could be
copied from either the CD or the
DVD.  Even the wallpapers could not
be opened! This double-whammy
makes me wonder if this was just a
once-in-a-while error or whether it
was a whole batch that went bad. 

I am returning both the CD and
the DVD for replacement, with the
hope that you’ll send me working
copies at the earliest. I can’t wait to
try some of the other software they
contain, including Bitdefender.

I have a suggestion: I do not see
any point in replicating the software
already on the DVD onto the CD.
People with DVD drives are anyway
able to use CDs. Why don’t you put
the most popular or important or
essential software on the CD, and
leave the free space on the DVD for
other things, such as source code?

Which brings me on to the next
topic: despite distributing various
flavours of GNU/Linux, I believe you
are not doing enough. I think much
more can be done. For example, you
can package Windows and Linux
binaries, along with source code for
excellent software such as VLC. 

There will be many geeks who
might want to tweak things around.
With the space savings from the CD,
you can also include cross compilers
such as MinGW (under Essentials) so
that Windows fans, too, can enjoy
the best of both worlds. 

Nishit Dave, Pune
Via e-mail

Letter 
of the
Month

Editor’s Note On The April 2005 DVD

Dear Reader,
A large percentage of the DVDs that accompa-
nied the April 2005 issue of Digit were non-
functional. Digit has already sent letters to all
its subscribers with valid e-mail IDs apologis-
ing for the same. All subscribers will find the
April replacement DVD along with the May
2005 issue.

A section of Digit’s newsstand readers
also complained of non-working DVDs. Since
we are unable to reach out to each and every
individual newsstand buyer, we would request
all readers who bought the April 2005 issue of
Digit from their local newsstand to send an e-
mail to ddvvdd@@tthhiinnkkddiiggiitt..ccoomm  along with their
name, complete address, telephone number
with STD code, and the Digit Patron code
printed on the last page of the issue.

Once we receive a request from news-
stand readers for a replacement DVD along
with all the valid details, Digit will ensure that
it will send a fully-functional replacement DVD
free of cost anywhere in India.

We once again apologise for the incon-
venience caused, with the express promise
that we will never let this happen again.

We would also like to thank our esteemed
readers for bearing with us.

Sachin Kalbag
Executive Editor

Digit



People And Events That Grabbed Headlines—For Better Or For Worse

Computer-generated
gibberish masquerading
as an academic paper

has been accepted at a
scientific conference.

Jeremy Stribling, one of
the three brains behind this
plot, said that he and two
fellow MIT graduate students
questioned the standards of
some academic conferences, so
they wrote a computer
program to generate research
papers complete with charts
and diagrams. The trio
submitted two of the randomly
assembled papers to the World
Multi-Conference on Systemics,
Cybernetics and Informatics
(WMSCI), scheduled to be held
July 10-13 later this year in
Orlando, Florida.

To their surprise, one of
the papers—“Rooter: A
Methodology for the Typical
Unification of Access Points
and Redundancy”—was
accepted for presentation.

The paper features such
gems as: “The model for our
heuristic consists of four
independent components:
simulated annealing, active
networks, flexible modalities,
and the study of
reinforcement learning” and
“... scatter/gather I/O server in
Simula-67, augmented with
opportunistically pipelined
extensions.”

Nagib Callaos, a
conference organiser, said
that they were now reviewing
their acceptance procedures.

Britain’s Prince Harry has
been in the news for
several reasons, good

and bad, and the latest on
the list is, we
assume, bad: he
shocked army
instructors by failing
a basic computer
competence test. The
test, at Royal
Military Academy
Sandhurst, England,
was part of a famil-
iarisation course
before he starts as a
trainee officer there.

A source quoted by the
Daily Mirror said, “Although
the test was considerably
more complex than just

sending e-mails,
instructors were
amazed that Harry
failed it.” Harry, it
seems, was worse
at computers than
other new recruits.

Harry presum-
ably has plenty of
offline diversions
that keep him
from getting
online too much.

Alawsuit filed on
behalf of Limp
Bizkit lead singer

Fred Durst alleges that
the same people who
hacked Paris Hilton's cell
phone were able to pull
a homemade sex video
off Durst's computer.

The Smoking Gun, a
tabloid news Web site,
has obtained part of
Durst’s complaint
against various Web sites
that posted portions of
Durst’s sex romp with a
former girlfriend.

The document states
that the US Secret
Service has kicked off an
“elaborate investigation”
into Durst’s home movie
mess. The singer is seeking
up to $80m, or Rs 348 crore
(a little too much?) for having
his privates put on the Web
without consent, according
to The Smoking Gun.

Durst’s lawsuit alleges
that Web site operators
contacted him to ask about
making a deal to sell his
homemade sex video online.
The lawsuit goes on to say

that Durst declined to make
such a deal, believing he had
the lone copy of the video.
“The only copy of the Video
was on the hard drive of the
Plaintiff's computer, and was
subsequently stolen
therefrom,” says the lawsuit.

At the time of going to
print, Durst was still trying
to have the video and the
still photos made from it
removed from the Web.
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This is exciting news from
the robotics department:
German inventor

Michael Harriman claims to
have created the world’s most
sophisticated robot sex doll.

Harriman said, “They are
almost impossible to distin-
guish from the real thing, but
... I will only be happy when
what I have is better than the
real thing.” Now that’s dedica-
tion! Hats off to German
engineering!

The dolls are on offer for
£4,000 (Rs 3.3 lakh), with extra

charges for adaptations like
extra-large breasts. Now
that’s pricing!

The model can also be
made to move by remote con-
trol, wiggling her hips under
the bedclothes and making
other suggestive movements—
all at the click of a button.

The more libidinous
amongst us are apt to say that
technology has finally arrived.
And £4,000 is a small price to
pay for something that’s bet-
ter than the real thing… who
says innovation is dead?

Now, Robot Sex Dolls

Nonsense!
Gimme back my video: Fred Durst

“Binary... Duh!”

Prince Harry Flunks
Computer Test

Hackers Stole
My Sex Video!
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